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Environment Management System (EMS)

EMS Overview

Creo is committed to the Environment Management System (EMS). According to this policy, we are 
committed to keeping customers and service engineers informed about the principles of handling 
company products with an emphasis on environmental conservation.

The Triple-R principles are reduce, reuse, and recycle.

Any item that can be recycled should be recycled and any item that can be reused should be reused, to 
reduce the quantities of trash that cities must handle.

Recycling

Used items such as paper, plastic, electronic parts, and glass – should be sent for recycling.

Packaging Materials

Packaging materials should be kept at the customer’s premises. For disposal, they should be sent to a 
plant for paper, carton, and wood recycling.

Product Recycling and Disposal

Xerox operates a worldwide equipment take back and reuse/recycle program. Contact your Xerox sales 
representative (1-800-ASK-XEROX) to determine whether this Xerox product is part of the program. 
For more information about Xerox environmental programs, visit www.xerox.com/environment.

If you are managing the disposal of your Xerox product, please note that the product contains lead, 
mercury and other materials whose disposal may be regulated due to environmental considerations. 
The presence of lead and mercury is fully consistent with global regulations applicable at the time that 
the product was placed on the market. For recycling and disposal information, contact your local 
authorities. In the United States, you may also refer to the Electronic Industries Alliance web site: 
www.eiae.org.
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Welcome to the Spire CXP8000 Color Server User Guide
Welcome to your Spire CXP8000 Color Server User Guide. This user guide 
provides you with information about the Xerox DocuColor 8000 Digital 
Press.

The Spire CXP8000 color server is a powerful, comprehensive color server 
that provides high throughput and print predictability to digital 
workflows. In combination with the Xerox DocuColor 8000 Digital Press, 
the Spire CXP8000 color server effectively addresses the growth of on-
demand printing needs and delivers the best output quality available. 

Throughout this guide, we look forward to supporting you all the way 
from prepress to print.

This user guide will help you operate the Spire CXP8000 color server. It 
can also be used as a reference guide for questions or procedures. Study this 
user guide to take full advantage of the many unique and advanced features 
of the Spire CXP8000 color server.

This user guide is for Spire CXP8000 color server operators and system 
administrators. This guide explains how you can quickly and easily print 
from the Spire CXP8000 color server or from a client workstation. Step-by-
step procedures are included for new and occasional Spire CXP8000 color 
server users. Detailed information is provided for users who require in-
depth knowledge of the Spire CXP8000 color server. 
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Overview of Guide
Table 1: Guide Overview

Chapter Contents Description

Chapter 1 Welcome This chapter introduces the guide and the Spire 
CXP8000 color server features and workflows.

Chapter 2 Getting Started This chapter explains how to turn on the Spire 
CXP8000 color server and provides explanations 
about the Spire CXP8000 color server workspace and 
main windows.

Chapter 3 Working from a Client 
Workstation

This chapter explains how set up Windows® and 
Macintosh® client workstations and how to configure 
LPR printing. It also explains how to setup and 
configure Novell Directory Services.

Chapter 4 Basic Workflows This chapter explains how to perform basic 
workflows in the Spire CXP8000 color server, such as 
importing and printing jobs, and how to set basic 
parameters in the Print Settings, Paper Stock and 
Print Quality Tab.

Chapter 5 Managing Jobs This chapter explains how to manage jobs in the 
Queue Manager and in the Storage window. It also 
explains how to export jobs to an InSite server and 
how to use the Job Preview & Editor tool and the 
Thumbnail window. A section about managing disk 
space is also provided.

Chapter 6 Production Printing This chapter provides the workflows for imposition, 
high resolution, PDF, and page exception (manual/
dynamic) print jobs. In addition it describes how to 
select finishing options and work with fonts.

Chapter 7 Color Workflow This chapter explains how to work with color in the 
Spire CXP8000 color server, and includes calibration 
and RGB and CMYK workflows. It also explains how 
to adjust colors, and to use color tools and post-RIP 
controls.
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Overview of Spire CXP8000 Color Server
The Spire CXP8000 color server is an on-demand pre-press system that 
uses Creo Spire advanced pre-press technologies, to drive a Xerox 
DocuColor 8000 Digital Press. 

As an optimal digital color solution for printers, the Spire CXP8000 color 
server enables you to print from Windows, Macintosh, and UNIX® client 
workstations. The Spire CXP8000 color server processes image files in 
page-description language (PDL) formats—for example, PostScript, PDF, 
and Variable Information—using RIP (Raster Image Processor) 
technology. The system converts image files into a suitable RTP (Ready-To-
Print) format for direct, high-quality digital printing. The Spire CXP8000 
color server also streamlines the printing process by allowing printing with 
preset workflows.

In combination with the Xerox DocuColor 8000 Digital Press, the Spire 
CXP8000 color server enables you to efficiently print flyers, brochures, 
pamphlets, dummy catalogs, short-run trials, and print-on-demand 
publications. When installed as a fast, network printer with the Spire 
CXP8000 color server, the Xerox DocuColor 8000 Digital Press prints up 
to 80 full-color A4 (210mm x 297mm) or Letter (8.5 inches x 11inches) 
pages per minute.

Chapter 8 Graphic Arts Workflow This chapter contains the graphic arts workflow, 
which includes importing and supporting Graphic 
Art Port (GAP) files, performing a pre-flight check, 
and the Creo® Network Graphic Production 
workflow.

Chapter 9 Variable Information 
Workflow

This chapter contains the procedure for printing 
variable information jobs, from managing the VI 
data to converting PostScript® files to VI by splitting 
the file into a booklet.

Chapter 10 System Administration This chapter explains how to administrate your 
system using the Administration window utilities.

Table 1: Guide Overview

Chapter Contents Description



Overview of Spire CXP8000 Color Server 5

The Spire CXP8000 color server combines RIP functionalities, 
automation, control tools and special hardware development capabilities 
with PC architecture.

Spire CXP8000 color server for Xerox DocuColor 8000  Digital Press

WARNING:  A shielded ethernet cable must be used from the Token Ring board 
to the Token Ring Hub to maintain compliance with Council Directive 89/336/
EEC.
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Hardware and Software Components
The Spire CXP8000 color server is a dedicated Creo platform running in a 
Windows 2000 environment. 

The Spire CXP8000 color server includes:

• Creo hardware, including the interface board

• Software, including:

Creo Application Software

Windows 2000 Professional Operating System

Adobe® Acrobat® version 5.0

New Features
The new version of the Spire CXP8000 color server includes the following 
new features:

• New GUI Design
The Spire CXP8000 color server graphic user interface has been 
updated to a new design with new icons and a new feel that is more-
user-friendly. New features of the GUI include new options, such as 
user profiles and preference settings.

• Security Features
New and improved security features in the Spire CXP8000 color server, 
include access control, removable disk and disk wipe options. 

• Client Tools
The following have been added for client workstations: 

Font downloader for Windows fonts - The Spire CXP8000 color 
server provides a special hot folder for downloading fonts from a 
Windows client workstation. The hot folder is published in the 
Spire CXP8000 color server D:\HotFolders\HF_FontDownLoader. 
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You can use the HF_FontDownLoader hot folder to install new or 
missing fonts to the Spire CXP8000 color server fonts dictionary. 
The fonts are installed when you drag them to the hot folder.

XPIF support - The Spire CXP8000 color server can receive Xerox 
Programming Information Format (XPIF), and automatically 
convert this format to Spire CXP8000 color server job parameters.

UNIX connectivity – The NFS server enables the user to mount the 
Spire shared/hot folder

• Color and Quality Enhancements
The following color and quality enhancements have been added: 

Import RGB profiles – RGB source profiles can be imported via 
Profile Manager

Destination profile – Mapping to destination profiles according to 
paper sets

• Feature Enhancements
The following feature enhancements have been added: 

Dynamic page exceptions - More dynamic page exception 
commands within a job are supported, True Inserts within a job, 
Plex SPD commands, and Support XRX commands in PDF files. 
The Preflight parameter enables you to check if your file includes 
dynamic page exception commands.

Image position on a page level - The image position tool enables 
you to shift an image on a specific page or range of pages.

Pre-separated files - The Spire CXP8000 color server now supports 
pre-separated PostScript file and DCS file.These files are printed as 
composite files.

APR enhancements - The HiRes Path dialog box now includes the 
Search in the input folder check box. The Spire CXP8000 color 
server first searches for high-resolution images in the same folder as 
the PDL file, and then in the D:\Shared\High Res folder.
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Features
The Spire CXP8000 color server provides the following:

• Creating jobs in RTP format
Using the Spire CXP8000 color server, RTP files can be created and 
stored on the Spire CXP8000 color server itself. This enables you to 
print RTP data at any time without further processing.

• Powerful document printing capabilities
In combination with the Xerox DocuColor 8000 Digital Press, the 
Spire CXP8000 color server enables complete printing and processing 
of documents, including the production of covers and pages on 
different paper stocks. 

• Enhanced job editing 
The Spire CXP8000 color server enables you to edit jobs, both pre- and 
post-RIP. Pre-RIP editing includes full Adobe Acrobat functionality 
including: deletion, extraction, rotating, adding, and cropping of 
pages. Post-RIP editing includes deleting job pages and merging pages 
from different jobs to a new job. This minimizes the need to re-RIP 
jobs.

• RIP - Adobe Postscript Level III and Extreme Certified technologies
The Spire CXP8000 color server uses the industry-standard Adobe RIP, 
with enhancements for Continuous Tone and Linework. Data are 
processed separately as Continuous Tone and Vector Data layers for 
increased efficiency and merged during printing.

• Ready-to-Print job preview and editing
The Spire CXP8000 color server enables you to preview RTP jobs up to 
pixel levels to see all job details and to verify job quality and content 
post-RIP. It is also possible to view a thumbnail list of job pages, or the 
actual raster pages.

• Job management
The Spire CXP8000 color server enables you to monitor job progress 
during all stages of printing. Among other functions, you can promote, 
demote, delete, monitor the import process, and estimate when a job 
will be fully imported. You can also abort jobs during RIPing or 
printing, as well as archive and retrieve jobs.

• Enhanced text and line art quality 
You can choose superior text quality with the Creo proprietary 
algorithm. This function enhances the quality of diagonal lines, 
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borders, blends, and small text. The Creo anti-aliasing causes blends to 
appear smooth with no banding and diagonal lines to appear crisp 
without jagged edges (do not use this option with VI jobs).
You can choose superior image quality with the Creo proprietary 
smooth scale algorithm. This function improves the quality of images 
containing various resolutions (such as images taken from the 
Internet).

• Trapping - FAF (Full Auto Frame)
The Spire CXP8000 color server uses the well-known Creo algorithm 
to trap job information easily. The FAF algorithm has been tailored for 
digital printing.

• Imposition
The Spire CXP8000 color server offers a full suite of Imposition 
functions, based on the well-known Ultimate Imposition engine. On 
the Spire CXP8000 color server, imposition is robust with user-
friendly operation. And only the Spire CXP8000 color server enables 
imposition of Variable Information jobs.

• Color Management
The Spire CXP8000 color server has a number of color management 
tools and utilities that will help you to improve the quality of your jobs. 
The Spire CXP8000 color server enables you to modify color on-the-
fly, even for images that have already been RIPped. This functionality 
includes application of brightness and contrast adjustments, as well as 
changes to image gradation and calibration.

• Variable Information printing
The Spire CXP8000 color server enables processing of Creo Variable 
Print Specification and Xerox VIPP file formats and PPML for efficient 
VI (Variable Information) processing and printing. Repeated elements 
are RIPped once and cached, so there is no need to continually re-RIP 
them.
The Spire CXP8000 color server also provides easy management of VI 
elements, including previewing, deleting and updating. The Spire 
CXP8000 color server also offers imposition for VI jobs, the only 
digital solution in the industry with this capability.

• Creo workflow extenders
This is a set of Adobe Photoshop and QuarkXPress software plug-ins 
and extensions that facilitate printing with the Spire CXP8000 color 
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server. These extensions are located in the shared Utilities folder on the 
Spire CXP8000 color server or on CD #3 supplied with the Spire 
CXP8000 color server software kit.

Supported Formats
The Spire CXP8000 color server supports the following file formats:

• PostScript (composite or pre-separated files)

• PDF

• EPS

• Creo VPS (Variable Print Specification)

• VIPP (Variable Data Intelligent PostScript Params)

• PPML (Personalized Print Markup Language)

• GAP (Graphic Art Port) files (file formats from various prepress 
systems, for example Brisque job and TIFF / IT)

• Creo CT & LW

• JPG, TIFF

• Pre-separated formats

Workflow
The Spire CXP8000 color server receives and processes files from the 
following client workstations: 

• Macintosh – running Mac OS 9.x or later and Mac OS X (10.1 and 
later)

• Windows – running Windows 98, ME, Windows NT 4.0, 2000, and XP

• UNIX Workstations and Servers
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The Spire CXP8000 color server basic workflow is as follows:

User activates Print in the DTP
application

(for example, Microsoft PowerPoint).

User selects one of the default Spire
color server virtual printers

(for example, ProcessPrint).

File begins processing according to settings
predefined in the file or for the selected

virtual printer.

File  is spooled to the Spire color server.

After the job has completed processing, the
file is printed to the DocuColor printer, and

an RTP (Ready-to-Print) format of the job is
stored in the storage folder on the Spire

color server.
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Data Flow

The Spire CXP8000 color server Data Flow is as follows:

1. The input file arrives at the Spire CXP8000 color server from either a 
client workstation, local hard disk, or external media and is submitted 
to the Process queue. 

2. The processing sub-system produces a RTP job from the input file.

3. The RTP job is stored on an image disk.

4. When printing starts, the RTP job elements on the disk are 
decompressed and merged to the correct location on the page. This is 
done using Creo hardware.

5. The image delivery sub-system converts the RTP information into the 
print engine format.

6. The image delivery sub-system transmits the page information to the 
print engine.

7. The page data is delivered to the Print Engine and the job is printed.

Processing
Software

Decompress and
Page Assembly

(Hardware)

Image Delivery
(Printed Page)

Printer Disks RTP

PDL

RTP
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Spire CXP8000 Color Server Network Printers
For Macintosh and Windows networks, the Spire CXP8000 color server 
provides three default network printers, known also as virtual printers.

Virtual printers are a function used for automating workflows, which then 
define job streaming. They contain preset workflows that are automatically 
applied to all print jobs processed with that virtual printer. There is no 
need to reset job settings for each job, thus increasing printing efficiency.

The three default virtual printers are:

• SpoolStore
Files are spooled directly to the Storage window and await operator 
processing. You can only import PDL files (such as: PS, PDF, VIPP, 
VPS) to the spool store, not RIPped - RTP files. 

• ProcessPrint
Files sent to this virtual printer are processed and printed directly to 
the Xerox DocuColor 8000 Digital Press via the Spire CXP8000 color 
server.

• ProcessStore
Files sent to this virtual printer are automatically processed and stored 
in RTP format. After processing, the files are stored in the Storage 
window of the Spire CXP8000 color server until the print operator re-
submits them for printing.

With printing workflows tailored to your job requirements, the Spire 
CXP8000 color server enables you to: 

• Define new virtual printers

• Choose from which virtual printer to print

Note:  The job (print) parameters set in the job (from the client) override the 
parameters set in the virtual printer. 

For information on defining and editing virtual printers, see Managing Virtual 
Printers on page 218.
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Turning On the Spire CXP8000 Color Server
1. Turn on the monitor.

2. Press the power button on the front panel of the Spire CXP8000 color 
server.

The power indicator on the front panel lights up. The Windows 
operating system starts, and the Spire CXP8000 color server splash 
screen appears.
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Opening the Workspace From the Start Menu

The Spire CXP8000 color server program group appears in the Windows 
Start menu.

Select Start>CXP8000>CXP8000.

The Loading Drivers window appears and then the Spire CXP8000 
color server workspace.  

Notes:

• If the Spire CXP8000 color server workspace is already turned on, 
open the workspace from the Start menu. See Opening the 
Workspace From the Start Menu later in this chapter.

• By default, the Auto Log On check box is selected in the Settings 
window. This option enables you to open the workspace without 
having to go through the logon process each time. If you want to 
designate different access levels for each user, you need to set 
security settings in the Settings window. For more information 
about designating access levels, see Security on page 402.  

Note:  The Spire CXP8000 color server includes a diagnostics utility that can 
check the hardware components of the system. Only service engineers 
should use this utility.
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Logging On
By default, the Auto Log On check box is selected in the Settings window. 
This option enables you to open the workspace without having to go 
through the logon process each time. If you want each user to have to log 
on to the Spire CXP8000 color server, you need to clear the Auto Log On 
check box, and then assign each user an access level and password. 

The Login dialog box enables you to log on to the Spire CXP8000 color 
server with a designated access level and password. The system 
administrator assigns each user an access level, as follows:

• Operator (default): Enables the user to operate the Spire CXP8000 
color server and configure the Preferences area in the Settings window. 

• Administrator: Enables the user to access all features and settings in the 
Spire CXP8000 color server

• Guest: Enables the user to import a job through an existing virtual 
printer and view the workspace

Logging On as a Different User
If you are already working in the Spire CXP8000 color server workspace, 
you can change your access level—for example, if you are logged on as an 
operator and you need administrator privileges.

1. From the Job menu, select Logon as a different user.

2. In the Access level list, select a different access level.

For more information about designating access levels, see Security on page 402.
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3. If you want to log on as an administrator or operator, type your 
password.

4. Click Logon.

You are logged on with the new access level.

The Workspace
After you turn on the Spire CXP8000 color server, the workspace 
automatically appears.

Note:  If you want to log on as a guest, you do not need a password.

1

2

3

4

5

6

7

8
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Table 2 describes the Spire CXP8000 color server workspace.

Customizing the Workspace View

The View menu enables you to customize the workspace. From this menu, 
you can open and close the Queues window. The menu also provides the 
following view options:

Table 2: Spire CXP8000 color server workspace

Item Name Description

1 Menu Bar Consists of the Job, Selection, Tools, Control, View, and Help menus. 
Click a menu name to open the corresponding menu

2 Status Panel Contains the logo Pane, Processing status area, Printing status area, 
server icon, and printer icon

3 Toolbar Consists of shortcut buttons for the Import window, Resource Center, 
Message Viewer, and Calibration window

4 Queues Consists of the Process Queue, which lists the files to be processed. After 
a file has been processed successfully, it moves either to the Print Queue 
(the upper area) or to the Storage window.

5 Alerts Lists all of the alert messages that are generated during the workflow

6 Thumbnail Displays a thumbnail view of a specific page in an RTP job that has 
finished processing

7 Storage The Storage window contains files that:

• were successfully printed

• were held, were aborted, or failed during processing or printing

• were sent directly from the client workstation to the Storage window 
or were imported to the Storage window

8 Paper Stocks Displays information about the paper in each tray and also shows 
whether the trays are ready for printing
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• Spire classic view: Displays the status panel, toolbar, Storage window, 
Queues window, Thumbnail window, and Alerts window

• Spire classic plus view: Displays the status panel, toolbar, Paper Stocks 
window, Storage window, Queues window, Thumbnail window, and 
Alerts window

• Queues view: Displays only the Print Queue and Process Queue

• Refresh view: Reverts to the factory default view for the view that is 
currently displayed

The Server and Printer Monitors
The server and printer icons are on the right end of the status panel and 
indicate (through animation) whether processing and printing are taking 
place. If a finishing device is connected to the printer, the finishing device 
also appears in the printer icon. You can click the printer or server icon to 
display status information. You also view messages regarding the printer 
operation mode and status next to the printer icon. The calibration 
reminder indicator reminds you to calibrate the printer. You can set the 
reminder in the Settings window. 

 

Note:  The Spire CXP8000 color server always displays the workspace in the most 
recently selected view.

Tip:  By default, the windows in the workspace are all docked-that is, attached 
to the workspace. You can detach, or undock, a window from the workspace by 
right-clicking the window’s title bar and selecting UnDock Window.

For more information about setting the calibration reminder, see Color on 
page 413.

Server icon Printer icon

Calibration reminder

indicator
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The DFE Monitor 
Click the server icon to open the DFE Monitor window. This window 
displays information about disk space, network details, and the virtual 
printers you have defined. 

The Disk Usage tab shows how much space is available on the user disk and 
printer disk.

The Network tab provides information about the network.
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The Virtual Printers tab lists the virtual printers that you have defined.

The Printer Monitor
Click the printer icon to open the Printer Monitor window.

The Printer Monitor window displays information about the size and type 
of paper in each tray, the connected devices, the available toner, and other 
aspects of the consumables.

The Paper Stock tab displays information about the paper in each tray and 
also shows whether the trays are ready for printing.
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The Finisher tab displays information about finishing devices that are 
connected to the Xerox DocuColor 8000 Digital Color Press.

The Toner tab shows whether there is enough toner.
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The Consumables tab displays the status of other refillables.

The Settings Window

You can set all system preferences in the Settings window. 

To open the Settings window:

From the Tools menu, select Settings. 
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The window is divided into two areas: 

• Administration: All users can view these settings, but only an 
administrator can configure the settings. 

• Preferences: All users can view these settings, but only an 
administrator or operator can configure the settings. 

The Resource Center

The Resource Center enables you to add, remove, and manage external 
resources for the Spire CXP8000 color server.

To open the Resource Center:

From the toolbar, click Resource Center.

Note:  If you log on to the Spire CXP8000 color server as a guest, the Settings 
window is unavailable.

For more information about setting system preferences, see Setting Up and 
Configuring the Spire CXP8000 Color Server on page 392.
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The Resource Center provides access to the following resources:

• Virtual Printers, see Managing Virtual Printers on page 218 

• Fonts, see Managing Fonts on the Spire CXP8000 Color Server on 
page 297

• Imposition Templates, see Imposition Templates on page 238 

• Cached VI Elements, see Managing VI Elements on page 385 

• Paper Sets, see Managing Paper Sets on page 167 

• Profile Manager, see Profile Manager on page 346

The Job Parameters Window
The Spire CXP8000 color server enables you to edit imported PDL files and 
change the job settings—for example, paper size, imposition, and color 
settings—in the Job Parameters window.

To open the Job Parameters window:

Double-click a job in the Storage window.
Or:
Right-click a job in the Storage window, and from the menu select Job 
Parameters.
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The Job Parameters window title bar displays the following information:

• The name of the job

• The time of submission

• The name of the virtual printer

Each tab has a set of related parameters and values that you can select.

Table 3: Description of tabs in the Jobs Parameters window

This tab Enables you to

Print Settings Set print related job parameters—for example, 
Print range and Print method. See The Print 
Settings Tab on page 157

Paper Stock Set job parameters related to paper stock—for 
example, Paper size and Paper set name. See The 
Paper Stock Tab on page 166

Print Quality Set job parameters related to print quality—for 
example, Trapping and Image quality—and 
improve the quality of printed jobs. See The Print 
Quality Tab on page 175
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The Help Menu
The Help menu enables you to access the online help, which is based on 
this user guide, and provides information about the current version of the 
Spire CXP8000 color server installed on your computer.

Color Apply last minute color corrections, or set the 
output job to match other output devices. See 
Color Workflow on page 303

Imposition Set job parameters related to positioning, folding, 
trimming, and binding of pages—for example, 
Margins and Template. See The Imposition Tab on 
page 227 

Services Set job parameters that will assist your job 
workflow—for example, APR path and Preflight. 
See Creo APR on page 249, Preflight Check on 
page 368, Substituting Fonts on page 302, Applying 
VI Structure to Large Files (Split to Booklets) on 
page 389, and Job Deletion on page 383 

Finishing Select from various options to finalize your 
printed document—for example, define settings 
for the front and back cover. See The Finishing Tab 
on page 285

Exceptions Define paper sets to include special exceptions in 
a job, and add inserts or interleaves. See The 
Exceptions Tab on page 263 

Table 3: Description of tabs in the Jobs Parameters window

This tab Enables you to
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To open the About window:

From the Help menu, select About.

The About window displays the following information:

• Spire CXP8000 color server version number

• Date the version was installed

• Any updates that were installed on top of the version

To open the online help:

From the Help menu, select Topics.
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Handling Conflicts
If there are conflicts in the Job Parameters window, the Conflict window 
displays the two parameters that conflict—for example, Transparency 
conflicts with duplex printing. You can’t print your job until the conflict is 
resolved.

To resolve the conflict, select one of the following options:

• In the Resolve Options area, select a resolve option, and then click 
Resolve.

• Click Cancel to remove the value you selected for the last parameter.

Basic Job Workflow
The basic workflow in the Spire CXP8000 color server consists of three 
main stages:

1. Submitting a file from a client workstation, or importing and printing 
from the Spire CXP8000 color server, see Submitting on page 32

2. After a job is imported, the print engine starts to process the job, see 
Processing on page 33

3. The job is printed and stored in the Storage window for future use, see 
Storage on page 34
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Submitting 
There are two methods for submitting a file for printing:

• Submit a file from an application on your client workstation—for 
example, PDL formats that were created on client workstations that are 
not connected to the Spire CXP8000 color server, or files that are 
available only on external media. 

• You can also import job files that reside locally on the Spire CXP8000 
color server.

Printing From a Client Workstation
To print a job from a client workstation, select one of the following 
methods:

• Print the job via one of the Spire CXP8000 color server network 
(virtual) printers—for example, ProcessPrint.
The job is spooled and then processed or printed (according to the 
selected job flow of the virtual printer). If you use this method, you can 
print from any application —for example, Microsoft Word— and use 
any file format from any client workstation (Windows, Macintosh, or 
UNIX).

• Drag the job to a hot folder.
The job is spooled and processed or printed (according to the selected 
job flow of the corresponding virtual printer). 

If you use the hot folder method, you can print most PDL files on the 
Spire CXP8000 color server— for example, PostScript, PDF, EPS, 
Variable Print Specification, and VIPP files. 

For more information about hot folders, see Using Hot Folders on page 85.

Note:  PDL jobs that are spooled to the Spire CXP8000 color server must have 
the appropriate file name extensions—for example, *.ps or *.pdf.
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Importing and Printing From the Spire CXP8000 Color 
Server
You can import to the Spire CXP8000 color server any PDL file such as a 
PostScript or PDF file, that is located on any local or network drive —for 
example, a CD-ROM drive or a shared network drive.

Processing 
After a job enters the Spire CXP8000 color server, it resides in the Queues 
window or the Storage window, depending on the job flow. The Queues 
window consists of two areas: 

• The Process Queue lists the job currently being processed and all the 
jobs that are waiting to be processed. 

• The Print Queue lists the job that is currently printing and all the jobs 
that were processed successfully and are waiting to be printed. The 
Print Queue also lists frozen jobs (jobs for which the specified paper 
stock is not available).

Each queue holds jobs in the order in which they enter the queue (unless a 
rush job “interrupts” the submission order). 

The top job in the queue is the currently running job, while all the others 
are waiting to run. The Print Queue and Process Queue areas show you the 
number of jobs and their status. You can change the order of jobs, suspend 
them, resume them, or view and edit the parameters. 

For more information about rush jobs, see Running a Rush Job on page 195.
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Storage

Note:  If there are very short jobs in the Print Queue, several jobs may be 
running at the same time. The jobs marked as running are listed first and are 
printed in the order of the list.
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The Storage window is the main repository for jobs. It can contain:

• Completed jobs

• Jobs that were manually moved to the Storage window

• Jobs that were aborted during processing or printing

• Jobs that failed to complete processing or printing

• Jobs that were imported or spooled directly from a client workstation

Resubmitting 
You can easily reprint RTP jobs that are stored in the Storage window. 
Select the job you want to reprint and then submit it. The job is 
automatically placed in the Print Queue. 

The Spire CXP8000 color server enables you to change job parameters and 
edit jobs prior to reprinting.

You can change job parameters in the Job Parameters window. Certain 
changes to the job parameters require you to re-RIP the job. The Spire 
CXP8000 color server automatically determines whether your file requires 
re-RIPing and places it in the appropriate queue when you submit it for 
reprinting.

You cannot re-RIP jobs that you edit in the Job Editor. When you save a job 
in the Job Editor, a new RTP file is created. No PDL file is associated with 
it. Therefore, parameters requiring re-RIPing can’t be applied.

For more information about the Storage window, see Managing the 
Storage Window on page 196.

For more information about resubmitting a job, see Reprinting Jobs on 
page 156.

For more information about editing RTP jobs, see Editing an RTP Job on 
page 209.
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Turning Off the Spire CXP8000 Color Server
1. In the Spire CXP8000 color server workspace, from the Job menu, 

select Exit.
Or:
Click  in the upper-right corner of the Spire CXP8000 color server 
workspace.
The Spire CXP8000 color server workspace closes, and you return to 
the Windows desktop.

2. Verify that the Spire icon has disappeared from your taskbar.

3. From the Windows desktop, select Start>Shut Down. 

4. In the shutdown dialog box, select Shut down.

5. When the Windows shutdown is complete, turn off the monitor.

6. On the Spire CXP8000 color server, click the power button behind the 
front door. 
The power LED on the front panel turns off. 

Note:  If there are jobs that are being processed or printed, a message is 
displayed.

Taskbar without Spire iconTaskbar with Spire icon

Note:  Some situations may require the power button to be depressed for 
more than 4 seconds.
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Default Network Printers 
For Macintosh and Windows networks, the Spire CXP8000 color server 
provides three default network printers known as virtual printers, 
ProcessPrint, ProcessStore and SpoolStore.

Virtual printers contain preset workflows that are automatically applied to 
all print jobs processed with that virtual printer. Using virtual printers 
enables you to print jobs more efficiently.

The Spire CXP8000 color server enables you to select from which virtual 
printer to print. It also allows you to define new virtual printers, with 
printing workflows tailored to your specific job requirements.

An additional default network printer is provided for Macintosh networks. 

FontDownLoader
This is a special network printer that you use with Macintosh client 
workstations to download fonts. The FontDownLoader enables you to 
send fonts to the Spire CXP8000 color server and use these fonts later in 
printed jobs. It is not possible to send files via the FontDownLoader, only 
fonts.

Note:  Unless you select the Override PPD parameters check box when you 
add a virtual printer, the job (print) parameters that are set in the job will override 
the parameters set in the virtual printer.

For more information about virtual printers, see Managing Virtual Printers on 
page 218 and Spire CXP8000 Color Server Network Printers on page 13.

For

For more information about the Fontdownloader, see Using the Fontdownloader 
for Macintosh Networks on page 298.
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Setting PPD File Parameters 
You can set job parameters from a client workstation using the Spire 
CXP8000 color server PPD file or you can define a virtual printer with 
predefined PPD file settings.

To print a file from Windows, you first need to set up a Spire CXP8000 
color server network printer with the appropriate PPD file. The PPD file 
contains all the parameters and paper stock definitions for the printer and 
enables you to print your file properly. 

To use the Spire CXP8000 color server PPD file:

In the Print window of your application, select print settings specific to 
printing to the Spire CXP8000 color server. 

To define a virtual printer:

Set job parameters when you create or edit a virtual printer. 
These settings become the printer's default options.

The following table lists the PPD file parameters and the printing options 
that can be selected from the Print window of an application.

For more information about print settings, see Printing From Windows on 
page 64 and Printing from a Macintosh on page 75.

For more information about virtual printers, see Adding a new printer on 
page 218 and Editing an Existing Printer on page 221.

Notes:

• In the PPD file, the Printer’s Default option is selected for all PPD file 
parameters. The Printer’s Default option corresponds to the settings of the 
currently selected virtual printer.

• The parameter settings that were last modified or applied are the settings 
that are applied to the job. However, the print settings defined in the job file 
override the settings of the virtual printer.

• Grayscale images created in RGB applications (such as PowerPoint) should be 
specified as monochrome or you should select Gray RGB>Print grays using 
black toner in the PPD file when you submit the job to the Spire CXP8000 
color server. This selection ensures that grayscale images are counted as 
black and white instead of color in both the Spire CXP8000 color server and 
in the Xerox DocuColor 8000 Digital Color Press billing meters.
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Table 4: PPD parameters

PPD Parameter Printing Options

Print Method Simplex prints single-sided pages (default).
In Duplex Head to Toe, the image on the reverse side of the sheet is 
rotated 180 degrees. It is used for calendar-style hard copies and 
presentation-style copies (usually used with landscape jobs).
In Duplex Head to Head, the head of the image appears at the top of the 
page on both sides of the sheet. It is used for normal book-style hard 
copies (usually used with portrait jobs).

Image orientation 
for imposition

Landscape specifies a landscape orientation for imposition.
Portrait specifies a portrait orientation for imposition.

Reverse Print 
Order

Yes starts printing from the last page.
No starts printing from the first page.

Face Up Face Up delivers the pages face up on the printer.
Face Down delivers the pages face down on the printer (when printing 
confidential documents).

Collation Yes prints a complete copy of the job before the first page of the next 
copy is printed.
No prints all the copies of each page before all the copies of the next page 
are printed. 

Image Scale Select Fit to paper for the image to fit the selected paper in the paper 
stock
100% prints at 100% of the original size (default)
Select an image scale by which to proportionally increase or decrease the 
image size, 50%, 150%, 200%, 250%, 300%, 350%, 400%

Rotate 180 Yes (only relevant for the Finisher Module > HCSS Staple Tray option), 
modifies the stapling position by 180 degrees. For example, instead of 
stapling on the upper left-hand corner, you can staple on the lower 
right-hand corner.
No ignores this method.

Paper set Undefined uses the parameters from the Paper Stock tab 
Paper sets 1-10 are the predefined paper sets available on the Spire 
CXP8000 color server

Type Select Paper or Transparency as the media. 



Setting PPD File Parameters 41

Weight Select the desired paper weight from the list. The following ranges are 
listed: 60-80, 81-105, 106-135, 136-186, 187-220 and 221-300 For 
example, 81-105 gsm prints on 81-105 gsm paper.

Coating Coated prints on coated paper.
UnCoated prints on uncoated paper.

Text and Line 
Quality

Normal provides standard text quality.
Anti Aliasing provides superior text quality. The Creo anti-aliasing 
causes blends to appear smooth with no banding and diagonal lines to 
appear crisp without jagged edges.
Sharpen edges provides superior text quality.

Image Quality High provides superior image quality. This setting applies the Creo 
proprietary smooth scale algorithm, which improves the quality of 
images containing several resolutions (such as images taken from the 
Internet).
Normal provides standard image quality and increased RIPing speed.

Trapping Yes applies the Creo FAF (Full Auto Frame) algorithm to the job.
Trapping solves misregistration between color separations in offset and 
digital printing. This occurs regardless of the printer device accuracy. 
This problem results in white lines around objects on top of a 
background (in a knock-out procedure) and also between adjacent 
colors. The FAF solution is to extract the element or background to 
create an overlap between them. Do not use this option with VI jobs.
No does not begin image trapping while RIPing (this does not affect 
trapping incorporated by the authoring application). If trapping was 
applied in the authoring application, select No.

Table 4: PPD parameters

PPD Parameter Printing Options
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Black Overprint Yes provides better printing quality (as in FAF) and a richer, deeper 
black with the underlying CMY values equal to those of the printed 
background. As a result, misregistrations are not visible.
Black Overprint ensures that 100% black text prints cleanly within a tint 
or picture area. Occasionally, white lines may appear around black text 
and the text may appear less dense than desired as a result of 
misregistration between color separations. With Black Overprint, the 
Pure Black Text / Graphics option is automatically activated and there 
are no knock-outs under the black text. However, a knock-out occurs 
when you print only the topmost color. This results in less color density 
and can cause misregistration if separations are not perfectly aligned.
No leaves the job as is.

PS Overprint PS Overprint offers the option to use the overprint, which exists in the 
PostScript file. It also determines whether the DTP application PS 
Overprint settings are honored in the RIP.
Spire CXP8000 color server settings override PS Overprint commands 
from DTP applications. For example, if PS Overprint was set to Yes in a 
DTP application, selecting PS Overprint No in the Spire CXP8000 color 
server results in no overprinting. The Spire CXP8000 color server can 
not create PS Overprint that is not predefined in the file. Selecting PS 
Overprint Yes for a file that has not had overprinting defined in a DTP 
application does not result in overprinting.
Yes (default) instructs the RIP to use the overprint information that 
exists in the input PostScript file. Also, if PS Overprint is applied in a 
DTP applications, it is implemented by the Spire CXP8000 color server. 
Background colors are not knocked out. 
For example, in the case of a yellow triangle overlapping a cyan circle, 
selecting Yes results in the overlapping area turning green. This is not 
seen on the screen, only in print.
No ignores the overprint information that exists in the input PostScript 
file. Background colors are knocked out and only the top most color 
parts are seen on the screen in your DTP application.
For example, in the case of a yellow triangle overlapping a cyan circle, 
selecting No results in the cyan background being knocked out, so only 
the yellow is printed. 

Table 4: PPD parameters

PPD Parameter Printing Options
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Image Noise No (default) applies no image noise to your job.
Noise 2-10 apply image noise. The higher the level, the smoother the 
vignettes appear.

Color Mode Grayscale prints all pages using black (K) toner only.
Color prints all pages using all CMYK toners.
If you selected Color, select the Print grays in black toner option in the 
Gray RGB list to print RGB gray images using black toner only. If you 
want grayscale CMYK elements to be printed using black toner only, you 
need to select Perceptual as the rendering intent.

RGB Workflow This option changes gamma values, thus producing more color depth 
for RGB images. To use the embedded CSA, select Use Source CSA. To 
replace use a Spire or Adobe CSA, select Use Spire RGB 1.8, Use Spire 
RGB2.1, Use Spire RGB 2.4, Use sRGB, or Use Adobe RGB.

Gray RGB Select Print grays using CMYK to print grayscale CMYK elements using 
black toner only.
Select Print grays in black toner to print RGB gray images using black 
toner only.

Rendering Intent 
for RGB

Rendering intent defines how colors are compressed from CIELAB 
values to printer color space.
Relative Colorimetric provides an accurate general-purpose gamut 
mapping for all applications. The lowest density is mapped to white.
Absolute Colorimetric preserves the substrate tint.
Saturated (presentation) produces saturated colors that are suitable for 
office environment applications —for example, text documents and 
presentations.
Perceptual (photographic) yields the most effective results on 
continuous tone and images.
Saturated (presentation) and Perceptual (photographic) are the most 
effective rendering intent methods for RGB images.

Table 4: PPD parameters

PPD Parameter Printing Options
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CMYK Workflow Select Use Original CMYK values, Use Source CSA, or select a CMYK 
emulation, Printer’s Default (None), Fogra Gloss Emulation, Fogra Matt 
Emulation, Fogra Uncoated, Euroscale, Gravure, Japan_Color, Offset, 
Match Print, iGen3 or SWOP.
Printer’s Default (None), applies Ink Saving (GCR) without emulation.
In all cases, emulation applied in the original DTP application overrides 
the Spire CXP8000 color server settings.

Emulate Source 
Paper Tint

Yes to emulate also the original paper tint.
No
This parameter is available only if you selected an emulation method.

Emulate RGB 
Elements

No 
Yes to emulate RGB colors according to the selected CMYK emulation 
method.
This parameter is available only if you selected an emulation method.

Preserve Pure 
Colors

Yes to emulate pure CMYK colors.
No
This parameter is available only you selected an emulation method.

Rendering Intent 
for CMYK

Rendering intent defines how colors are compressed from CIELAB 
values to printer color space.
Relative Colorimetric provides an accurate general-purpose gamut 
mapping for all applications. The lowest density is mapped to white. 
Perceptual (photographic) yields the most effective results on 
continuous tone and images.
Saturated (presentation) produces saturated colors that are suitable for 
office environment applications (for example text documents and 
presentations).
Absolute Colorimetric preserves the substrate tint.
Relative Colorimetric and Absolute Colorimetric are the most effective 
rendering intent methods for CMYK images.

Use Spire Spot 
color dictionary

Yes to use the Spire spot color dictionary.
No

Table 4: PPD parameters

PPD Parameter Printing Options



Setting PPD File Parameters 45

Destination profile Linked uses the destination profile that was mapped to a paper color in 
the Resource Center>Profile Manager
DC_8000_C.GA and DC_8000_U.COM are predefined destination profiles.  

Calibration Normal prints using the normal calibration table.
Saturated prints using the saturated calibration table.
None prints without calibration, therefore, there is no balance between 
colors and gives no color calibration data.

Screening Method Automatic applies two types of screens: 

• For CT, the system uses Dot type screen of 200 lpi. 

• For LW (text / line-art elements), the system uses Line type screen of 
200 lpi. 

Dot 150 applies Dot type screen of 150 lpi.
Dot 200 applies Dot type screen of 200 lpi.
Line 200 applies line type screen of 200 lpi.
Line 300 applies line type screen of 300 lpi.
Line 600 applies line type screen of 600 lpi.

Ink Saving (GCR) No does not use GCR and uses default maximum toner settings.
Use Low, Medium, or High to set the amount of CMY toners to be 
replaced by the black toner. High provides low ink coverage while saving 
on toner (this prevents the occasional peeling of ink and the curling 
effect that may occur when printing transparencies).

Brightness Brightness settings can be applied to RTP jobs without reprocessing (re-
RIPing the file).
Normal keeps the current job setting and does not apply extra 
brightness.
To apply brightness, select one of the range options: Light (5%), Lighter 
(10%), Lightest (15%), Dark (5%), Darker (10%), Darkest (15%).

Contrast Contrast settings can be applied to RTP jobs without reprocessing (re-
RIPing the file).
Normal keeps the current job setting and does not apply extra contrast.
To apply contrast, select Less Contrast or More Contrast. 

Table 4: PPD parameters

PPD Parameter Printing Options
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Automatic 
Deletion

Always, Never, Successful Only, Failed Only
On large VI jobs, which take up a large amount of the Spire CXP8000 
color server’s disk space, it is recommended (if you do not need to 
reprint the job) that you use the this option. Completed and failed jobs 
are automatically saved in the Storage window unless you select one of 
the Job Deletion options.
Always removes all jobs after they are printed.
Never does not delete any job after printing it.
Successful Only continuously deletes pages once they have been 
successfully printed and thus sustains enough free disk space for the 
duration of the print run. Each successfully printed page of the job is 
immediately deleted while the rest of the job remains in the queue to 
print.
Failed only removes failed jobs (while processing or printing) from the 
Spire CXP8000 color server.

APR Print with High Res prints using high-resolution files.
Print with Low Res prints using low-resolution files.

Job Flow Process Print RIPs the PDL files and prints them, and then moves the 
files to the Storage window or deletes them in accordance with the 
deletion policy.
Process Store RIPs the PDL files, and then moves them to the Storage 
window as RTP jobs.
Spool Store copies the PDL files directly to the Storage window.

Split to booklets Select the desired number of pages (1-10) per booklet.
Printers Default (No) does not split the job to booklets.

Admin Page Admin Page includes general information about the job, including paper 
stock parameters (Admin Page can also apply to completed jobs that 
weren’t successful).
Admin page is printed in the same order as the job, before each set for 
face-down printing and after each set for face-up printing.
No (default) does not print an admin page with the job.
Yes prints an admin page.

Table 4: PPD parameters

PPD Parameter Printing Options
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Slip Sheet Yes inserts a sheet offset from the job stock between jobs or copies of a 
job or at the end of uncollated stacks of pages.
No does not insert any slip-sheets.

Finisher Module To select the printed output’s destination, select a finisher module from 
the list: 
OCT (Offset Catch Tray) prints to the output cache tray. 
If your printer is equipped with an HCS (High Capacity Stacker), select: 
HCS Top Tray to print to the top tray.
HCS Stack Tray to print to the stack tray, which is the internal tray.
If your printer is equipped with an HCSS (High Capacity Stacker 
Stapler), select:
HCSS Top Tray to print to the top tray.
HCSS Stack Tray to print to the stack tray (usually for many pages or 
copies). 
HCSS Staple Stack to print a document that is already stapled. 
DFA Profile 1 / DFA Profile 2 / DFA Profile 3 / DFA Profile 4 / 
DFA Profile 5 prints to the DFA (Document Finishing Architecture) 
device. Select the desired profile according to the profile set in the Xerox 
DocuColor 8000 Digital Color Press.

Finisher Offset Yes shifts the sheets when a new page number is delivered. For example, 
if you requested three copies of each page uncollated, the printing 
output sequence is as follows, Page1, Page1, Page1, Offset, Page2, Page2, 
Page2, Offset, and so on.
No does not use this printing method.

Staple Options Landscape - Single TL a single staple in the top left corner.
Landscape - Single TR a single staple in the top right corner.
Landscape - Dual Right two staples along the right side.
Landscape - Dual Left two staples along the left side.
Landscape - Dual Top two staples along the top.
Portrait - Single TL a single staple in the top left corner.
Portrait - Single TR a single staple in the top right corner.
Portrait- Dual Right two staples along the right side.
Portrait - Dual Left two staples along the left side.
Portrait - Dual Top two staples along the top.

Table 4: PPD parameters

PPD Parameter Printing Options
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Working From Windows Client Workstations
The Spire CXP8000 color server can print from a Windows client 
workstation that has one of the following operating systems:

• Windows 98, Windows ME

• Windows NT 4.0, Windows 2000, Windows XP

The following section describes how to define a Spire CXP8000 color 
server network printer for each of the supported operating systems.

Defining a Printer on Windows Client Workstations
You use the Windows Add Printer wizard to define the Spire CXP8000 
color server network printers. 

Defining a Printer on Windows NT 4.0

To define a network printer using the Windows Add Printer wizard:

1. On your Windows desktop, click the Start button and select 
Settings>Printers.

2. Double-click the Add Printer icon. 

3. Select Network printer server, and then click Next.

Note:  When you add a new Spire CXP8000 color server network printer to a 
client workstation, there is no need to install the Spire CXP8000 color server PPD 
file and Adobe PostScript printer driver separately. They are installed 
automatically in the Windows Add Printer wizard.
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4. In the network, locate the Spire CXP8000 color server and double-
click the server name. 

A list of the network printers is displayed.

5. Select one of the network printers—for example, ProcessPrint—and 
then click OK.

6. Select Yes if you want to set this printer as the default printer on your 
computer. Otherwise, select No. 

7. Click Next.

8. Click Finish to complete the setup.
The Spire CXP8000 color server network printer is now successfully 
installed. 

To define a network printer using the network neighborhood:

1. Locate the desired network printer.

2. Double-click the network printer icon.

3. In the message that appears, click Yes to setup the printer.

The network printer is defined on your Windows client workstation.

Note:  The Spire CXP8000 color server is provided with three network 
printers, ProcessPrint, ProcessStore and SpoolStore.
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4. From the Printers list, select the Spire CXP8000 color server, and then 
click Next.

Defining a Printer - Windows 98

To define a network printer using the Windows Add Printer wizard:

1. On your Windows desktop, click the Start button, and follow the path 
Settings>Printers.

2. Double-click the Add Printer icon. 

The Add Printer wizard appears.

3. Click Next.

4. Select Network printer, and then click Next.

Note:  To install additional network printers, repeat the process.

Note:  When you add a new Spire CXP8000 color server network printer to a 
client workstation, there is no need to install the Spire CXP8000 color server PPD 
file and Adobe PostScript printer driver separately. They are installed 
automatically in the Windows Add Printer wizard.
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5. Type the network path or the queue name of your printer
Or:
If you don’t know the exact name, click Browse to view the available 
network printers.

a. Select one of the network printers—for example, ProcessPrint.

b. Click OK.

6. Click Next.

7. Select Yes if you want to set this printer as the default printer on your 
computer. Otherwise, select No. 

8. Click Next.
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9. Select Yes to print a test page.

The Spire CXP8000 color server network printer is now successfully 
installed. 

10. Click Finish to complete the setup.

To define a network printer using the network neighborhood:

1. Browse to the desired network printer.

2. Double-click the network printer icon.

The Add Printer wizard appears and the network printer is defined on 
your Windows client workstation.

Defining a Printer - Windows 2000 and Windows ME

To define a network printer using the Windows Add Printer wizard:

1. On your Windows desktop, click the Start button and follow the path 
Settings>Printers.

2. Double-click the Add Printer icon. 

The Add Printer wizard appears.

3. Click Next.

Note:  To install additional network printers, repeat the process.

Note:  When you add a new Spire CXP8000 color server network printer to a 
client workstation, there is no need to install the Spire CXP8000 color server PPD 
file and Adobe PostScript printer driver separately. They are installed 
automatically in the Windows Add Printer wizard.
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4. Select Network printer.

5. Click Next.

6. Select Type the printer name, or click Next to browse for a printer.
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7. In the Name box, type the exact name of the printer. 
Or:
Click Next to browse for a printer. 

8. Select one of the network printers—for example, ProcessPrint.

9. Click Next. 

10. Select Yes if you want to set this printer as the default printer on your 
computer. Otherwise, select No.

11. Click Next.

12. Click Finish to complete the setup.

The Spire CXP8000 color server network printer is now successfully 
installed.

To define a network printer using the network neighborhood:

1. Locate the desired network printer.

2. Double-click the network printer icon.

3. In the message that appears, click Yes to setup the printer.

The network printer is defined on your Windows client workstation.

Note:  To install additional network printers, repeat the process.
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Defining a Printer - Windows XP

To define a network printer using the Windows Add Printer wizard:

1. On your Windows desktop, click the Start button and select Printers 
and Faxes.

2. In the Printer Tasks area, select Add a printer.

The Add Printer wizard appears.

Note:  When you add a new Spire CXP8000 color server network printer to a 
client workstation, there is no need to install the Spire CXP8000 color server PPD 
file and Adobe PostScript printer driver separately. They are installed 
automatically in the Windows Add Printer wizard.
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3. Click Next.

4. Select A network printer, or a printer attached to another computer 
and click Next.

5. Select Browse for a printer, and click Next.
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6. Locate the Spire CXP8000 color server and double-click it to display 
the list of network printers.

7. Select the printer you wish to setup, and click Next.

8. Select Yes if you want to set this printer as the default printer on your 
computer. Otherwise, select No.

9. Click Next.

10. Click Finish to close the wizard.

The Spire CXP8000 color server network printer is added to your 
printer list.

To define a network printer in Windows XP using the network 
neighborhood:

1. Locate the desired network printer.

2. Double-click on the network printer icon.

The network printer is defined on your Windows client workstation.

Note:  To install additional network printers, repeat the process
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Creating PostScript Files on Windows 
The following procedures describe how to create PostScript files using the 
Spire CXP8000 color server from the client workstation. This is useful 
when you are not connected to the Spire CXP8000 color server and you 
need to distribute jobs for printing on the Spire CXP8000 color server 
remotely or on external media. These files can then be imported to the 
Spire CXP8000 color server for printing.

To create a PostScript File:

1. Open a job in your DTP application —for example, Microsoft Word— 
and from the File menu, select Print.

2. Select the Print to File check box.

3. Click OK.

A PostScript file is created.

To define a print to file printer locally:

1. Start the Adobe PostScript Driver application (the application is 
available on CD#3 in the Utilities folder (AdobePSDriver.exe), or at 
Adobe's Web site at http://www.adobe.com/support/downloads/
main.html).

The Welcome window appears.

http://www.adobe.com/support/downloads/main.html
http://www.adobe.com/support/downloads/main.html
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2. Click Next.

The End User Agreement window appears.

3. Read the license agreement and click Accept.

4. Select It is directly connected to your computer (Local Printer) and 
click Next.

5. In the Available ports list, select File: Local Port and click Next.
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The next step is to configure the printer with the Spire CXP8000 color 
server PPD file. The Spire CXP8000 color server PPD file is located in 
a shared folder on the Spire CXP8000 color server.The Spire CXP8000 
color server PPD file name is CXP8K801.

6. Click Browse. 
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7. Click the Network button and browse to your Spire CXP8000 color 
server.

8. Locate the Spire CXP8000 color server and double-click on the server 
icon. Then, double-click the Utilities folder. 

9. Click OK.

10. Double click the PPD folder and select the Spire CXP8000 color server 
PPD file name,

11. Click OK.
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12. In the Printers list, select the Spire CXP8000 color server printer, and 
then click Next.

13. In the Sharing dialog box, select Not Shared, and then click Next.

14. Type a name for the printer which you will be able to identify on the 
client workstation—for example CXP8000_ProcessStore. 

15. Select Yes (Recommended) if you want to print a test page or select 
No, and then click Next.

16. Click Install to install the print to file printer with the Spire CXP8000 
color server PPD file. When prompted to configure the printer, click 
Yes, and then click Next.

17. Select Yes.
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18. Click Next.

19. Configure the printer according to your specifications, and then 
click OK.

20. Click Finish to complete the setup.

The printer appears in the Printers window.

You are now ready to print *.ps and *.prn files. Once printed, these files 
can be imported and printed on the Spire CXP8000 color server.
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Copying the PPD File from Windows
You need to use the Spire CXP8000 color server PPD file to create 
PostScript files to send to the Spire CXP8000 color server. Therefore, you 
should copy and distribute the Spire CXP8000 color server PPD file to your 
customer. 

To copy the PPD file from the Spire CXP8000 color server for 
distribution on a disk or by e-mail:

1. On the Windows desktop, double-click the Network Neighborhood 
icon.

2. Locate and select the Spire CXP8000 color server station—for 
example, V4_CXP8000.

3. Double-click the Utilities folder, and then double-click the PPD folder.

4. Double-click the folder for the desired language—for example, 
English.

5. Copy the PPD file to a disk or send it by e-mail to the customer.

Printing From Windows
1. Open the file you would like to print in the corresponding 

application—for example, open a PDF file in Adobe Acrobat.

2. From the File menu, select Print. 

The Print window appears.

3. From the Name list, select the desired Spire CXP8000 color server 
network printer—for example, Spire_ProcessPrint.

For more information about installing Spire CXP8000 color server network 
printers on client workstations, see Working From Windows Client 
Workstations on page 48.
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4. If desired, click the Properties button and modify the job parameters.

5. Click OK.

6. Click OK in the Print window.

The file is sent to the Spire CXP8000 color server. 

Working From Macintosh Client Workstations
This section describes how to define a Spire CXP8000 color server network 
printer for Macintosh client workstations. The Spire CXP8000 color server 
can print to Macintosh client workstations running Mac OS 9 and Mac OS 
X (10.2).

You can also submit jobs using the Spire CXP8000 color server virtual 
printers over a TCP/IP protocol. This connection enables a significantly 
higher spooling speed.

Notes:

• Unless the Override PPD Parameters option was selected in the 
virtual printer, any changes to the printer parameters override the 
parameters of the selected virtual printer. 

• Printer's Default indicates that the value is taken from the settings of 
the selected virtual printer on the Spire CXP8000 color server.

For more information about TCP/IP protocol, see Spire Over TCP/IP on page 108.
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Defining a Printer on Macintosh Client Workstations

Copying the Spire CXP8000 color server PPD File for 
Mac OS 9
Before setting up a Spire CXP8000 color server network printer, you need 
to install the Spire CXP8000 color server PPD file on your Macintosh client 
workstation.

1. From the Apple menu, select Chooser.

2. Select AppleShare, and then locate the Spire CXP8000 color server on 
the network.

3. Click OK.

The Login window appears.

4. Select the Guest option, and then click Connect.

The corresponding Spire CXP8000 color server window appears.
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5. Select Utilities, and then click OK.

6. On the desktop, double-click the Utilities volume.

The Utilities window appears.

Note:  Do not select the Utilities check box. If you do, Utilities will mount 
with every reboot.
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7. Double-click the PPD folder, and then double-click the folder for the 
desired language—for example, English. 

8. Copy the PPD file to the System Folder>Extensions>Printer 
Descriptions folder.

The Spire CXP8000 color server PPD file is now installed in the Printer 
Descriptions folder. It is ready to be configured with one of the Spire 
CXP8000 color server network printers. 

Setting the Network Printer for Mac OS 9
1. Make sure that the Spire CXP8000 color server PPD file has been 

copied to the Printer Descriptions folder on your client workstation.

2. From the Apple menu, select Chooser.

For more information about copying the PPD file, see Copying the Spire 
CXP8000 color server PPD File for Mac OS 9 on page 66.



Working From Macintosh Client Workstations 69

3. Select LaserWriter and then locate the Spire CXP8000 color server on 
the network.

4. Select one of the Spire CXP8000 color server's network printers—for 
example, CXP8000_ProcessStore—and click Create.

The system automatically locates the Spire CXP8000 color server PPD 
file and configures the printer as a Spire CXP8000 color server network 
printer.

If you have the Desktop Printer Spooler extension enabled, a printer 
icon appears on the desktop. 

Note:  Use this icon when you want to download PostScript files to the Spire 
CXP8000 color server.
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Copying the Spire CXP8000 Color Server PPD File for Mac OS 
X (10.2)
Before you define a network printer you need to install the Spire CXP8000 
color server PPD file on your Macintosh client workstation.

1. From the Go menu, select Connect to Server.

The Connect to Server window appears.

2. Locate the desired Spire CXP8000 color server, and then click 
Connect.

3. Select Guest, and then click Connect.
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4. Select the CXP8000_Utilities folder, and then click OK.

The CXP8000_Utilities folder is mounted on your desktop.

5. Double-click the CXP8000_Utilities folder on your desktop.

6. Double-click the PPD folder, and then double-click the folder for the 
desired language.

7. Copy the PPD file from the Spire CXP8000 color server to your 
Macintosh hard disk.
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Setting the Network Printer for Mac OS X (10.2)
1. Copy the Spire CXP8000 color server PPD file to the 

Library>Printers>PPDs folder on your client workstation.

2. From the Go menu, select Applications.

3. Open the Utilities folder and double-click the Print Center icon.

For more information about copying the PPD file, see Copying the Spire 
CXP8000 Color Server PPD File for Mac OS X (10.2) on page 70.
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4. Click Add Printer.

5. Select AppleTalk as the connection type and then locate the Spire 
CXP8000 color server.

6. In the Printer Model list, select Other.

7. Locate the folder to which you have copied the PPD file, and then 
select the file.

Note:  If you would like to use the LPR protocol instead, see the procedure 
Setting up an LPR Printer in Macintosh OS X (10.2) on page 106.
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8. Click Choose to assign the PPD file to the selected Spire CXP8000 
color server network printer.

9. Click Add to add the new printer to the printer list.
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Printing from a Macintosh
1. Open the file you would like to print, in the corresponding 

application—for example, open a Quark file.

2. From the File menu, select Print.

3. From the Printer list, select the desired printer—for example, 
Color_ProcessPrint.

4. To set job parameters, click General and from the pop-up menu, select 
one of the Printer Specific Options.

For more information about installing the Spire CXP8000 color server 
network printers on client workstations, see Copying the Spire CXP8000 
color server PPD File for Mac OS 9 on page 66 and Setting the Network 
Printer for Mac OS X (10.2) on page 72.
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A window similar to the one shown below appears. 

5. Adjust the printer options as desired.

6. After modifying the job settings, click Print.

The file is sent to the Spire CXP8000 color server. 

Spire Web Center
The Spire Web Center is an internet site that provides online Spire 
information and can be accessed from client workstations. 

The Spire web center enables you to:

• View the status of jobs in the Spire queues, the Alerts window in its 
current state, and the printer system information

• Download remote client tools, utility applications, color profiles, and 
print drivers

• View Spire related documentation, such as release notes, Spire guides, 
frequently asked questions and answers, and other troubleshooting 
information

• Find links to related vendors or products

Notes:

• The Printer's Default option indicates that the value is taken from the 
virtual printer that is currently selected.

• The PPD parameters are divided into five Printer Specific Options in 
the drop-down menu.
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To connect to the web center from a client workstation:

1. On your desktop, click the Internet Explorer icon.

2. When the Internet Explorer starts, in the address field type: 
http://<spire name>—for example, if the Spire station name is 
FALCON_E, type http://FALCON_E.

Important:  To connect to the Spire Web Center from a client workstation, you 
must first enable the web connect service on the Spire CXP8000 color server. To 
enable this service, select the Settings window>Administration>Remote 
Tools Setup.

For more information about setting up the web connect service, see Remote 
Tools Setup on page 399.

Note:  You can also use the Spire color server IP address—for example, 
http://192.168.92.0.

Important:  If you would like to connect to the Spire CXP8000 color server 
from a Macintosh client workstation, contact your system administrator to 
add the Spire name to the DNS. This is required since Windows name 
resolution protocols are not supported in Macintosh. The DNS addition is 
required when clients go through a main server on the network.
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The Spire CXP8000 color server Web Center appears.

The Web Viewer
The Web Viewer page enables you to view the printer configuration and 
system information, the jobs that currently reside in the Spire CXP8000 
color server Queues window and Storage window, and to view the alerts 
that currently appear in the Alerts window. This information is important 
when you print from a client workstation because it enables you to 
monitor your jobs in the queues and then make any necessary changes. 

In addition, if you have a system that uses XML protocol, you can retrieve 
information about the job list and printer status.
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The Queues tab
In the Queues tab you can view the jobs that are currently running in the 
Spire CXP8000 color server Print Queue and Process Queue. 
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The Storage tab
In the Storage tab you can view the Spire CXP8000 color server Storage 
window and the jobs that reside in this window. 
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The Alerts tab
In the Alerts tab you can view the Spire CXP8000 color server Alerts 
window messages. For example, if a job that you sent to print from your 
client workstation has failed—you can view the message in the Alerts 
window, edit the job parameters (PPD file), and then resend it for 
processing and printing on the Spire CXP8000 color server.
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The Printer tab
In the Printer tab you can view the Spire CXP8000 color server system 
information.

Web Viewer API
The JobList.xml file and the Printer Status.xml file enable you to retrieve 
information about the job list and the printer status.

The JobList.xml file contains information about files in the Print Queue, 
Process Queue, and the Storage window.

To see the Job List view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=JobList_xml.

The Printer Status.xml file contains information about the various printer 
states. To see the Printer State view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=PrinterStatus_xml.
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Downloads
The Downloads page enables you to access the Spire CXP8000 color server 
Utilities folder and download available tools and files for Windows and 
Macintosh client workstations—for example, the Spire CXP8000 color 
server PPD file.
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Links
The Links page enables you to link to related vendors or products.
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Using Hot Folders
For every published Spire CXP8000 color server network printer that you 
define on a client workstation, a corresponding hot folder is automatically 
created in the Spire CXP8000 color server D:\Hot Folders folder. The Spire 
CXP8000 color server has three default hot folders, HF_ProcessPrint, 
HF_ProcessStore, and HF_SpoolStore. These hot folders correspond to the 
three default printers.

Each hot folder carries the virtual printer's name (HF_printer’s name), see 
the following graphic.

When you connect from a client workstation to the Spire CXP8000 color 
server over the network, you can use the hot folder to submit PDL jobs to 
the Spire CXP8000 color server. When you establish a connection, drag 
your jobs onto the desired hot folder (according to the selected workflow).

Jobs that reside in the hot folder will automatically be submitted to the 
Spire CXP8000 color server through the corresponding virtual printer. 
Consequently, all of the virtual printer job parameters, inclusive of the 
workflow, will be applied to the job.

Tip:  You can also drag the hot folder icon to your desktop to create a short cut 
to the folder for future usage.
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As soon as the job has been spooled to the Spire CXP8000 color server, it 
disappears from the hot folder and enters the Spire CXP8000 color server 
Process Queue or Storage window, according to the selected workflow.

Hot Folder File Formats
Hot folders may contain all PDL formats that are supported by the Spire 
CXP8000 color server, PS, PDF, EPS, PRN, VPS, VIPP, PPML, TIF, JPG 
and GAP. 

Files with unsupported formats that are moved to a hot folder, will not be 
imported to the Spire CXP8000 color server and will remain in the hot 
folder.

Hot Folders and Brisque or Prinergy jobs (GAP Formats)
When you use hot folders to print GAP jobs, the process is automated and 
the job is converted to a PDF, which is displayed in the Spire CXP8000 
color server queues. The PDF files can then be programmed and printed as 
any other PDF file.

Using Hot Folders from Client Workstations
You can use hot folders to process and print files from any client 
workstation. The following procedures explain how to print using hot 
folders from Windows, Mac OS 9, and Macintosh OS X.

To print a job using a hot folder from Windows:

1. On your Windows desktop, double-click the Network Neighborhood 
icon. 

2. Locate your Spire CXP8000 color server.

3. Double-click the Spire CXP8000 color server. 

Note:  If you send files for printing through a hot folder while the Spire CXP8000 
color server application is down, when the application restarts, the files that 
reside in hot folders will immediately be imported to the system.

For more information about supported GAP formats, see Printing PrePress Files - 
GAP Files on page 366.
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A list of all the shared folders and hot folders appears.

4. Double-click the desired hot folder—for example, HF_ProcessPrint.

You can now drag the desired files to the hot folder. All the files are 
processed and printed automatically to the printer, according to the 
hot folder workflow.

To print a job using a hot folder from Macintosh OS 9:

1. Click the Apple menu, and then select Chooser.

2. Locate the Spire CXP8000 color server on the network, and then click 
OK.

Tip:  You can also drag the hot folder icon to your desktop to create and 
use a shortcut to the folder in the future.
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3. Select Guest, and then click Connect.

4. From the list, select the desired hot folder—for example, 
HF_ProcessPrint—and then click OK.

The hot folder icon appears on your desktop.You can now drag the 
desired files to the hot folder icon. All the files are processed and 
printed automatically to the printer, according to the hot folder 
workflow.
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To print a job using a hot folder from a Mac OS X:

1. From the Finder menu bar, select Go>Connect to Server.

The Connect to Server window appears.
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2. Locate your Spire CXP8000 color server on the network, and click 
Connect.

3. Select Guest, and then click Connect.

4. From the list, select the desired hot folder—for example, 
HF_ProcessPrint—and then click OK.

The hot folder icon appears on your desktop. You can now drag the 
desired files to the hot folder icon. All the files are processed and 
printed automatically to the printer, according to the hot folder 
workflow.
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LPR Printing with the Spire CXP8000 Color Server
This section covers the procedures for setting up and configuring an LPR / 
TCP/IP printer from the following computers: 

• Windows NT 4.0 

• Windows 2000, Windows XP 

• Windows NT, Windows 2000, Windows XP command Line 

• Mac OS X (10.2) 

• Mac OS 9 (using the Choose Spire Over IP utility) 

• Linux 

• AIX and UNIX command line

Setting up an LPR Printer in Windows NT 4.0
The following procedure describes how to configure an LPR printer in 
Windows NT 4.0 for printing to the Spire CXP8000 color server. 

 The following items must be installed and configured on a Windows NT 
4.0 computer (server or client workstation version) before you begin: 

1. TCP/IP protocol
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2. Microsoft TCP/IP Printing service 

3. Latest Adobe PostScript Printer Driver, you can install this from the 
Spire CXP8000 color server, D:\utilties\Utilities\PC utilities, or you 
can download the latest version free from http://www.adobe.com/
support/downloads/main.html.

4. Spire CXP8000 color server PPD file copied to your client workstation 
(the PPD file is located in the D:\utilities\PPD folder on the Spire 
CXP8000 color server).

To define an LPR Printer:

1. From the Start menu on the Windows desktop, select 
Settings>Printers. 

The Printers window appears.

http://www.adobe.com/support/downloads/main.html
http://www.adobe.com/support/downloads/main.html
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2. From the File menu, select Server Properties. 

3. Click the Ports tab, and then click Add Port.

4. In the Available Printer Ports list, select LPR Port, and then click New 
Port.

5. In the Name or address of server providing lpd box, type the exact 
name of the Spire CXP8000 color server (this box is case-sensitive)—
for example, OPAL5.
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6. Type the exact name of the network printer from which you want to 
print. To view the exact name of the printer on the Spire CXP8000 
color server, select Resource Center>Virtual Printers. In this example 
the Printer name is OPAL5_ProcessPrint.

7. Click OK, and then close the Printer Ports window.

The new LPR port is now defined on your computer.

The next step is to define the LPR printer using the Adobe PostScript 
Printer driver application, see the following procedure.

To define an LPR Printer using the Adobe PostScript Driver:

1. Start the Adobe PostScript Driver Application. You can install this 
from the Spire CXP8000 color server, D:\utilties\Utilities\PC utilities, 
or you can download the latest version free from http://
www.adobe.com/support/downloads/main.html.

2. In the Welcome window, click Next. 

http://www.adobe.com/support/downloads/main.html
http://www.adobe.com/support/downloads/main.html
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3. The End User License Agreement window appears, read the license 
agreement, and then click Accept.

4. Select Install a new PostScript Printer, and then click Next. 

5. In the Printer Connection Type window, select It is directly connected 
to your computer (Local Printer), and then click Next.

6. Select the LPR port you defined earlier—for example, 
OPAL5_ProcessPrint LPR—and then click Next.

The next step is to configure the printer with the Spire CXP8000 color 
server PPD file. Make sure that you have copied this to your computer, 
or that you have access to the Spire CXP8000 color server on your 
network. 
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7. In the Select Printer Model window, click Browse. 

The Browse for Printer window appears. 

8. Locate and select the Spire CXP8000 color server PPD file. 

9. Click OK. 

10. In the Select Printer Model window, select CXP8K801, and then click 
Next.

11. In the Sharing window, select Not Shared, and then click Next. 

12. Type a name for the printer that you will be able to identify on your 
computer—for example, OPAL5_ProcessPrint LPR. You can also keep 
the original name of the printer. 

13. To set this printer as the default printer on your computer, select Yes. 
Otherwise, select No.
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14. Select Yes (Recommended) if you want to print a test page. Otherwise, 
select No. 

15. Click Next. 

16. In the Setup Information window, click Install to install the LPR 
printer with the Spire CXP8000 color server PPD file. 

17. When prompted to configure the printer, click Yes. 

18. Click Next. 

19. In the Printer Configuration window, select Yes when prompted to 
configure the printer now. 

20. Click Next.

The CXP8000 Properties window appears. 

21. Configure the printer according to your specifications, and then click 
OK. 

22. In the Setup Complete window, click Finish to complete the setup.

The new LPR printer is now listed with your other printers on the 
Windows NT computer, and you are now ready to print to the Spire 
CXP8000 color server using the LPR. 

Setting up an LPR Printer in Windows 2000 and Windows XP
The following procedure describes how to configure an LPR printer in 
Windows 2000 and Windows XP for printing to the Spire CXP8000 color 
server.

The following items must be installed and configured on the Windows 
2000 and Windows XP computer before you begin:

1. TCP/IP protocol

2. Latest Adobe PostScript Printer Driver, you can install this from the 
Spire CXP8000 color server, D:\utilties\Utilities\PC utilities, or you 
can download the latest version free from http://www.adobe.com/
support/downloads/main.html.

3. Spire CXP8000 color server PPD file copied to your client workstation 
(the PPD file is located on the Spire CXP8000 color server in the 
D:\utilities\PPD\ folder). 

http://www.adobe.com/support/downloads/main.html
http://www.adobe.com/support/downloads/main.html
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To define an LPR Printer:

1. From the Start menu on the Windows desktop, select 
Settings>Printers.

The Printers window appears.

2. From the File menu, select Server Properties. 

The Print Server Properties window appears.

3. Click the Ports tab, and then click Add Port. 

 

4. In the Available Printer Ports list, select Standard TCP/IP Port, and 
then click New Port. 

The Add Printer wizard screen appears.
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5. Click Next.

The Add Port screen appears.

6. In the Printer Name or IP Address box, type the exact name of the 
Spire CXP8000 color server (this box is case-sensitive)—for example, 
OPAL5. 

7. In the Port Name box, type a name for the printer that you will be able 
to identify on your computer—for example, OPAL5ProcessPrint LPR. 

8. Click Next. 
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The Additional Port Information Required screen appears.

9. In the Device Type area, select Custom, and then click Settings.

The Configure Standard TCP/IP Port Monitor screen appears.
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10. Select the following options:

• Protocol: Select LPR

• LPR Settings:

• Queue Name: Type the exact name of the network printer you 
want to print to (you can view the exact name of the printer on 
the Spire CXP8000 color server under Resource 
Center>Virtual Printers). In this example the Printer name is 
OPAL5_ProcessPrint.

• LPR Byte Counting Enabled: Select this check box

11. Click OK, and then click Next. 

12. Click Finish. 

13. In the Printer Ports window, click Close. 

The new Standard TCP/IP Printer Port is now defined on your 
computer.

 

The next step is to define the TCP/IP Printer using the Adobe PostScript 
Printer Driver application, see the following procedure.
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To define an LPR Printer using the Adobe PostScript Driver:

1. Start the Adobe PostScript Driver Application. You can install this 
from the Spire CXP8000 color server, D:\utilties\Utilities\PC utilities, 
or you can download the latest version free from http://
www.adobe.com/support/downloads/main.html.

2. In the Welcome window, click Next. 

3. The End User License Agreement window appears, read the license 
agreement, and then click Accept.

4. Select Install a new PostScript Printer, and then click Next. 

5. In the Printer Connection Type window, select It is directly connect to 
your computer (Local Printer), and then click Next.

6. In the Available ports area, select the Standard TCP/IP port you 
defined earlier on—for example, OPAL5_ProcessPrint LPR—and then 
click Next.

The next step is to configure the printer with the Spire CXP8000 color 
server PPD file. Make sure that you have copied this to your computer, 
or that you have access to the Spire CXP8000 color server on your 
network. 

7. In the Select Printer Model dialog box, click Browse. 

The Browse for Printer dialog box appears. 

8. Locate and select the Spire CXP8000 color server PPD file.

http://www.adobe.com/support/downloads/main.html
http://www.adobe.com/support/downloads/main.html
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9. Click OK. 

10. In the Select Printer Model window, select the CXP8K801, and then 
click Next.

11. In the Sharing window, select Not Shared, and then click Next. 

12. In the Printer Name box, type a name for the printer that you will be 
able to identify on your computer—for example, OPAL5_ProcessPrint 
LPR. You can also keep the original name of the printer. 

13. Select Yes, if you want to set this printer as the default printer on your 
computer. Otherwise, select No.

14. Select Yes (Recommended) if you want to print a test page. Otherwise, 
select No. 

15. Click Next. 
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16. In the Setup Information window, click Install.

This installs the LPR printer with the Spire CXP8000 color server PPD 
file. 

17. When prompted to configure the printer, click Yes. 

18. Click Next. 

19. In the Printer Configuration window, select Yes when prompted to 
configure the printer. 

20. Click Next.

The CXP8000 Properties window appears.

21. Configure the printer according to your specifications, and then click 
OK. 

22. In the Setup Complete window, click Finish to complete the setup.

The new LPR printer is now listed with your other printers on the 
Windows NT computer, and you are now ready to print to the Spire 
CXP8000 color server.
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Windows NT, Windows 2000, Windows XP Command Line
You can also submit PostScript, PDF, or Variable Print Specification files 
for printing to the Spire CXP8000 color server using the following 
commands in the Windows command line. The following procedure is 
suitable for Windows NT, Windows 2000, or Windows XP. 

1. From the Start menu, click Run. 

2. Type cmd, and then click OK. 

3. Locate the directory that contains the file(s) you want to print. 

4. Type the following in the command line:
lpr –S <server name> -P <virtual printer name> -ol 
<file name>  
and then press ENTER.
For example:
lpr –S OPAL3 –P OPAL3_ProcessPrint –ol brochure.ps

Your file is printed to the Spire CXP8000 color server using the LPR 
command.

Note:  All commands, server name, and printer name are case-
sensitive.
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Setting up an LPR Printer in Macintosh OS X (10.2)

Configuring an LPR Printer
1. Follow the procedure Setting the Network Printer for Mac OS X (10.2) 

on page 72 until step 5.

2. In the Printer List window, select LPR Printers using IP as the 
connection type.

 

3. In the LPR Printer's Address box, type the TCP/IP address or 
hostname of the Spire CXP8000 color server—for example, 
10.4.18.169.

4. Clear the Use default queue on server check box.

Note:  Before you configure the LPR printer, make sure that you have installed 
the Spire CXP8000 color server PPD file on your Macintosh client workstation, 
see Copying the Spire CXP8000 Color Server PPD File for Mac OS X (10.2) on 
page 70.
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5. In the Queue Name box, type the full name of the Spire CXP8000 
color server network printer—for example, 
V4_CXP8000_ProcessPrint.

6. In the Printer Model list, select Other.

7. Locate the folder to which you have copied the PPD file.

8. Click Choose to assign the CXP8K801.ppd file to the selected Spire 
CXP8000 color server network printer.

Note:  This box is case-sensitive.
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The following dialog box appears.

9. Click Add to add the new printer to the printer list.

The new printer is displayed in the Printer List window.

Using the Choose Spire Over IP Utility to set up an LPR Printer in Macintosh 
OS 9

Spire Over TCP/IP
The Spire Over TCP/IP application enables you to submit jobs from a 
Macintosh client workstation using the Spire CXP8000 color server virtual 
printers over a TCP/IP protocol. This connection provides a significantly 
higher spooling speed.

Note:  Before you set up a network printer, make sure that you have installed the 
Spire CXP8000 color server PPD file on your Macintosh client workstation, see 
Copying the Spire CXP8000 color server PPD File for Mac OS 9 on page 66.

Important:  The TCP/IP settings on your Macintosh must match the Spire 
CXP8000 color server TCP/IP network settings.
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To install this application, you need a Macintosh OS version 9.0 or later, 
with an installed LaserWriter application version 9.0 or later, or Adobe 
Photoshop 8.8 or later (available at http://www.adobe.com/support/
downloads/main.html). If you do not have a compatible LaserWriter 
application installed, you can download this application from the Spire 
CXP8000 color server, D:\Utilities\Mac utilities folder.

To install the Choose Spire Over IP application:

1. On your Macintosh client workstation, from the Apple menu, select 
Chooser.

2. Select AppleShare and browse the network to the desired Spire 
CXP8000 color server—for example, Falcon_Color—and then click 
OK.

The Login dialog box appears.

http://www.adobe.com/support/downloads/main.html
http://www.adobe.com/support/downloads/main.html
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3. Select Guest and click Connect.

The corresponding Spire CXP8000 color server dialog box appears.

4. Select the Utilities folder and then click OK.

5. The Utilities folder icon appears on your desktop; double-click the 
icon to open the folder.



LPR Printing with the Spire CXP8000 Color Server 111

6. Double-click the Choose Spire Over IP Installer icon.

7. Click Install.

After the installation is complete, a message appears.

8. Click Quit.

The Choose Spire Over IP option is now added to the Apple menu.
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9. To create desktop printers for printing over IP, from the Apple menu, 
select Choose Spire Over IP.

10. To view the print queues of the Spire CXP8000 color server, double-
click Local Services and then double-click the Spire CXP8000 color 
server icon—for example, FALCON_COLOR.

11. To create a desktop printer for a specific print queue, select the print 
queue from the list—for example, FALCON_COLOR_Process Print—
and then click the Setup button. 

12. Select Select a PPD file on this computer, and then click OK.



LPR Printing with the Spire CXP8000 Color Server 113

13. Locate the Spire CXP8000 color server PPD file that you copied to 
your computer in step 1, and then click Open.

14. You can change the printer name if you want. Otherwise, click OK.

The desktop printer is created and configured and the following 
progress indicator appears.

When the printer is successfully created, the following message 
appears.
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15. Click OK.

The printer icon appears on your desktop.

You can now print your jobs using this printer through a TCP/IP 
protocol.

Printing from Linux
The following procedure describes how to print from Linux to the Spire 
CXP8000 color server using the command line or by defining a printer 
using the Linux user interface (in this case Red Hat Linux). 

Linux Command Line
1. Select System Tools>Terminal Window to open a Terminal window. 

2. If your Linux computer is not configured with DHCP in the network 
settings, you will need to add the hostname and TCP/IP address of the 
Spire CXP8000 color server that you want to print. You add the 
hostname in the /etc/hosts file. 

3. Locate the directory that contains your file(s), and then type the 
following command: 
# lpr –P <virtual printer name>@<server name> 
<filename>
For example:

# lpr –P OPAL3_ProcessPrint@opal3 letter.ps

4. Press ENTER. 

Your file is printed to the Spire CXP8000 color server. 

Note:  You do not need to use the Spire CXP8000 color server PPD file when you 
print from Linux.

Note:  All commands and printer names are case-sensitive. The server name is 
the name defined in the /etc/hosts file or the registered name in the DNS server 
on your network (DHCP use).
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Linux User Interface
The following procedure reflects Red Hat Linux version 8.0

1. Select System Settings>Printing.

2. Click New to setup a new LPR/LPD printer. 

The Add A New Print Queue dialog box appears.

3. Click Forward.

The Set the Print Queue Name and Type dialog box appears.

4. In the Queue Name box, type a name for the printer that you will be 
able to identify on your computer—for example, OPAL3_LPR.

5. Click Forward. 

The Configure a Unix Print Queue dialog box appears.
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6. In the Server box, type the Spire CXP8000 color server name—for 
example, OPAL3. 

7. In the Queue box, type the exact name of the network printer you 
wish to print to—for example, OPAL3_ProcessPrint. 

8. Click Forward. 

9. In the Select a Print Driver screen, select PostScript Printer, and then 
click Forward. 

The Finish, and Create the New Print Queue screen appears. 

10. Click Apply.

11. In the Red Hat Printer Config dialog box, click Apply. 

Note:  To view the exact name of the printer on the Spire CXP8000 
color server, select Resource Center>Virtual Printers.



LPR Printing with the Spire CXP8000 Color Server 117

12. When prompted, click OK.

The new LPR/LPD printer is now listed with your other printers on the 
Linux computer and you can print to the Spire CXP8000 color server.

Defining a Printer on UNIX Client Workstations

AIX and UNIX Command Line

To define an AIX 4.2.1 printer for printing through LPR:

1. On your UNIX workstation—for example, AIX 4.2.1—type SMIT and 
follow the sequence, 
Print Spooling>Add a Print Queue>remote>Standard processing.

2. In Name of QUEUE to add, type the name of the print queue to be 
used on your UNIX client.

3. In HOSTNAME of remote server, type the hostname of the remote 
server where the printer is defined—for example, CXP8000.

Note:  Use a logical name to recognize the remote printer.
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4. In Name of QUEUE on remote server, type the exact name of the print 
queue defined on the remote server—for example, ProcessPrint.

5. Click OK.

Printing from a UNIX Client Workstation

To print from a UNIX client through LPR:

1. Type the following:
<lpr><space><-P><space><local UNIX printer
name><space><PS file name>
For example, to print frog.ps on a printer named ProcessPrint, type:
lpr -P ProcessPrint frog.ps.

2. Press ENTER.
The PostScript file is downloaded to the printer. All settings are taken 
from the remote printer on the Spire CXP8000 color server.

UNIX Connectivity
This section describes how to install and configure Microsoft Windows 
Services for UNIX (SFU) version 3.0 on a workstation running Windows 
2000 or Windows XP.

Windows SFU version 3.0 adds UNIX NFS (Network File System) protocol 
compatibility to a Windows workstation. This compatibility enables UNIX 
platforms to mount the workstation’s volume.

Installing the SFU 3.0 Software
This procedure describes how to install the Microsoft SFU 3.0 software.

Note:  Verify that the printer name defined on the remote server contains no 
more than 20 characters. Unix is case sensitive.

Note:  Use alphanumeric and underscores for names. Names are case 
sensitive—for example, ProcessPrint not processprint. UNIX does not require 
PPD files to print jobs.



UNIX Connectivity 119

To install the SFU 3.0 software:

1. Insert the Windows Services for UNIX CD-ROM in the computer’s 
CD-ROM drive.

2. In the Windows Services for UNIX Wizard window, click Next.

3. Click in the User name box, and type your name.

4. In the CD Key boxes, type the product key number that is located on 
the back of the CD-ROM’s case, and then click Next.

5. Read the End User License Agreement carefully. If you accept the 
terms of the agreement, click I accept the terms of the License 
Agreement, and then click Next to continue installation.

6. Click Customized Installation, and then click Next.

7. Click the icon that appears next to each component that you want to 
install. Under each component, select the items you want to include in 
the installation.
Select only the following:

• Server for NFS

• Authentication tools for NFS>Server for NFS Authentication

• Authentication tools for NFS>User Name Mapping.

When you have finished specifying all the components to install, click 
Next.

Note:  If the installation program does not start automatically when the 
Windows Services for UNIX compact disc is inserted into the CD-ROM drive, 
open the CD-ROM drive in Windows Explorer, and then double-click the 
Setup.exe program.

Note:  If the name of your organization does not appear in the 
Organization text box, type the name.

Note:  If you click I do not accept the License Agreement, the installation 
terminates.
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8. Click Next. 

A dialog box appears stating that low-level security settings need 
changing.

9. Click Next.

10. In the User Name Mapping dialog box, type the system name of the 
computer on which you are installing SFU. Then click Next.

11. Click in the Installation location text box, and type the full path of the 
directory where you want to install Windows Services for UNIX. Then 
click Next.

12. Start the Component Services application and configure the Server 
for NFS service that setup disabled for starting-up automatically.

a. Click the Windows Start button and select Control Panel.

b. Double-click the Administrative Tools icon. 

c. Double-click the Component Services icon.

Note:  NFS components will not work unless you specify the name of the 
User Name Mapping server.

Note:  The path you specify can contain only alphanumeric characters and 
the underscore (_) character.
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13. Restart the computer.

Increasing NFS Performance Using the Windows Registry
The Windows Services for UNIX 3.0 application disables disk write 
caching in the Windows registry by default (caching=0).

When write caching is enabled, the speed of NFS file write operations is 
increased. You can expect NFS file write performance to be in the range of 
5-7 MB/second.

You can download a special registry file that automatically enables write 
caching. 

To enable write caching automatically in the Windows registry:

Download the sfu_better_performance.reg file from the following 
TechPlanet location, http://techplanet.creo.com/pos/entry_production/
nav/index.htm, and then run the file.

Creating a File-name Translation File
Windows Services for Unix 3.0 lets you import a special text file that 
translates UNIX-specific text characters into characters that are recognized 
by Windows NTFS.

The most problematic UNIX character that is not recognized by NTFS is 
the colon character (:). The Helios application uses colon characters to 
store Macintosh file name descriptions so that UNIX recognizes them.
Other UNIX characters that are not residencies by NTFS are the asterisk 
(*) and the question-mark (?) characters.

You can obtain the trans.txt translation text file from Xerox Support and 
import it into SFU.

Note:  After you have installed Services for UNIX 3.0, you can add or remove 
additional program components whenever you choose by inserting the SFU 3.o 
CD-ROM.

Note:  For detailed information about the Windows Registry, visit Microsoft 
support at http://support.microsoft.com/default.aspx?scid=kb;EN-US;256986.

http://techplanet.creo.com/pos/entry_production/nav/index.htm
http://techplanet.creo.com/pos/entry_production/nav/index.htm
http://support.microsoft.com/default.aspx?scid=kb;EN-US;256986
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To import the translation text file into SFU:

1. Save the trans.txt file to any location on your PC.

2. Click on the Windows Start button, and select Programs>Windows 
Services for UNIX>Services for UNIX Administration. The SFU 3.0 
application starts.

3. In the navigation pane, select the Server for NFS icon.

4. In the File name handling area, select the Translate file names check 
box.

5. Click Browse, and navigate to the directory location where the 
trans.txt file is located.

6. Click Open.

7. Click Apply. 

The translation file is imported.
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Configuring NFS Server Settings with SFU
The Windows Services for Unix 3.0 application lets you configure the 
settings required for the Server for NFS.

To configure NFS server settings:

1. Click on the Windows Start button, and select Programs>Windows 
Services for UNIX>Services for UNIX Administration. 

The SFU 3.0 application starts.

2. In the navigation pane, select the Server for NFS icon.

3. In the Server for NFS on local computer pane, select the Server 
Settings tab.

4. Configure the Server for NFS using the same settings that are shown 
in the following figure:

5. Click Apply. 

6. Stop and re-start the service:

a. In the navigation pane, right-click the Server for NFS icon, and 
select Stop.

b. In the navigation pane, right-click the Server for NFS icon, and 
select Start.
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Setting Up Windows SFU for Brisque

Configuring Windows User-Name Mapping
Before you configure user-name mapping in the SFU application, copy the 
UNIX user name and group name files from Brisque to your Windows 
workstation via FTP (File Transfer Protocol). You will import these files 
later into the SFU application to map existing Brisque users and groups to 
Windows users and groups.

To copy Brisque user and group files:

1. Click the Windows Start button and select Run. 

The Run dialog box appears.

2. In the Run text box, type cmd and click OK. 

A command line prompt window appears.

3. At the command line prompt, type ftp <Brisque IP address>, 
and press ENTER. For example, type ftp 192.9.100.1, and press 
ENTER.

4. At the User prompt, type root, and press ENTER.

5. At the Password prompt, type ripro, and press ENTER.

6. At the ftp prompt, type six command as follows:

• Type lcd c:\SFU, and press ENTER.

• Type cd /etc, and press ENTER.

• Type ascii, and press ENTER.

• Type get passwd, and press ENTER.

• Type get group, and press ENTER.

• Type quit, and press ENTER.

To map user-names:

1. Click the Windows Start button, and select Programs>Windows 
Services for UNIX>Services for UNIX Administration. 

The SFU 3.0 application starts.
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2. In the Tree navigation pane, double-click the Services for UNIX [local] 
icon. 

The Welcome pane appears.

3. Click the Settings tab.

4. In the User Name Mapping Server area, check that the name displayed 
in the Computer name text box is the same as the name of the local 
Windows system being used.

5. In the Tree navigation pane, select the User Name Mapping icon. The 
Configuration tab options appears in the adjacent pane.

6. Select the Personal Computer Network File System (PCNFS) option.
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7. In the Password file path and name box, click Browse and select the 
password file that you copied from Brisque via FTP. Then click Open.

8. In the Group file path and name text box, click Browse and select the 
group file that you copied from Brisque via FTP. Then click Open.

9. From the menu bar at the top of the pane, select the Maps tab. 

The Maps options appear, listing Windows and UNIX users.

10. Click the Show User Maps link. The Maps pane lists the Windows and 
UNIX users. This link changes its name to Hide User Maps.
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11. Click in the Windows users list, and select Administrator.

12. Click in the UNIX users list, and select scitex.

13. Click Add. 

A dialog box appears.

14. Click OK. 

The mapping appears in the Mapped users list area. A message 
appears: Are you sure you want to set advanced mapping 
for this account?

15. Click Yes.

16. Click the Show Group Maps link. This link changes its name to Hide 
Group Maps. The Maps pane lists the Windows and UNIX groups.

17. Click Apply.



128  Chapter 3 – Working From a Client Workstation

 

18. Click in the Windows group list area, and select Administrators.

19. Click in the UNIX groups list area, and select scitex.

20. Click Add. A dialog box appears.

21. Click OK. 

The mapping appears in the Mapped groups list area.

22. Click Apply.
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Sharing an NFS Folder or Entire NFS Volume
Before Brisque can mount individual Windows 2000 folders or the entire 
Windows 2000 volume, the required folders or entire volume must be 
shared as an NFS volume.

To share an NFS folder or entire NFS volume:

1. Start Windows Explorer or my My Computer.

2. Right-click the desired folder or volume and select Properties. 
Or:
Right-click the icon that represents the disk’s volume and select 
Properties.

The NFS Share Properties dialog box appears.

3. Select the NFS Sharing tab.

4. Select the Share this folder option.

5. Select the Allow anonymous access check box.

6. Click in the Anonymous UID text box, and type 200.

7. Click in the Anonymous GID text box, and type 200.

Note:  You can either share the entire drive or you can share a single folder.
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8. Click the Permissions button. 

The NFS Share Permissions dialog box appears.

9. Click the Type of access list box, and select Read-Write.

10. Select the Allow root access check box.

11. Click OK.

The shared folder appears in the Windows Explorer or My Computer 
window with a distinctive icon.
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Checking that NFS Is Started and Will Run Automatically at 
Startup
1. From the Windows desktop, right-click the My Computer icon and 

select Manage. 

The Computer Management application window appears.

2. In the navigation pane, select the Services and Applications icon.

3. Select the Services icon. 

A list of services that are currently running is displayed in the adjacent 
pane.

4. From the list of services, select the Server for NFS icon. If the Server 
for NFS service is listed, the service is running.

Note:  To start or stop the service or change the service’s settings, double-click 
anywhere in the Server for NFS row.
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Brisque Workstation Installation and Configuration Procedures
The following procedures describe the installation and configuration 
procedures that are necessary to enable Brisque to mount and use a 
Windows 2000 volume.

Adding the Windows System as a Brisque Host
This procedure describes how you add the Windows 2000 computer as a 
Brisque host by editing the /etc/hosts file.

To add the Windows system as a Brisque host:

1. From the Brisque Launch Pad, open the Services panel, and double 
click the Terminal icon. 

The Password dialog box is displayed.

2. Click in the User text box, and type root.

3. Click in the Password text box, and type ripro.

4. Click OK. 

A terminal window appears.

5. At the command line prompt, type smit hosts. 

The System Management Interface Tool dialog box appears.

6. Select Add a Host. 
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The Add a Host Name dialog box appears.

7. Click in the INTERNET ADDRESS (dotted decimal) text box, and type 
the IP address of the Windows 2000 workstation.

8. Click in the HOST NAME text box, and type the host name of the 
Windows 2000 workstation.

9. Click in the COMMENT text box, and type NT.

10. Click OK.

11. From the Exit menu, click Exit.

Mounting the Windows NFS Volume
This procedure describes how you mount the Windows 2000 volume on 
Brisque.

To mount the Windows NFS volume:

1. From the Brisque Launch Pad, open the File Manager panel and 
double-click the MountPro icon. The Devices & Remote Stations 
dialog box appears, and lists any volumes that are already mounted on 
Brisque.

2. Click the Mount button. 
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The Mount dialog box appears.

3. From the Station Type list box, select NT Server.

4. Click in the Remote Station text box and type the host name of the 
Windows 2000 workstation to mount.
Or:
Click List and select the desired host name of the workstation to 
mount.

5. Click in the Volume text box, and type the name of the Windows 2000 
volume to mount.
Or:
Click List and select the desired volume to mount.

6. From the Permission list, select Read/Write.

7. Click OK.

Note:  This step is only required if you are running Brisque version 3.x and Brisque 
version 4.0. Brisque version 4.1 automatically inserts the station type, using the 
information configured in the /etc/hosts file.

Note:  If you are running Brisque version 3.x or Brisque version 4.0, the volume 
is listed with the syntax host.x.y, which is the same naming convention used by 
Windows. For example, syswin2k.1.0. If you are running Brisque version 4.1, the 
volume is listed using the syntax volume.x.y. For example, test.1.0.
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Sending a Sample Job, Page or File to the Windows NFS 
Volume
This procedure describes how to send a sample job, page or file to the 
mounted Windows 2000 NFS volume. If you complete this procedure 
successfully, this confirms that the Windows NFS volume is mounted 
correctly.

1. From the Brisque File Manager, right click on Brisque job, page or file, 
and select Send. 

The Send Job dialog box appears.

2. Click in the Destination text box and type the host name of the 
Windows 2000 workstation.
Or:
Click List and select the host name of the workstation.

3. Click in the Volume text box and type the name of the Windows 2000 
volume.
Or:
Click List and select the volume name of the workstation
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4. Click in the Path text box and type the path name of the Windows 
2000 folder or volume.
Or:
Click List and select the folder or volume name.

Configuring and Setting up NDS
This section describes how to configure the connection between a Novell 
Directory Services (NDS) Server and the Spire CXP8000 color server, in a 
Novell working environment. 

To configure this connection:

1. Create the NDS Print Server "nwprintserver" in the NDS.

2. Create an NDS Printer object in the NDS.

3. Create all print queues using the following 
format,<hostname_VirtualPrinterName> in the NDS.

4. Verify the connection information.

5. Configure the IPX Printing parameters: Tree and Context, using the 
Spire CXP8000 color server Settings window (Network Setup/IPX 
Printing) in the Spire CXP8000 color server.

6. Install the printer drivers on a Novell Client.

Note:  In Brisque version 4.1, there is an option named Do not send .srsc 
directory. The .srsc directory is required if you are running Helios, and is also 
required if you intend to copy the files you sent from the Windows 2000 
workstation.

Important:  The Novell client should also be installed in the Spire CXP8000 
color server since it is not installed by default.

Note:  The following procedures should be performed on a Windows client 
workstation running the Novell Client, and configured by the Novell 
Administrator to access the NWAdmin program.
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To perform these procedures, you need:

• Administrative permissions assigned by the Novell administrator

• The user name and password for access to the NDS Server

• An account in the appropriate NDS Tree and Context with permissions 
to create objects

• The full Context (location in the NDS Tree) where you will be creating 
the Print Server, Printer and Print Queues

• Background and know-how of NDS Server

Defining NDS Printer Queues in the NDS Tree

Using the Novell NetWare Administrator Application
Perform the following procedures to create the Print Server, Printer and 
Print Queues, using the NetWare Admin application:

1. Define the NDS Print Server, Printer, and Print Queue in the NDS 
Tree, 

2. Assign the printer to the Print Server and the Print Queues to the 
printer. 

3. Check the print layout to verify the connections and perform a test 
print.

For more information about defining NDS printers, see To define an NDS 
print server: on page 139, To define an NDS printer: on page 140, and To 
define the NDS print queues: on page 141.

For more information about assigning print servers and print queues, see To 
assign a printer name to nwprintserver print server: on page 144, and To 
assign a print queue to the printer: on page 146.

For more information about verifying NDS connections, see To verify the 
new NDS layout: on page 148.

Important:  Perform these procedures in the specified order.
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To open the Netware Administrator Application:

Open the Netware Administrator Application (provided by your 
Novell Administrator).

The NetWare Administrator window appears and displays the NDS 
window. The following example shows the existing Trees, Queues and 
other Novell connections.
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To define an NDS print server:

1. From the NDS window, select the desired Context.

2. From the Object menu, select Create.

The New Object dialog box appears.

3. In the Class of new object list, select Print Server.

4. Click OK.

The Create Print Server dialog box appears.

5. In the Print Server name box, type nwprintserver.

Note:  Before performing the following procedure, check the Novell Server 
window and if the nwprintserver already exists, proceed to the next procedure 
To define an NDS printer: on page 140.

Note:  In Novell NDS version 5.0 and later, the words Non NDPS also 
appear.

Notes:

• It is important that you only use this server name, in lower case. 

• Do not define a password for the Print Server.
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6. Click Create.

The NDS nwprintserver printer is created and appears in the NDS 
window.

To define an NDS printer:

1. From the Object menu, select Create.

The New Object dialog box appears.
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2. From the Class of new object list, select Printer.

3. Click OK.

The Create Printer dialog box appears.

4. In the Printer name box, type any printer name— for example, 
Spire_Printer.

5. Click Create.

The printer name is added to the NDS window.

To define the NDS print queues:

1. From the Object menu, select Create.

Note:  In Novell version 5.0 NDS and later, the words Non NDPS also 
appear.

Notes:

• Both <hostname_ProcessPrint> and <hostname_ProcessStore> queues 
should be defined. 

• Prior to performing this procedure, verify that in the Spire CXP8000 color 
server, both network printers <hostname_ProcessPrint> and 
<hostname_ProcessStore> are present.

• Both virtual printers <hostname_ProcessPrint> and 
<hostname_ProcessStore> should not be deleted from the Spire CXP8000 
color server.
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The New Object dialog box appears.

2. In the Class Of New Object list, select Print Queue. 

3. Click OK.

4. Verify that Directory Service Queue is selected.

5. In the Print Queue name box, type the exact (case sensitive) virtual 
printer name: <hostname_ProcessPrint>—for example— 
Spire7_ProcessPrint.

6. Select the Create another Print Queue check box.
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7. Click the Print Queue Volume icon.

8. Select any existing volume.

9. Click OK.

The print queue volume name appears in the Print Queue Volume box.

10. Click Create.

The print queue is now added to the NDS window along with the 
nwprintserver and the printer name (Spire_Printer).

Note:  Notice that the Create Print Queue dialog box reappears so that you 
can define the second print queue.
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11. In the Create Print Queue dialog box, verify that Directory Service 
queue is selected.

12. Clear the Create another Print Queue check box.

13. In the Print Queue name box, type the exact (case sensitive) second 
virtual printer name: <hostname_ProcessStore>—for example— 
Spire7_ProcessStore.

14. Click the Print Queue Volume icon.

The Select Object dialog box appears.

15. Select any existing volume.

16. Click OK.

The print queue volume name appears in the Print Queue Volume box. 

17. Click Create.

Both queues now appear in the NDS window.

To assign a printer name to nwprintserver print server:

1. In the NDS window, double-click nwprintserver.

The Print Server dialog box appears.
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2. Click Assignments to open the Assignments tab.

3. Click Add.

The Select Object dialog box appears.

4. From the printers, select the printer name you have defined—for 
example, Spire_Printer—and then click OK.
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The printer appears in the Printers list.

5. Click OK.

To assign a print queue to the printer:

1. In the NDS window, double-click the printer name you have 
defined—for example, Spire_Printer.

The Printer dialog box appears.
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2. Click Assignments to open the Assignments tab.

3. Click Add.

The Select Object dialog box appears.

4. Select the queue name <hostname_ProcessStore> you have defined, 
and click OK.
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5. Click Add and select <hostname_ProcessPrint>.

Both printer queues now appear in the Print queues list.

6. Click OK.

To verify the new NDS layout:

1. In the NDS window, double-click nwprintserver.

The Print Server dialog box appears. 
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2. Select the Print Layout tab.

3. Verify that the nwprintserver server, the printer, and queues are 
displayed as shown in the above example.

4. Click Cancel.

Using the NDS PConsole 
The Spire CXP8000 color server virtual printers can be defined as NDS 
printer queues at the NDS Server, using the NDS PConsole. This 
procedure includes the following stages:

1. In the Spire CXP8000 color server, verify that the two virtual printers 
<hostname_ProcessPrint> and <hostname_ProcessStore> are 
present.

2. In the NDS PConsole:

• Create the Novell NDS Print Server "nwprintserver".

Notes:

• It is important to use only this server name, in lower case. 

• In any case, do not define a password for the Print Server.
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• Create the NDS printer object.

• Create the NDS print queues <hostname_ProcessPrint> and 
<hostname_ProcessStore>.

3. In the Spire CXP8000 color server:

• Configure the IPX Printing parameters: Tree and Context (the 
exact tree name and the full context path name) in the Spire 
CXP8000 color server Settings window, see Configuring IPX 
Printing on page 150.

• Restart the Spire CXP8000 color server application.

4. Install the Novell Printer Queue on the Novell Client.

Configuring IPX Printing

To setup the Spire CXP8000 color server IPX parameter:

1. From the Tools menu, select Settings.

The Settings window appears.

Note:  You do not need to define the context and tree if they were defined in the 
Novell configuration process.
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2. Under Administration, select Network Setup.

3. In the IPX Printing area, click Change Settings next to the Tree 
parameter.

4. Type the exact Tree parameter and the full containers path of the 
Context parameter, in their respective boxes. You can also click 
Browse and browse to the desired Tree and Path.

5. Click OK.

6. Restart the Spire CXP8000 color server application.
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Installing the Printer Drivers on a Novell Client Using the Adobe PS 
Application

1. Use the Adobe PostScript application with the Spire CXP8000 color 
server PPD file (provided in the Spire CXP8000 color server, Utility 
folder). 

2. In the Adobe PostScript Wizard, verify that you have selected the 
Novell printer queue from the NetWare Network, and not the Spire 
CXP8000 color server virtual printers. See the following example.

The following screen shows the Printers window after installing the 
Novell printer queue.

3. Perform a test print using the installed Novell NetWare printer. 

Note:  The Novell printer has the NDS name as an extension—for example, 
NW_TANSRV5.
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Importing and Printing Jobs
You import jobs for printing in the following situations:

• When a page-description language (PDL) file is created on a client 
workstation that is not connected to the Spire CXP8000 color server

• When a PDL file is located on an external medium, such as a CD-ROM

• When the desired file resides locally on the Spire CXP8000 color server

Importing Files

To import files to the Spire CXP8000 color server:

1. From the Job menu select Import Job. 

The Import window appears. 
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2. To access the desired files, click the up one level button, or double-
click on the file folders to go down the file tree.

3. In the upper list in the Import window, select the desired file and click 
the add button.  

The file appears in the lower list.

4. Select a printer from the Virtual Printer list.   

5. Click Import.

All files currently listed on the lower list are sent to the Spire CXP8000 
color server to be processed and printed as defined in the selected 
virtual printer.

To check the status of imported jobs:

1. Click the Server icon arrow.

The Importing/Retrieving window appears.

The Importing/Retrieving window indicates the name of the file being 
imported, its location and the job size. It also indicates the percentage 
of the job already transferred, both numerically and graphically.

Note: To remove a file, select the desired file in the lower list in the Import 
Job window and click the remove button.
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2. Select one of the following options:

• Click Skip This Job to stop importing the current file and import 
the next job in the import queue.

• Click Abort All Jobs to stop importing all the files.

• Click Close to close the Importing/Retrieving window.

Reprinting Jobs

Submitting an RTP Job Requiring no Changes
Select the job in the Storage window and from the Job menu select 
Submit.

The job(s) are placed in the Print Queue.

Submitting a Job that Requires Re-RIPing
1. Double-click the job to open the Job Parameters window. 

2. Change the desired parameter and click Submit.

The Spire CXP8000 color server automatically determines if your job 
needs to be re-RIPped and places it in the appropriate queue.

Basic Settings
Basic settings are set in the Job Parameters window. 

The following tabs in the Job Parameters window are used in the basic 
workflows:

• Print Settings tab

• Paper Stock tab

• Print Quality tab

Note:  Use SHIFT or CTRL to select several jobs.

For more information about opening the Job Parameters window, see The Job 
Parameters Window on page 27.
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The Print Settings Tab
The Print Settings tab enables you to set print-related job parameters such 
as the print range, the number of copies you would like to print, the print 
method and order. In addition you may define the collation, the image 
position on the sheet, the image scale, set the gallop workflow if desired, or 
rotate your job.

No. of Copies

Enter the Number of Copies to be printed.
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Print Range 

If the printed job is a VI job, the Print Range display is as follows:
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Select the desired Print range.

To select specific pages/booklets or page ranges, select Pages/Booklets 
and specify the pages or booklets to be printed as follows:

Type one or several numbers separated by commas and no spaces. 
For example, 1,3,5.

Type a range of pages or booklets with a hyphen between the 
starting and ending numbers in the range. For example, 1-5.

Print Method

Select the Print method to one of the following:

Simplex: for single-sided printing

Duplex Head to Toe: for calendar-style hard copies (usually used 
with landscape jobs)

Note:  For imposed jobs, instead of typing the desired pages, you should type 
the desired imposed sheets.
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Duplex Head to Head: for printing book-style hard copies (usually 
used with portrait jobs)

Print Order

Set the print order to From 1 to N (front to back) or From N to 1 (back 
to front).
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Delivery

Select Face Up or Face Down as the delivery option.

Tip:  Use Face Down when printing confidential documents.

Note:  When you collate a document, select Face Down (Face Up) and From N 
to 1 (From 1 to N) in the Print order parameter to print the set in the correct 
order.
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Collation

Select the Collation option:

Yes: prints a complete copy of the job before the first page of the 
next copy is printed

No: prints all copies of each page before going on to the next page

For example, if you have a 20 page job and want to print 10 copies, if you 
select Yes, all 20 pages will be printed before the next copy of the job is 
printed. If you select No, 10 copies of page one will be printed, and then 10 
copies of page two will print, and so on.
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Image Position

This option enables you to adjust the image positioning on the sheet’s 
printed page (simplex or duplex). 

This function uses the following terminology: 

• Rear: the sheet's edge near the printer rear, where printing stops

• Lead: the edge of a sheet at which printing begins

The page’s Lead and Rear edges are determined just after the page is 
printed out, before making any change in the page orientation. 

To adjust the image positioning in duplex printing, do one of the 
following: 

• Select Same on both sides to shift the image on the sheet’s second side 
(face down image) according to the shift on the sheet’s first side (face 
up image).

• Click Center Image to set the Rear and Lead values to 0.
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• Set page offsets by clicking the directional arrows or by entering Rear 
and Lead values.

Click the arrows to change the values as follows: 

Right (left) arrows for positive (negative) values shift toward (away 
from) the leading edge 

Top (bottom) arrows for positive (negative) values toward (away 
from) the rear edge 

Image Scale

Select the desired Image scale option:

100%: prints at 100% of the original size (default)

Fit to Paper: for the image to fit the selected paper in the paper 
stock

Custom: select Custom and enter the percent by which you would 
like to proportionally decrease/increase the image size
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Rotate 180°

To rotate your job by 180°, select Yes.

Gallop
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The Gallop function enables you to begin printing a defined number of 
pages before the entire job has been RIPed. This enables you to print and 
RIP concurrently.

Gallop reduces the amount of time desired to RIP and print a job and is 
especially useful for long runs such as VI jobs. When combined with a 
deletion policy, Gallop enables you to free printer disk space.

Gallop is not recommended for relatively small jobs, since the benefit of 
engaging the process is marginal, and the total production time will be 
shortened by only a few seconds.

To set the gallop:

Select Yes and enter the number of pages to RIP before starting to 
print.

The Paper Stock Tab
The Paper Stock tab enables you to set paper stock-related job parameters. 

The Spire CXP8000 color server uses multiple paper stock parameters such 
as paper size, type, weight and coating to specify the paper stock. You may 
either select each parameter separately or select a complete paper set which 
already includes all parameters. 

If the selected paper set is unavailable, the current job is frozen until the 
appropriate set is available (the job receives a frozen status indicator, its 
line appears in blue and a message appears in the Alerts window). Other 
jobs can print while jobs are held.

Note:  The default number of pages to be RIPed before printing is 50. For 
complicated jobs using numerous shared elements, you can increase or 
decrease this number.
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Paper Set Name

To set the desired paper set:

Select the desired paper set from the Name list. If required, a paper set 
can be added (see Managing Paper Sets on page 167).

The selected paper set values (Paper Size, Type, Weight and Coating) 
appear in the corresponding parameters in the Paper Stock tab.

Managing Paper Sets

The Spire CXP8000 color server is provided with predefined paper sets for 
your convenience. These paper sets cannot be removed but they can be 
modified. In addition, you can add, modify or remove custom paper sets 
according to your requirements.

To add a new paper set:

1. Click the browse button.
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The Paper Set window opens.

2. Click the Add button.

The Paper Set Properties window appears.

3. Enter the following parameters:

Name: enter the new paper set name. It is recommended that the 
name is as descriptive as possible—for example, 
Letter90gsmuncoat.

From the Size, Color, Weight, Coat and Type lists, select the desired 
properties for the new paper set.

If you selected the Custom Paper Function in the Settings window 
(see General Defaults on page 411), select the Custom Profile.

4. Click OK.



Basic Settings 169

To modify a paper set:

1. In the Paper Set window, select the paper set you would like to modify.

2. Click the Edit icon.

The Paper Set Properties window appears. 

3. Modify the desired properties of the paper set.

4. Click OK.

To delete a paper set:

1. In the Resource Center window, with the Paper Sets option selected, 
select the paper set you would like to delete.

2. Click the Remove icon.

The Paper Set is deleted.

Paper Size

1. Select the desired stock size from the Size list.

Note:  The system predefined paper sets can’t be deleted.
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For a custom paper size setting, select Custom from the list. 

The Paper size options are displayed as follows:

2. Type the desired Height and Width. 

3. Select the desired Feed Direction:

• LEF (Long Edge Feed)

• SEF (Short Edge Feed)

Note:  Units of measurement (mm or inches) reflect system configuration. 
They are chosen in the Settings window (see Localization on page 409).
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Type

1. Select Paper to print on paper.
Or: 
Select Transparency if the stock type is Transparency.

2. Select the Add Interleave check box if you want to insert a blank page 
between transparencies. 

3. To customize the interleave, select the desired paper set from the list.
Or:
Use the default Same as job.
Or:
Click the browse button and add a new paper set.

For more information about adding a paper set, see Managing Paper Sets 
on page 167.

Notes:

• Slip-sheets and/or blank pages (interleave) in a transparency job are 
counted by the number of sheets, not by the number of pages, 
(rastered pages) reported on the Admin page.

• If the job is imposed, then the interleave is the size of the imposition 
sheet and is inserted between each sheet.
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4. In the Tray list, select the desired tray:

• Tray 1: Load the specific stock in this tray

• Tray 2: Load the specific stock in this tray

• Tray 3: Load the specific stock in this tray

• Tray 4: Load the specific stock in this tray

• Auto: Any tray with the specific paper stock will be used 

Weight

From the Weight list, select the desired stock weight.

Note:  For the Xerox DocuColor 8000 Digital Press, the paperweight ranges are, 
60-80 gsm, 81-105 gsm (default), 106-135 gsm, 136-186 gsm, 187-220 gsm, 
221-300 gsm.
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Coating

Select Coated to print on coated paper.
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Tray

In the Tray list, select the desired tray:

• Tray 1: Load the specific stock in this tray

• Tray 2: Load the specific stock in this tray

• Tray 3: Load the specific stock in this tray

• Tray 4: Load the specific stock in this tray

• Auto: Any tray with the specific paper stock will be used.

If you selected the Custom Paper Function in the Settings window (see 
General Defaults on page 411), in the Custom Profile list, select the 
custom profile.

Notes:

• The Auto tray option uses the paper in the selected tray only if it 
complies with all the other paper stock parameters. If the paper stock in 
the assigned tray mismatches with any Job Stock parameter, the job 
becomes 'Frozen’.
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The Print Quality Tab
The Print Quality tab enables you to set print quality related job 
parameters and to improve the quality of printed jobs. These parameters 
include the possibility to enhance text/ line quality and image quality. In 
addition it enables you to apply the Creo FAF algorithm by setting 
trapping, to define the black overprint, to use or ignore the overprint 
information by setting the PS overprint, and set the image noise level.

Text / Line Quality

Text/Line Quality refers to the Creo anti-aliasing algorithm for superior 
text quality. Text/Line Quality and text and line-art elements are processed 
separately to produce optimal rendering of all the elements on a page. This 
option improves the text quality of diagonal lines, borders and blends, 
causes blends to appear smooth with no banding and displays crisp 
diagonal lines without (or with minimal) jaggies (rough edges) that are the 
result of the limited resolution of the print engine.
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To set the text/line quality, select one of the following options:

Normal (default) to provide regular text quality

Anti Aliasing: When this option is selected, Creo anti-aliasing is 
used. This option requires re-RIP. Anti-aliasing is used to avoid or 
minimize jaggies - rough edges which are the result of the limited 
resolution of the original file.

Sharpen Edges: This option only works on LW data. This option 
does not require re-RIP.

Normal (with jaggies) High
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Image Quality

Image quality refers to the ability to maintain the same detail and 
smoothness with different degrees of enlargement. This feature is 
especially useful when your PostScript file includes several images at 
different qualities (for example, images that were scanned at different 
resolutions, were rotated, or downloaded from the internet).

To select the image quality, select one of the following options:

High to improve the quality of images in a job

Normal (default) to provide normal image quality (for jobs that do 
not require improved picture quality)

Note:  If you select the High option, the processing speed is decreased.
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Trapping

Trapping is a solution that solves misregistration between color 
separations in both offset and digital printing. This occurs no matter the 
accuracy of the printing device, and results in white lines around objects 
on top of a background (in a knock-out procedure) and also between 
adjacent colors. The solution is to extract the element and/or the 
background in order to create an overlap between them. 

See the following illustration for the trapping’s effect:

Printed without Trapping Printed with Trapping



Basic Settings 179

This function uses the following terminology: 

• Frame Thickness refers to the thickness of trapping. The thicker the 
frame, the less chance that white areas appear between images. 

• Protect Small Text is an option you may apply for small or complex 
images, since thicker frames can decrease quality by hiding parts of an 
image. Selecting this option will protect any text smaller or equal to 
12 pt by not framing it while applying the FAF algorithm.

To set trapping, select Yes.

In the Frame Thickness box, select the default (0.08mm) for the 
thickness of the trapping frame, or type the desired value.

Select the Protect Small Text check box so that any text that is 
smaller or equal to 12 pt. is not framed during FAF.
Or:
Clear this option to frame all text elements during FAF.

Note:  When Yes is selected, the Frame Thickness and Protect Small Text 
options are activated. These options cannot be selected through the PPD.

Note:  Selecting No does not affect trapping incorporated by DTP 
applications (for example, Photoshop). FAF should not be used with 
application based trapping. In a PostScript file that already contains trapping 
from the originating application, it is not necessary to use Spire CXP8000 
color server trapping.



180  Chapter 4 – Basic Workflows

 

Black Overprint

Occasionally, white lines may appear around black text. The text may 
appear less dense than desired as a result of misregistration between color 
separations. Black Overprint is used to ensure that black text prints cleanly 
within a tint or picture area. The text appears in a richer, deeper black, with 
the underlying CMY values equal to those of the printed background. 

A knock-out occurs when you print only the topmost color. This results in 
lesser color density and can cause misregistration if separations are not 
perfectly aligned. When Black overprint is active, there are no knock-outs 
under the black text. Black overprint prints text over colored backgrounds 
rather than knocking out the background first. As a result, misregistrations 
are not visible. It is therefore recommended to use Black overprint in order 
to ensure best results when printing black text and graphics. 

To enable black overprint, from the Black overprint options, select Yes 
(Black Overprint applies only to 100% black).

Note:  Selecting No increases the processing speed.
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PS Overprint

In the client authoring tools (for example QuarkXPress®), you can select 
overprint options. PS Overprint offers the option to use the overprint, 
which exists in the PostScript file. It also determines whether the DTP 
application PS Overprint settings are honored in the RIP. 

The Spire CXP8000 color server settings override PS Overprint commands 
from DTP applications. For example, if you set the PS Overprint option to 
Yes in a DTP application, and in the Spire CXP8000 color server set the PS 
Overprint option to No, the result is no overprinting. The Spire CXP8000 
color server can’t create PS Overprint that is not pre-defined in the file. If 
you select the Yes option (default) for a file that has not had overprinting 
defined in a DTP application, the result is no overprinting.

If you choose to keep the PS overprint that was applied in a DTP 
application, the Spire CXP8000 color server implements the overprinting 
and background colors are not knocked out. For example, in the case of a 
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yellow triangle overlapping a cyan circle, selecting Yes results in the 
overlapping area turning green. This is not seen on the screen, only in 
print.

If you choose to ignore the PS overprint information that exists in the 
input PostScript file, background colors are knocked out and only the top 
most color parts are seen on the screen in your DTP application.
For example, in the case of a yellow triangle overlapping a cyan circle, 
selecting No results in the cyan background being knocked out, so only the 
yellow is printed.

To set the PS overprint, select one of the following options:

• Select Yes to use the overprint information that exists in the input file.

• Select No to ignore the overprint information that exists in the input 
file.

Image Noise

The Image Noise parameter, enables you to smooth and blend vignettes of 
continuous tone (CT) images.

Note:  The above is true for files with PS Overprint Yes already selected in the 
DTP application.
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By default the Image Noise parameter is set to No. 

To set the image noise level:

1. In the Image noise options, select Yes.

2. Change the image noise level (if desired) by moving the slider; the 
higher the level, the smoother the vignettes appear.
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Overview
This chapter explains the various operations that you can perform from 
the Spire CXP8000 color server queues and in the Storage window. The 
chapter also provides information on managing jobs and disk space.

The Job Editor tool enables you to preview your jobs and edit RTP jobs. In 
this chapter, you will find out how to do these tasks.

This chapter also explains how to use the job accounting tools, manage 
virtual printers and define your job flow.

Managing the Job Queues
After entering the Spire CXP8000 color server, a job resides either in the 
Queues window or in the Storage window, depending on the job flow. 

To display the Queues window:

From the View menu, select Queues.

The Queues window consists of two areas, the Process Queue and Print 
Queue.

• The Process Queue lists the job that is currently being processed and 
the jobs that are waiting to be processed. 

• The Print Queue lists the currently printing job and the jobs that were 
processed successfully and are waiting to be printed. The Print Queue 
also lists frozen jobs (jobs for which the specified paper stock is not 
available).

Each queue holds jobs in the order in which they enter it (unless a rush job 
“interrupts” the submission order). 

At any time, you can view information regarding the number and status of 
the jobs in the queues. You can also change the order of the jobs and 
suspend or resume the queue.

For more information about rush jobs, see Running a Rush Job on page 195.
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After you start the Spire 8000 color server, the Queues window is displayed. 
The Queues window consists of the Print Queue and the Process Queue.

Each queue holds jobs in the order in which they enter it. The top job in the 
queue is currently running, while all others are waiting to run. 

If necessary, you can change the order the jobs that are waiting in the 
queues. You can also view and edit the jobs’ parameters.

Note:  If there are very short jobs in the Print Queue, several jobs may be 
running at the same time. The jobs marked as running are listed first and printed 
in the order they are listed.
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The Queues Window
After you submit PDL jobs (or resubmit PDL jobs), the Process Queue lists 
the files to be processed. 

Once a file has been processed successfully, it moves to the Print Queue and 
waits to be printed or to the Storage window (depending on the current job 
flow or virtual printer).

The Queues window lists informations about the jobs that are being 
processed. Status indicators indicate the status of each job. Table 5 
describes the status indicators used in both the Process Queue and Print 
Queue.

For more information about operations on the jobs residing in the Queue 
Manager, see Aborting a Running Job on page 193.

Table 5: Process Queue and Print Queue status indicators

This 
Status 
Indicator

Indicates This:

The job is running.

The job is frozen and held in the Print Queue. If a job is 
frozen, it indicates that the selected paper stock is not 
available

The job is waiting.
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Right-click the column heading row to select the columns that you want to 
view. 

The job is a rush job.

The rush job is frozen.

The rush job is waiting.

Table 5: Process Queue and Print Queue status indicators

This 
Status 
Indicator

Indicates This:

For more information about rush jobs, see Running a Rush Job on page 195.

Table 6: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

Type File format of the PDL job—for example, PS 
(.ps), PDF(.pdf), VPS(.vps)

Title Name of the file to be printed. If you submit a 
file whose name already exists in the Spire 
CXP8000 color server, a number is 
automatically added to the file name—for 
example, if you submit a file called lobster 
and this file name already exists, the newer 
file is renamed lobster1.

Sender User name of the system from which this file 
originated

Submitted Date and time this job was first submitted to 
the Spire CXP8000 color server

Pages Number of pages to be processed in a PDF 
job. If the DTP application supported it, the 
number of pages is indicated for other PDL 
jobs.
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Status Information

The Processing and Printing status areas contains the following:

• The suspend and resume buttons (for more information see 
Suspending and Resuming Queues on page 192)

• The queue name.

• If a job is currently being processed or printed, the name of the job and 
a process indicator are displayed.

Sets Number of copies to be printed

Paper set/Stock 
name

Paper set name or stock name.

Paper Size Paper size

Weight Paper weight

 Type Paper type

 Coating Paper coating

File Size File size of the job

Account Account name taken from the Job info 
parameter

Job Info Job info type taken from the Job info 
parameter

Imposition Type of imposition used

Page Exception Whether or not the job has page exceptions

Server Name of the server being used

Virtual Printer 
Names

Name of virtual printer being used

Table 6: Process Queue and Print Queue column descriptions

This Column Indicates This Information:
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• The number of jobs in the queue—for example, 2.

Batching Jobs
The job-batching workflow combines jobs with similar attributes into a 
single batch to enable the printer to print the jobs continuously without 
pausing. This feature saves printing time, especially for a large number of 
small jobs. Jobs that use paper of the same size and weight are suitable for 
batching. 

When a job enters the Print Queue, the Spire CXP8000 color server checks 
whether the job is suitable for batching with the previous one: 

• A job that can be batched appears with the running status indicator. 
The printer prints both jobs without pausing between them. 

• A job that cannot be batched with the previous one waits in the queue 
and appears with the waiting status indicator. It is printed only when 
the printer finishes the previous job and comes to a stop. 

The Spire CXP8000 color server batches suitable jobs only if they are 
consecutive in the queue. Two jobs are not batched if a job that is not 
suitable comes between them in the queue.

The following types of jobs cannot be combined into one batch:

• Collated jobs and uncollated jobs

• Jobs that use different output trays

• Jobs with different staple positions

The job batching option is active by default. 

The Processing status area indicated the total number of pages for PDF jobs. 
The number of pages is indicated for other PDL jobs only if the desktop 
publishing application in which they were created supports this feature.
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To deactivate job batching:

In the Settings window, select Preferences>Print Queue Manager> 
Disable Job Batching. 

Changing the Order of Jobs in the Queues 
You can rearrange the jobs in a queue to change the order in which they 
will be processed or printed. This feature is useful when you have an urgent 
job that takes priority, for example.

To move a job up in the queue:

Right-click the job and select one of the following options:

Promote: to move the job up one step

Promote to top: to move the job to the top of the queue

To move a job down in the queue:

Right-click the job and select one of the following options:

Demote: to move the job down one step

Demote to bottom: to move the job to the bottom of the queue.

Suspending and Resuming Queues
If necessary, you can stop a queue temporarily and then later continue its 
operation afterwards. To do this, use the suspend and resume buttons:

To suspend a queue:

Click the suspend button.

The button turns red (suspend mode), and the processing/printing 
stops after the current job has finished running.

For more information about job batching, see Print Queue Manager on 
page 411.

Note:  You can only move one job at a time.

Note:  The job is placed below the Running job.
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To resume a queue:

Click the resume button.

The button turns green (resume mode), and the top job in the queue 
starts processing/printing.

Aborting a Running Job

To stop processing or printing a running job:

Right-click the running job in the Queues window, and from the 
menu, select Abort.

The job moves from the queue to the Storage window, and the Alerts 
window is updated.

The Aborted status is assigned to the job, and the next job in the queue 
starts running.

Note:  To return a job to the proper queue, right-click the job(s) in the Storage 
window and from the Job menu select Submit.
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To return a job to the Process Queue or Print Queue:

Right-click the job in the Storage window and from the Job menu 
select Submit.

Moving a Waiting Job to the Storage Window
To the postpone processing or printing of one or more waiting jobs, use the 
Move to storage option.

To move a waiting job to storage:

1. Select the job in the Queues window.

2. Right-click the job(s), and select Move to storage.

The job(s) move(s) from the queue to the Storage window and appears 
with the held job indicator . 

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.
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To return a held job from the Storage window to its original queue:

Right-click the job, and from menu select Submit.

The job moves from the Storage window to the queue and appears with 
the waiting job indicator.

Viewing and Editing Job Parameters 
In the Queues or Storage window, double-click the job whose 
parameters you want to view.

The Job Parameters window appears.

Running a Rush Job
When you have a job that’s urgent, you can submit it for processing or 
printing and run it before other jobs. If you submit a job for processing 
while another job is being processed, the latter job pauses temporarily but 
retains its running status. When the rush job finishes processing and 
moved to the Print Queue, the processing of the paused job continues.

If you submit a rush job for printing while another job is being printed, the 
latter job pauses temporarily after the current page (both sides) or set is 
printed but retains its running status. When the rush job finishes printing, 
the printing of the paused job continues.

To submit a rush job:

Note:  In the Queues window, you can edit the parameters of jobs that have not 
begun to run. If you want to edit the parameters of a running job, you must first 
suspend the queue (click the suspend button).

Note:  If you edit the parameters in of a job in the Print Queue and the changes 
require re-RIPing of the job, it automatically moves to the Process Queue.

Note:  Only one job can be processed or printed at a time. Therefore, if you select 
several jobs (one after the other) as rush jobs, they will be processed/printed in 
the order of their selection.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.
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In the Queues or Storage window, right-click the job, and select Run 
Immediately.

The job appears with the rush status indicator  at the top of the 
appropriate queue and runs immediately.

Deleting a Job
Once you delete a job from the Process Queue, Print Queue, or Storage 
window, you need to resubmit it for processing and printing. To 
temporarily remove a job from a queue, use the Move to storage option 
(see Moving a Waiting Job to the Storage Window on page 194).

To delete a job:

1. Right-click the desired job in the queue or Storage window, and select 
Delete.

The following message appears.

2. Click Yes.

The selected job(s) is deleted.

Managing the Storage Window
The Storage window is displayed by default. If you close the Storage 
window, you can reopen it by selecting Storage from the View menu.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.

Note:  You can delete more than one job at a time: Select the jobs, and from 
the Job menu, select Delete.
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The Storage window contains jobs of various types:

• Printed Jobs

• Jobs that you moved to the Storage window or aborted during 
processing or printing

• Jobs that failed during processing or printing

• Retrieved jobs

• Jobs that were imported directly to the Storage window from the client 
workstation (by selecting the Spool & Store option for the job flow)
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In the Storage window, you can see the number of jobs that are in storage 
and their status.

Each job in the Storage window is assigned a status as shown in Table 7:

By default, the Storage window shows all the jobs, whatever their status. All 
the status buttons are selected—that is, they appear pushed in. If you click 
a status button now—for example, the Completed Jobs button—the 
button is released and the list hides all the completed jobs:

Table 7: Storage window status buttons

Icon Status Indicates This

Completed The job has finished printing.

Held You moved the job from the Queues window 
to the Storage window; or the current job 
flow or virtual printer moved the job to the 
Storage window automatically.

Failed The job failed during processing or printing.

Aborted You aborted the job in the Queues window 
while the job was running.
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If you click the Completed Jobs button again, the button is pushed in and 
the list shows the completed jobs.

Discarding RTP Information
The RTP information can be discarded if desired. Under some 
circumstances, it is necessary to discard RTP data—for example when you 
want to re-RIP a file, archive a job without the RTP information, or edit 
tabs.

To discard RTP information from a job:

In the Storage window, right-click the relevant job and select Revert to 
source.

The RTP data is discarded and the file returns to its original format—
for example, PostScript.

For more information on RTP jobs, see Data Flow on page 12.

Handling Jobs in the Storage Window
In the Storage window you can perform the following actions:

• Submit a job. See Submitting Jobs on page 200.

• Run a rush job before other jobs. See Running a Rush Job on page 195.

• Preview and edit a job, using the Job Editor. See Job Editor on page 203.

• View and edit the parameters of a job. See Viewing and Editing Job 
Parameters on page 195.

• Archive a job. See Archiving and Retrieving Jobs on page 200.

• Duplicate a job. See Duplicating Jobs on page 200.

• Delete a job. See Deleting a Job on page 196.

• View a job’s history (in the Job History window). See Viewing a Job’s 
History on page 203.

• Export as job as a PDF file. See PDF Workflow on page 257.

• View the job ticket report for a job. See Job Ticket Report on page 223.

Note:  When all the status buttons are in the released (unselected) position, The 
Storage window shows no jobs.
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• View the preflight report for a job. See Preflight Report on page 369.

• Export a job as a Synapse® InSite job. See Export as Creo Synapse InSite 
Job on page 373.

Submitting Jobs

To submit a job in the Storage window:

In the Storage window, right-click the job, and select Submit.

RTP jobs are submitted to the Print Queue; all other jobs are submitted 
to the Process Queue.

Duplicating Jobs

To duplicate a job:

1. In the Storage window, right-click the job and select Duplicate. 

A warning message appears.

2. Click Yes to continue. 

The selected file is duplicated and is given the name of the original job 
followed by the suffix _dup.

Archiving and Retrieving Jobs
To keep enough disk space free, we recommend that you back up jobs and 
their related files to an external server and then delete them from the 
Storage window.

This backup process is called archiving. You can retrieve archived jobs and 
related files later for further use.

You can set a default archiving path that will automatically be displayed in 
the Open dialog box when you select Archive from the Job menu. Set this 
path in the Settings window under Preferences>General Defaults.

Notes:

• Duplicating an RTP job creates a PDL version of the job.

• Once you duplicate a job, you can only edit parameters in the Job 
Editor that do not require re-RIP. 
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If a job includes VI elements, you need to archive or retrieve the VI 
elements before archiving or retrieving the job. For more information on 
archiving or retrieving VI elements, see Managing VI Elements on 
page 385.

To archive a job on an external server:

1. In the Storage window, right-click the job you want to archive and 
select Archive.

The Open dialog box appears.

2. Locate the desired folder, and then click Archive.

A cabinet file (a compressed file) that contains all the files related to the 
archived job is created at the selected location. 

3. In the Alerts window, verify that archiving has been completed.

4. Delete the job from the Storage window.

Notes:

• The archived job retains its current status (that is, completed, failed, 
held, or aborted) and is archived with the information in its Job 
Parameters and Job History windows. 

• When retrieved, the archived job retains the original job name, not the 
name assigned when archived.
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To retrieve an archived job:

1. From the Job menu, select Retrieve from Archive.

The Open dialog box appears.

2. Locate the archived job under its archive name, select the related 
cabinet file, and click Open. 

The selected job appears at the top of the list in the Storage window. It 
is assigned the status indicator (completed, held, failed, or aborted) 
that is had before archival. 

Notes:

• You can retrieve more than one job at a time.

• The files related to the job (for example, PDL) are also retrieved.

• The job is retrieved with the information in its Job Parameters and Job 
History windows.

• The cabinet file is not deleted.
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3. In the Alerts window, verify that the file has been successfully 
retrieved.

Viewing a Job’s History
In the Queues or Storage window, right-click the job and select Job 
History.

The Job History window appears.

Job Editor
The Job Editor tool enables you to preview a job before printing, delete, 
move or insert pages. While you navigate to the various pages of a job, you 
can view thumbnails of the job, For an imposed job, you can view the 
imposed sheets, including the layout of the pages on each sheet and the 
pages’ orientation, crop marks and fold marks.

To open the job editor:

In the Storage window, right-click an RTP job that you want to 
preview, and select Job Preview&Editor.

The Job Editor window appears, displaying the first page of the selected 
job. 

Navigation Buttons
The navigation buttons enable you to view the pages of the current job.  

Previewing the Job
By default, when you open the Job Editor, the first page of the job is 
displayed (when the Fit to page option is selected). The preview buttons 
enable you to switch the display mode of the page:

For more information about the Job History window, see Job History on 
page 421.

Note:  When the first page of a booklet is in view, the Previous Page navigation 
button takes you to the previous booklet. When the last page of a booklet is in 
view, the Next Page button takes you to the next booklet.
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The Max details button magnifies the selected area of the page. To return 
to the previous view, click anywhere on the page. If you navigate to another 
page after selecting Max details, the preview option switches to Fit to Page.

The Actual Size button displays the size of the page as it will be printed. If 
the page is larger than your monitor’s display, use the horizontal and 
vertical scroll bars to view the entire page. If you navigate to another page, 
the Actual Size option remains selected.

The Fit to page button resizes the display so that you can see the entire 
page. If you navigate to another page, the Fit to page option remains 
selected.

Viewing Pages in the Job Editor
The Job Editor window has three tabs—Booklets, Thumbnails and 
Imposed Sheets—which enable you to switch between views.

The Booklets tab
The Booklets tab displays the booklets included in the selected job and the 
names and numbers of the pages in each booklet. The Booklets tab opens 
by default when you are previewing a nonimposed RTP job.

To view a page on the booklets tab: 

In the left pane of the Booklets tab, double-click the name of the page 
that you want to view.

The page is displayed in the right pane.
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The Thumbnails Tab 
The Thumbnails tab displays miniature views (“thumbnails”) of each page 
in the selected booklet. These thumbnails enable you to find a specific page 
more easily.

To view a page on the Thumbnails tab:

1. Click the Thumbnails tab.

Miniature versions of the pages appear on the left side of the tab, in the 
thumbnail pane.

2. Use the scroll bar, as desired, to view all of the pages.
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3. To view the thumbnails side by side, resize the thumbnail pane by 
dragging the bar that divides the panes in the tab.

4. Double-click the thumbnail of the page that you want to view. 

The page is displayed in the right pane.

The Imposed Sheets Tab
The Imposed Sheets tab is available only for imposed RTP jobs. This tab 
enables you to view the imposed sheets and check your imposition 
parameters. You cannot edit the job on this tab. To edit an imposed job, use 
the Thumbnails or Booklets tab. Then return to the Imposed Sheets tab to 
view the updated imposed layout.
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To display a page of an Imposed job:

1. Click the Thumbnails or Booklets tab.

2. Select the desired thumbnail or page.

3. Click the Imposed sheets tab.

The selected page of the imposed job appears.

Notes:

• In VI jobs, the booklet number appears in instead of the sheet number—for 
example, Booklet 1, Page 15.

• In duplex jobs, each sheet is displayed twice, once for side A, and once for 
side B. For example, Sheet 1, Side A.
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4. To view information about the imposed job, click the Show Info 
button.

The related imposition information appears. 

5. To close the imposition information, click the Show Info button 
again.

6. To edit the job, click the Booklets or Thumbnails tab.

For more information about editing RTP jobs, see Editing an RTP Job on 
page 209.

Note:  If you edit an imposed RTP job and then return to the Imposed sheet 
view, the view will be updated according to the applied changes.
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Editing an RTP Job
You can edit an RTP job in the following ways:

• Move pages within the job 

• Delete pages from the job 

• Insert pages from another job

To move a page in a job:

1. Click the Thumbnails tab.

2. In the thumbnail pane, click the page that you want to move.

3. Drag the page to the target location.

The page moves to the selected location, and the page numbers are 
updated accordingly.

4. Click Save As to save the changes in the job.

Note:  Jobs that you can edit in the Job Editor cannot be re-RIPed. Once a job has 
been saved in the Job Editor, it is a new RTP file without an associated PDL file. 
You cannot apply parameters that require re-RIPing to such jobs.

Note:  The red marker indicates where the page will be inserted.
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To deleting a page from a job

1. In the Job Editor window, click the page that you want to delete, and 
click Delete.

The page is deleted and the page numbers are updated accordingly.

2. Click Save As to save the changes.

Copying Pages Into a Job
You can copy one page or all pages from one job to another.

To copy a page into a job:

1. In the Job Editor window, open the job that you want to edit.

2. Click Select Job.

The RTP Jobs window appears.

3. Select the job with the page you want to copy.

4. Click OK. 

In the Thumbnails tab, the left pane splits into two. The thumbnails of 
the second job that you opened appear below those of the job you are 
editing.

Note:  The Spire CXP8000 color server displays only those RTP jobs that have 
the same page size and orientation as the job that you are editing.
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5. In the lower set of thumbnails, locate the page that you want to copy.

6. Drag the page to the upper set of thumbnails, to the desired location 
in the job that you are editing.

The copied page is inserted in the desired location, and the page 
numbers are updated accordingly.

Note:  The red marker indicates where the page will be inserted.
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7. Click Save As to save the changes.

To copy all the pages of a job into another job:

1. Follow steps 1-4 in the procedure for copying a page into a job (see 
page 210).

2. Click the Merge Jobs button.

All the pages of the second job that you opened are inserted at the end 
of the job that you are editing.

3. Click Save As to save the changes.

Job Accounting
The Accounting feature provides information about all the jobs that were 
printed successfully via the Spire CXP8000 color server. The report is in 
the form of a tab-delimited file. You can filter, sort, and print the jobs in 
the report and also export the report to a spreadsheet application—for 
example, Microsoft Excel—where you can manipulate the data.
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Viewing the Accounting Information
At any stage of work, from the Tools menu select Accounting.

The Accounting Viewer window appears, listing information related to 
all the jobs that printed successfully via the Spire CXP8000 color server. 

Each row in the Accounting report contains information related to a 
specific job.

Notes:

• To see additional columns, use the horizontal scroll bar.

• By default, all the jobs that were handled during the past 3 months are 
listed. From the Tools menu, select Settings. In the Settings window, under 
Preferences>Messages, you can specify how long information remains 
before being overwritten. In addition, you can remove all the information 
from the window whenever desired.
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The columns indicate the following information.

Table 8: Description of columns in the Accounting Viewer

Column name Indicates the

Job Title Original name of the file related 
to this job (that is, without the 
extension)

Sender User name of the system from 
which this job originated

Submitted Date and time the job was first 
submitted into the Spire CXP8000 
color server

Started Printing Date and time on which the job 
first started printing

Processing Time Total time during which the job 
was processed

Printing Time Total time during which the job 
was printed

Job Size Job size in MB

Paper Size Size of the media set for the job—
for example, Letter, A3, A4

Paper Weight Paper weight in gs/m

Coating Paper stock coating status 
(Coated or Uncoated)

Sets Actual number of printed copies

Job B/W Pages Number of black-and-white pages 
in the original PDL file 

Inserts Number of pages inserts

Job Color Pages Number of color pages in the 
original PDL file 
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Setting the Accounting/Message Viewer
By default, all the jobs that were handled during the past 90 days are listed 
in the Spire CXP8000 color server Accounting window. Also, all jobs that 
were handled during the past 56 days are listed in the Spire CXP8000 color 
server Message Viewer. You can specify how long information remains 
before being overwritten.

Total Pages Printed Number of pages that were 
printed

Purged B/W Number of B/W pages that were 
already in the paper path, and 
were cleared due to job abort, or 
paper jam

Purged Color Number of color pages that were 
already in the paper path, and 
were cleared due to job abort, or 
paper jam

Page Exceptions Existence of exceptions in the job 
(Yes/ No)

Account [Optional] string of text, if such 
was entered in Job Parameters

Recipient [Optional] string of text, if such 
was entered in Job Parameters

Job Comments [Optional] string of text, if such 
was entered in Job Parameters

Table 8: Description of columns in the Accounting Viewer

Column name Indicates the

To change the Accounting/Message Viewer log setup, see Messages on 
page 416.
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Printing and Exporting the Accounting Log
You can save the Accounting information to an ASCII Tab delimited file.

To export the accounting information:

1. Filter the information as desired.

2. Click Export.

The Export Accounting window appears.

3. Locate the folder in which to save the report.

4. Click Save.

The log is saved as a Tab delimited text file in the specified location. 

5. If desired, open the *.txt file in a text editor or in a spreadsheet 
application—for example, Microsoft Excel—and manipulate the data.

You can print the Accounting information (filtered and sorted) to any 
connected printer.

Notes:

• The log includes all the columns (even those that were hidden), listed in 
the original order and sorting.

• To export specific rows, select them before clicking Export. The 
exported log will include only these rows.

• The exported data is not deleted from the Accounting report on the 
Spire CXP8000 color server (that is, it will still be displayed in the Job 
Accounting window).
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To print the accounting log:

1. Filter and sort the report as desired.

2. Click Print List.

The Print window appears.

3. Set the printing options as desired and click OK.

The data is printed according to the current filtering and sorting.

Note:  To print specific rows, select the desired rows now. The printed report 
will include only these rows.

Notes:

• To fit the maximum amount of columns on the page, print using 
Landscape orientation (if your printer supports it).

• The report includes all the columns (including those that were hidden), 
listed in the original order.
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Managing Virtual Printers
A virtual printer is a printer published on the network with specific 
parameters set for processing and printing on the Spire CXP8000 color 
server. The Spire CXP8000 color server contains a mechanism that 
automatically installs the published virtual printers on your client 
workstation with the PPD and suitable printer driver. 

The Spire CXP8000 color server is predefined with three virtual printers:

• ProcessPrint 
Files sent to this printer are automatically processed and printed to the 
printer through the Spire CXP8000 color server.

• ProcessStore 
Files sent to this printer are automatically processed and stored in the 
Storage window of the Spire CXP8000 color server. You can later 
submit the jobs to be printed, or change the parameters of a job and 
resubmit it for processing.

• SpoolStore
Files sent to this printer are automatically stored in the Spire CXP8000 
color server's Storage window until the print operator submits them 
for processing and printing.

If a job that is sent from the client, or downloaded to a particular virtual 
printer, contains preset parameters from the PPD, these options overwrite 
the parameters set in the virtual printer for that job. The Printer Default 
options defined in the PPD use the default parameters set for that 
particular virtual printer.

Adding a new printer
When adding a new virtual printer you can specify if it is published on the 
network and if the virtual printer parameters will override the PPD 
parameters.

In addition, based on predefined paper sets, you can specify that a virtual 
printer supports dynamic page exceptions and select the desired paper sets 
(up to 4 paper sets for each virtual printer). A job that has embedded 
dynamic page exceptions commands, and is submitted for print using a 
dynamic page exceptions virtual printer, is printed using the defined paper 
sets.



Managing Virtual Printers 219

To add a new printer:

1. From the Tools menu, select Resource Center.

The Resource Center window opens.

2. From the Resource list, select Virtual Printers.

3. Click the Add button.

The Add New Virtual Printer dialog box appears.

4. In the Name box, type a name for the new printer you want to add.

5. From the Based on list, select an existing printer with similar settings.
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6. In the Comments box, type any comment regarding the virtual printer 
parameters (optional).

7. The Publish the printer on the network check box is selected by 
default. Clear the check box if you do not want to publish the printer 
on the network.

8. Select the Override PPD parameters check box if you would like the 
Virtual Printer settings to override the PPD parameter selection.

9. If you would like this printer to support dynamic page exceptions, 
select the Support dynamic page exceptions check box. 

10. Edit the Job Parameters of your new virtual printer. 

11. Click OK in the Add New Virtual Printer dialog box. 

The new printer appears in the Printer list.

For more information about dynamic page exceptions, see Dynamic Page 
Exceptions on page 275.

For more information about editing printer settings, see Editing an 
Existing Printer on page 221.

Note:  If you don't edit the Job Parameters, the settings of the new virtual 
printer are taken from the printer on which it was based.
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Editing an Existing Printer

To edit an existing printer:

1. In the Virtual Printers area, select a printer from the list and click Edit.

2. Click Edit.

The Job Parameters window appears.

3. Select the desired parameters and change their settings according to 
your requirements.

4. Click OK to return to the Edit Virtual Printer dialog box.

5. Click Save to save the new settings.

Deleting an Existing Printer
1. In the Virtual Printers window, select a printer from the list and click 

the Delete button.
Or:
Right-click the printer and select Remove.

2. In the message that appears, click Yes to delete the designated printer.
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Job Flow
The Job Flow parameter in the Job Parameters window Services tab 
enables the Spire CXP8000 color server operator to specify a job flow for a 
job that is imported to the Spire CXP8000 color server from the network or 
from the Spire CXP8000 color server folders.

1. In the Job Parameters window Services tab, select the Job flow 
parameter.

2. Select the desired job flow option:

Process & Print: to set the Spire CXP8000 color server to RIP the 
PDL files, print them, and store them in the Storage window 
(unless the Job Deletion parameter is set to Delete after Complete)

Process & Store: to RIP the PDL files and move them to the Storage 
window as RTP jobs

3. Click Save.

Note:   The Spool & Store option (the Spire CXP8000 color server places the 
PDL files directly into the Storage window without processing them) is 
disabled and can be defined only through the PPD parameters of the virtual 
printer.



Job Ticket Report 223

Job Ticket Report
The Job Ticket report contains all information from the Job Parameters 
window (including Job Parameters window title bar data). The Job Ticket 
report presents the job parameters on a single sheet and may be exported 
or printed as a hard copy.

This feature is useful for:

• Updating the Hot-Line service on Job Ticket Report data when a 
question arises.

• Retaining job parameters when the same job is planned to be re-
printed in the future.

• Providing the client/customer a follow-up tool regarding printed Job 
Parameter information.

To display the job ticket report:

1. Right-click a job in the Storage window, and from the menu select Job 
Ticket Report.

The Job Ticket Report window appears.
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2. You can export or print the report by clicking Print or Export.

The Job Ticket Report is exported as a text file.
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Imposition Workflow
Imposition is the process of positioning page images on sheets of paper in 
the printer or in a digital printing press. It is part of the process of 
producing finished documents.

In addition to page images, you can add various marks to the sheets to aid 
the production process. These marks show where the paper should be 
folded or trimmed.

Imposition does not affect the content of the individual page but rather the 
placement of the pages on a press sheet. Imposition is a combination of 
content and layout. The content is the pages that should be printed and the 
layout is the location of the page on the sheet and the printing marks, crop 
marks and fold marks.

Whenever possible, you should define imposition settings before RIPing a 
job. Changing key imposition settings—for example, template settings—
post RIP may result in inefficient re-RIPing of your job.

In the Spire CXP8000 color server, imposition parameters are set in the 
Imposition tab, and page exceptions are set in the Exceptions tab.

You can use a Spire CXP8000 color server virtual printer to predefine your 
imposition settings. When you create a new virtual printer or edit an 
existing one, define the imposition settings for that particular printer. 
These settings become the printer's default options and are applied to all 
jobs that use the printer. 

For more information about the Imposition tab and the Exception tab, see The 
Imposition Tab on page 227, and Setting Exceptions for Imposed Jobs on 
page 267.

For more information about virtual printers, see Spire CXP8000 Color Server 
Network Printers on page 13, and Managing Virtual Printers on page 218.
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The Imposition Tab
The Imposition tab enables you to set job options related to the 
positioning, folding, trimming and binding of pages.

Imposition Method

The Imposition Method parameter specifies how printed sheets are 
finished. You to choose a method according to the finished format that 
you need.

In the Imposition method options area, select one of the following 
options:

None: This is the default option. If you select None, the imposition 
parameters are unavailable and the thumbnail viewer does not 
display an image.

Note:  If you use a dynamic page exceptions virtual printer to print a job, the 
Imposition tab is unavailable, see Dynamic Page Exceptions on page 275.
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Step & Repeat: Use this option for printing multiple copies of the 
same image so it fills up a larger sheet. This method is used mainly 
for printing business cards.

Cut & Stack: Use this option to enable Step & Repeat jobs to be 
printed, cut, stacked and bound in the most efficient manner, while 
preserving the original sorting. A job’s pages, booklets, or books are 
sorted in a Z-shape. In other words, each stack of pages is sorted in 
consecutive order. When stacks are piled one on top of another, the 
entire job is already sorted up or down.

Notes:

• When you use the Step & Repeat template for VI jobs, the system 
prints the job in Z-Sorting mode. This mode enables imposed VI jobs 
to be sorted for Cut & Stack finishing.

• It is possible to use specific Step & Repeat templates to print 
several different images on one sheet.

Note:  When you use the Step & Repeat template with the Cut & 
Stack sub-option, you cannot make changes or enter a valid exception 
in the Exceptions tab.
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Saddle Stitch: Use this option for a book-finishing technique where 
the pages of a book are attached through stitching or stapling in the 
spine fold —for example, brochures.

Perfect Bound: Use this option for a book-finishing technique 
where the pages of a book are attached through trimming of the 
spine fold, roughening the edges of the gathered pages and gluing 
them together —for example, hardcover books.

Sizes
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The Sizes parameter uses the following terminology:

• Paper set defines the paper stock attributes (paper size, type, weight 
and coating) on which the imposed job will be printed. The Spire 
CXP8000 color server enables you to define all the paper stock settings 
of an imposed job on the Imposition tab with no need to switch to the 
Paper Stock tab and define the paper stock settings there.

• Trim size is the size of the finished, trimmed document. 

You can adjust your page size by adjusting the trim size.

• Orientation specifies the orientation, Portrait or Landscape, for the 
trim size. If the wrong orientation is specified, an unsuitable template 
might be selected and the job might be cropped as a result.

To set the size options:

1. In the For sheet size use paper set list, select the desired paper set. If 
you need to add a new paper set, click the browse button.

Note:  If you set the trim size to be smaller than the page size set in the DTP 
application, some of the data is cropped. Setting a larger trim size results in a 
larger border on the printed page.

For more information about adding paper sets, see Managing Paper Sets on 
page 167.
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2. In the Trim Size list, select the desired trim size. If you select Custom, 
define a custom trim size and type the desired Height in the H box, 
and the desired Width in the W box.

3. Select the desired Orientation for the trim size.

Template

The Template parameter includes a list of available templates and their 
layout options. Each imposition method has its own specific template 
choices. For example, if you change your imposition method from Perfect 
bound to Step & Repeat, the template you initially selected no longer fits 
the new method. When desired, the Spire CXP8000 color server 
automatically substitutes a suitable template for your new method and 
notifies you that the change has been made.
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To select a template:

1. From the Category options, select System to choose a predefined Spire 
CXP8000 color server imposition template.
Or:
Select User-defined to choose a user defined Spire CXP8000 color 
server imposition template.

2. In the Template list, select an available template.

3. In the Layout list, select the desired layout.

4. Select the Fit to sheet check box to proportionally increase or decrease 
the layout.

Previewing the Template Layout

When you choose a template, you need to account for other job 
parameters—for example, Trim Size, Bleed, Margin, Gutters, and Paper 
Size. In the Template Options area, you can preview the template layout of 
your job and check your imposition settings. For example, green arrows 
indicate that the template layout is rotated, and blue and black arrows 
indicate the direction of the pages on the sheet. The sequence of pages is 
indicated by the page numbers.

For more information about user defined templates, see Imposition 
Templates on page 238.

Note:  If you select the User Defined option, Layout is unavailable.
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If the parameters conflict, you will see where the conflicts exist when you 
preview the template layout:

• Red corners indicate that the trim size is bigger than the sheet size.

• Yellow corners indicate unsuitable margin settings—for example, if 
the margin size is unsuitable.

• Dotted lines indicate conflicting trim size settings and template 
settings (for example, A3 trim for Step & Repeat 2x2 Duplex template).

Margins

The Margins parameter enables you to adjust the spaces between the 
outside edges of pages and the edges of the sheet on which they are printed. 
Margin settings should suit finishing equipment and requirements. 
Confirm binding parameters with your binder when planning your sheet.

Note:  You can preview the imposed job in the Job Editor window, Imposed 
sheets tab, see Viewing Pages in the Job Editor on page 204.
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The Margins parameter uses the following terminology: 

• The Margins size is the distance between the outside edges of the sheet 
and the edges of the pages printed on the sheet. The value that you set 
is not the exact distance. The Spire CXP8000 color server calculates the 
exact distance in accordance with other imposition parameters.

• The Gutter size is the inside space between pairs of pages on a sheet. 
When folded into a signature / booklet, the gutter allows space for 
trimming.

• The Spine trim size is the space between adjacent pages on a printed 
sheet. When the sheet is folded into a signature / booklet, this space 
allows you to roughen the edges for perfect binding. 

To set the margins:

In the Margins options area, type the desired margin sizes.

Note:  For specific sheet templates, there may be no gutter at all or only one 
gutter—for example, in two up, there is no gutter. In these cases, the gutter 
size setting is ignored.

Note:  You use spine trim size with the perfect bound method only. If the 
saddle stitch method is used, this value is set to zero and the pages are 
printed side by side without any space between them.

Note:  Units of measurement (mm or inches) reflect system configuration and 
are selected in the Settings window, see Localization on page 409.



Imposition Workflow 235

Marks & bleed

The Marks & bleed parameter enables you to mark where trimming and 
folding should occur. 

When you set bleed options, you extend part or all of the printed image 
beyond the trimming boundary. The bleed options ensure that an 
inaccurate trim setting will not leave an undesired white space at the edge 
of the page. The bleed options produce sharp page boundaries with color 
that extends all the way to the edge of the page.

To select marks and bleed options:

1. In the Marks area, select one of the following options:

a. To print the lines that indicate where the sheet should be cropped, 
select the Crop Marks check box.
To print the crop marks on both sides of the page, select the Both 
sides of sheet check box.
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b. To print the lines that indicate where the sheet should be folded, 
select the Fold Marks check box.

2. In the Bleed area, select one of the following options:

a. Maximum bleed: Use this option to extend the bleed to the sheet 
fold lines.

b. Custom bleed size: Type the desired bleed size in millimeters.

Note:  

• Crop marks are placed according to the Trim Size option. A minimum 
of 6 mm is required for crop marks, and 10 mm for fold marks.

• If your job already includes crop marks incorporated in the DTP 
application, you do not need to add crop marks here. If you do add crop 
marks, both sets of crop marks can be printed.

• If you want to use crop marks incorporated in the DTP application, make 
sure that enough space is left around your page in the PostScript file so 
that the page prints with crop marks.

Note:  

• You cannot extend the bleed size beyond the sheet fold lines. Bleed 
does not affect the position of crop.

• Bleeding must be defined in your DTP application in order for the Spire 
CXP8000 color server to be able to apply the bleed options.
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Creep

Creep is a common problem in saddle-stitch jobs When signatures are 
inserted inside one another, the signatures inserted last are the farthest 
from the center of the booklet. As a result, the outer edges of the inner 
pages creep past the outer pages.

The Creep parameter uses the following terminology: 

• Creep in specifies the amount of movement towards the spine applied 
to the center two pages and their backs (in other words the pages that 
require the most amount of compensation). 
An ever-decreasing amount of movement is automatically applied 
from the center quartet of pages back towards the outside four pages of 
the job (in other words every quartet of pages is moved by an amount 
less than the previous quartet). 

Note:  It is recommended that you use a border around all documents when you 
use creep.

Note:  The outside two pages and their backs are not moved (the value 0.0 is 
used). 
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• Creep out is used when you find that the page images are too close to 
the spine. This problem can be resolved by selecting a value for Creep 
out. This will move all the pages of the job further out towards the 
outside margin (away from the spine) by the specified amount. This 
movement takes place before the Creep in value is applied. 

To set the creep options:

1. In the Creep in area, select Auto to automatically set the Creep in based 
on paper stock weight
Or:
Type the desired amount for Creep in.

2. In the Creep out area, type the desired amount.

Imposition Templates
There are three types of templates you can use in the Spire CXP8000 color 
server:

• Collating templates, see Collating Templates on page 239

• Predefined imposition templates, see Spire CXP8000 Color Server 
Predefined Imposition Templates on page 239

• User defined imposition templates, see User Defined Imposition 
Templates on page 245

Note:  Units of measurement (mm or inches) are set in the Settings window, 
see Localization on page 409.
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Collating Templates
The step & repeat method contains a subset of templates called collating 
templates. Collating templates are used when jobs with different page 
images are used to fill up a larger sheet. Unlike regular step & repeat, where 
the same images are printed several times on a sheet, with collating 
templates, several images are printed on the same sheet. Collated templates 
are used for one-time job print runs and are of the form P1-P2-P3, 
indicating the job pages to be printed on a sheet.

Spire CXP8000 Color Server Predefined Imposition 
Templates
The Spire CXP8000 color server uses the following predefined imposition 
templates.  

Note:  DUP refers to Duplex and SIM refers to Simplex.

Table 9: Predefined imposition templates

Step & Repeat Cut & Stack Saddle Stitch Perfect Bound

1×1 DUP HTH 1×1 DUP HTH 1×2 HTT 1×2 HTT

1×1 DUP HTH Rotated 1×1 DUP HTH Rotated 1×2 HTT Rotated 1×2 HTT Rotated

1×1 DUP HTT 1×1 DUP HTT 2×1 2×1

1×1 DUP HTT Rotated 1×1 DUP HTT Rotated 2×1 Rotated 2×1 Rotated

1×1 SIM 1×1 SIM 2×2 2×2

1×1 SIM Rotated 1×1 SIM Rotated 2×2 HTT 2×2 HTT

1×2 DUP HTH 1×2 DUP HTH 2×2 Rotated 2×2 Rotated

1×2 DUP HTH Rotated 1×2 DUP HTH Rotated 2×2 HTT Rotated 2×2 HTT Rotated

1×2 DUP HTT 1×2 DUP HTT 4×2 4×2

1×2 DUP HTT Rotated 1×2 DUP HTT Rotated 4×2 Rotated 4×2 Rotated

1×2 SIM 1×2 SIM

1×2 SIM Rotated 1×2 SIM Rotated
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1×2 North South 1×2 North South

1×3 DUP HTH 1×3 DUP HTH

1×3 DUP HTH Rotated 1×3 DUP HTH Rotated

1×3 DUP HTT 1×3 DUP HTT

1×3 DUP HTT Rotated 1×3 DUP HTT Rotated

1×3 SIM 1×3 SIM

1×3 SIM Rotated 1×3 SIM Rotated

2×1 DUP HTH 2×1 DUP HTH

2×1 DUP HTH Rotated 2×1 DUP HTH Rotated

2×1 DUP HTT 2×1 DUP HTT

2×1 DUP HTT Rotated 2×1 DUP HTT Rotated

2×1 SIM 2×1 SIM

2×1 SIM Rotated 2×1 SIM Rotated

2×1 North South 2×1 North South

2×2 DUP HTH 2×2 DUP HTH

2×2 DUP HTH Rotated 2×2 DUP HTH Rotated

2×2 DUP HTT 2×2 DUP HTT

2×2 DUP HTT Rotated 2×2 DUP HTT Rotated

2×2 SIM 2×2 SIM

2×2 SIM Rotated 2×2 SIM Rotated

2×4 SIM 2×4 SIM

2×4 SIM Rotated 2×4 SIM Rotated

Table 9: Predefined imposition templates

Step & Repeat Cut & Stack Saddle Stitch Perfect Bound
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2×4 DUP 2×4 DUP

2×4 DUP Rotated 2×4 DUP Rotated

2×5 DUP HTH 2×5 DUP HTH

2×5 DUP HTH Rotated 2×5 DUP HTH Rotated

2×5 DUP HTT 2×5 DUP HTT

2×5 DUP HTT Rotated 2×5 DUP HTT Rotated

2×5 SIM 2×5 SIM

2×5 SIM Rotated 2×5 SIM Rotated

3×1 DUP HTH 3×1 DUP HTH

3×1 DUP HTH Rotated 3×1 DUP HTH Rotated

3×1 DUP HTT 3×1 DUP HTT

3×1 DUP HTT Rotated 3×1 DUP HTT Rotated

3×1 SIM 3×1 SIM

3×1 SIM Rotated 3×1 SIM Rotated

3v2 DUP HTH 3×2 DUP HTH

3×2 DUP HTH Rotated 3×2 DUP HTH Rotated

3×2 DUP HTT 3×2 DUP HTT

3×2 DUP HTT Rotated 3×2 DUP HTT Rotated

3×2 SIM 3×2 SIM

3×2 SIM Rotated 3×2 SIM Rotated

3×3 SIM 3×3 SIM

3×3 SIM Rotated 3×3 SIM Rotated

Table 9: Predefined imposition templates

Step & Repeat Cut & Stack Saddle Stitch Perfect Bound
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3×3 DUP 3×3 DUP

3×3 DUP Rotated 3×3 DUP Rotated

3×4 DUP HTH 3×4 DUP HTH

3×4 DUP HTH Rotated 3×4 DUP HTH Rotated

3×4 DUP HTT 3×4 DUP HTT

3×4 DUP HTT Rotated 3×4 DUP HTT Rotated

3×4 SIM 3×4 SIM

3×4 SIM Rotated 3×4 SIM Rotated

3×8 DUP HTH 3×8 DUP HTH

3×8 DUP HTH Rotated 3×8 DUP HTH Rotated

3×8 DUP HTT 3×8 DUP HTT

3×8 DUP HTT Rotated 3×8 DUP HTT Rotated

3×8 SIM 3×8 SIM

3×8 SIM Rotated 3×8 SIM Rotated

3×9 SIM 3×9 SIM

3×9 SIM Rotated 3×9 SIM Rotated

3×9 DUP 3×9 DUP

3×9 DUP Rotated 3×9 DUP Rotated

4×2 DUP HTH 4×2 DUP HTH

4×2 DUP HTH Rotated 4×2 DUP HTH Rotated

4×2 DUP HTT 4×2 DUP HTT

4×2 DUP HTT Rotated 4×2 DUP HTT Rotated

Table 9: Predefined imposition templates

Step & Repeat Cut & Stack Saddle Stitch Perfect Bound
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4×2 SIM 4×2 SIM

4×2 SIM Rotated 4×2 SIM Rotated

4×3 DUP HTH 4×3 DUP HTH

4×3 DUP HTH Rotated 4×3 DUP HTH Rotated

4×3 DUP HTT 4×3 DUP HTT

4×3 DUP HTT Rotated 4×3 DUP HTT Rotated

4×3 SIM 4×3 SIM

4×3 SIM Rotated 4×3 SIM Rotated

4×4 HTH DUP 4v4 HTH DUP

4×4 DUP HTH Rotated 4×4 DUP HTH Rotated

4×4 HTT DUP 4×4 HTT DUP

4×4 DUP HTT Rotated 4×4 DUP HTT Rotated

4×4 SIM 4×4 SIM

4×4 SIM Rotated 4x4 SIM Rotated

4×5 SIM 4×5 SIM

4×5 SIM Rotated 4×5 SIM Rotated

4×5 DUP 4×5 DUP

4×5 DUP Rotated 4×5 DUP Rotated

5×2 DUP HTH 5×2 DUP HTH

5×2 DUP HTH Rotated 5×2 DUP HTH Rotated

5×2 DUP HTT 5×2 DUP HTT

5x2 DUP HTT Rotated 5×2 DUP HTT Rotated

Table 9: Predefined imposition templates

Step & Repeat Cut & Stack Saddle Stitch Perfect Bound
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5×2 SIM 5×2 SIM

5×2 SIM Rotated 5×2 SIM Rotated

5×4 SIM 5×4 SIM

5×4 SIM Rotated 5×4 SIM Rotated

5×4 DUP 5×4 DUP

5×4 DUP Rotated 5×4 DUP Rotated

5×5 DUP HTH 5×5 DUP HTH

5×5 DUP HTH Rotated 5×5 DUP HTH Rotated

5×5 DUP HTT 5×5 DUP HTT

5×5 DUP HTT Rotated 5×5 DUP HTT Rotated

5×5 SIM 5×5 SIM

5×5 SIM Rotated 5×5 SIM Rotated

5×6 SIM 5×6 SIM

5×6 SIM Rotated 5×6 SIM Rotated

5×6 DUP 5×6 DUP

5×6 DUP Rotated 5×6 DUP Rotated

6×5 SIM 6×5 SIM

6×5 SIM Rotated 6×5 SIM Rotated

6×5 DUP 6×5 DUP

6×5 DUP Rotated 6×5 DUP Rotated

8×3 DUP HTH 8×3 DUP HTH

8×3 DUP HTH Rotated 8×3 DUP HTH Rotated

Table 9: Predefined imposition templates

Step & Repeat Cut & Stack Saddle Stitch Perfect Bound
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User Defined Imposition Templates
The Imposition Template area enables you to import and manage user 
defined imposition templates that were created in a stand-alone 
application—for example, Ultimate inSpire. 

To import a user defined imposition template:

1. On the toolbar, click the Resource Center button. 

8×3 DUP HTT 8×3 DUP HTT

8×3 DUP HTT Rotated 8×3 DUP HTT Rotated

8×3 SIM 8×3 SIM

8×3 SIM Rotated 8×3 SIM Rotated

9×3 SIM 9×3 SIM

9×3 SIM Rotated 9×3 SIM Rotated

9×3 DUP 9×3 DUP

9×3 DUP Rotated 9×3 DUP Rotated

Table 9: Predefined imposition templates

Step & Repeat Cut & Stack Saddle Stitch Perfect Bound
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2. In the Resource list, select Imposition Templates.

3. Click Import.

4. In the Open dialog box, locate the user defined template you want to 
import. 
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5. If you want to lock the template, select the lock job ticket check box.  

6. Click Import.

To rename a user defined imposition template:

1. On the toolbar, click the Resource Center button. 

2. In the Resource list, select Imposition Templates.

3.  Select a user defined imposition template from the list, and click 
Rename.

4. Type a new name for the user defined imposition template.

5. Click OK.

The renamed user defined imposition template appears in the 
imposition template list.

To delete a user defined imposition template:

1. On the toolbar, click the Resource Center button. 

2. In the Resource list, select Imposition Templates.

3.  Select a user defined imposition template from the list, and click 
Remove.

Editing Imposition Jobs
The Job Editor enables you to inspect the layout of your imposed RTP job. 
You can move pages within a job, delete pages in a job, insert pages of 
another job, or merge two entire jobs.

Note:  If the template is locked, you cannot set imposition parameters in the 
Job Parameters window.

Note:  You can use Adobe Acrobat to edit pre-Rip jobs. For post-Rip jobs, you can 
only edit RTP files. If you make changes to a job in the Job Editor and the job 
requires re-RIPing, the job will fail because there is no original PDL file to re-RIP.
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When you insert or replace pages, the new page should have the same size 
and orientation attributes as the old page.

To replace a page that is rotated 180°, rotate the page in the DTP 
application and resubmit it to the Spire CXP8000 color server. You can use 
Adobe Acrobat to rotate PDL files. 

High-Resolution Workflow
Working with high-resolution files during the design and page layout 
process can often times be long and inefficient. Processing and 
manipulating large files and graphics can be very time consuming. To 
speed up production, it is common to work with low-resolution files until 
the RIPing stage.

The Spire CXP8000 color server provides Creo APR (Automatic Picture 
Replacement) and supports Open Prepress Interface (OPI) image 
replacement workflows for replacing low-resolution files with high-
resolution files during the RIP. 

For more information about the Job Editor, see Editing an RTP Job on page 209.

High-Resolution Image File, 5.23 MB Low-Resolution Image File, 306 KB
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Creo APR
Creo APR is an image replacement method for PostScript files. Creo APR 
is a standardized set of file instructions that specify how an external high-
resolution image is placed in a PostScript file as it goes to RIP. The 
instructions specify the type, size, position, rotation, cropping and 
location of the high-resolution images themselves. 

When you send your PostScript file to be processed, the Spire CXP8000 
color server checks it for Creo APR instructions. It then searches for the 
external high-resolution file, performs the specified image replacement 
and RIPs the PostScript file.

Setting APR Options
1. In the Job Parameters window, click the Services tab, and then select 

the APR parameter.
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2. In the APR options area, select one of the following options:

• Print with high res: Use this option to replace low-resolution 
images in your job with high-resolution images that are located in 
a specified APR path.

• Print with low res: Use this option to print the job with the 
existing low-resolution images—for example, for proofing 
purposes.

3. In the Use APR mask from area, select one of the following options:

• PostScript image: Use this option to use the masking data 
contained in the low-resolution image file.

• High res: Use this option to use the masking data contained in the 
high-resolution image file.

• Both: Use this option to use the masking data that is common in 
both high-resolution and low-resolution image files—for example, 
if the images defined by the two sets of masking data overlap, the 
overlapping area is RIPed.

Setting a High-Resolution Path
There are two default paths in which the Spire CXP8000 color server 
searches for high-resolution images:

• Search in the input folder: The Spire CXP8000 color server first 
searches for high-resolution images in the same folder as the PDL file. 

• D:\Shared\High Res: If you want to save your high-resolution files in 
this folder, copy the files to D:\Shared\High Res. 

You can also add a new high-resolution path, and then edit, or delete the 
path.

Paths other than the default paths are defined on a per-job basis, or set in 
the virtual printer. You can specify paths on local hard drives, CD-ROM 
drives, and the floppy drive connected to the Spire CXP8000 color server. 
You can also specify paths on remote clients or file servers.

Note:  If the masking data in the low-resolution image file defines a 
completely different part of an image than the masking data in the 
high-resolution file, no masking data is used.
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To add a high-resolution path:

1. Under the APR path box, click Add.

The HiResPath dialog box appears.

1. Click Add.

The Open dialog box appears.
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2. Locate your high-resolution images, and then click Select.

The new path is displayed in the HiResPath dialog box.

3. To promote or demote a selected APR path, use the arrow buttons.

To modify a high-resolution path:

1. In the HiResPath dialog box, select the path you want to modify.

2. Click Edit.

The Open dialog box appears.

3. Locate your high-resolution images, and then click Select.

The new path is displayed in the HiResPath dialog box.

To delete a high-resolution path:

1. In the HiResPath dialog box, select the path you want to delete.

2. Click Remove.

The selected path is deleted.

OPI 
Like Creo APR, OPI is a standardized set of file instructions that specify 
how an external high-resolution image is placed in a PostScript file as it 
goes to RIP. The instructions specify the type, size, position, rotation, 
cropping and location of the high-resolution images themselves. 

When you send your PostScript file to be processed, the Spire CXP8000 
color server checks it for OPI instructions. It then searches for the external 
high-resolution file, performs the specified image replacement and RIPs 
the PostScript file.

Many OPI systems use remote storage of high-resolution files. The Spire 
CXP8000 color server supports the storage and replacement of high-
resolution OPI files internally. However, PDL files from some DTP 
applications (such as QuarkXPress) may contain these instructions 
(“comments”) by default, although the high-resolution files are 
unavailable and have been embedded in the job. In this case, the job will 

Note:  The order in which the APR paths are listed is the order in which the 
Spire CXP8000 color server searches for the high-resolution images.
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not be processed and an error message will appear. Therefore, to ensure 
continuous printing, the Spire CXP8000 color server OPI image 
replacement is unavailable by default.

To select OPI support:

1. From the Tools menu, select Settings.

The Settings window appears.

2. Under Preferences, select General Defaults.

3. In the OPI area, select Enable OPI Spire Support.

Note:  When the Enable OPI Spire Support option is selected, the 
Support Helios Server check box is automatically selected by default. If you 
do not want Helios server support, clear this check box.
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Creo APR and OPI File Formats
Creo APR and OPI function identically on the Spire CXP8000 color server. 
Creo APR low-resolution files have an *.eps extension in Windows and an 
*.e extension on the Macintosh, while OPI low-resolution files have a *.lay 
extension. The Creo APR and OPI workflows support Creo Continuous 
Tone, EPSF, Jpeg, PDF, DCS1, DCS2 and TIFF high-resolution file 
formats. You can use either the Creo APR or OPI workflow, depending on 
your high-resolution file type.

Preparing to Print Using Creo APR or OPI
1. Create low-resolution files from high-resolution files.

2. Export each image file as a low-resolution *.e file—for example, a file 
called duck is exported as duck.e. 
OPI images can be created in other applications or can be provided by 
a print service bureau. Make sure that you have created or obtained 
the desired image files.

3. When you design the document in a DTP application, use low-
resolution files.

4. Perform detailed graphic work on the original high-resolution file. 
Only use the low-resolution file for positioning, rotating, scaling and 
cropping. 

Note:  You can use the PS Image Exporter Plug-In in Adobe Photoshop to 
create Photoshop Image (APR low-resolution) files. You can either install the 
PS Image Exporter Plug-In from the Spire CXP8000 color server 
Documentation and Utilities CD-ROM, or download it from the Creo website 
at https://ecentral.creo.com/ecentral/self_support/downloads.asp.

Notes:

• A PostScript image (*.e) file is a low-resolution preview of the original 
high-resolution file. It contains preview information saved at 72dpi in 
black and white or color. Also, it contains pointers to the location of the 
high-resolution Image.

• APR low-resolution files have a. “*.e” extension on the Macintosh and 
an “*.eps” extension in Windows. OPI low-resolution files have a 
“*.lay” extension. 

Note:  Once you create the low-resolution file, do not change the name of 
the high-resolution file. This is the file name for which the Spire CXP8000 
color server searches.

https://ecentral.creo.com/ecentral/self_support/downloads.asp
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5. Place the high-resolution files in a defined path on the Spire CXP8000 
color server. This Spire CXP8000 color server looks for this path when 
it RIPs your jobs. Define the high-resolution path through the Job 
Parameters window for each job.

Printing with Creo APR or OPI
If your high-resolution files are located in the Spire CXP8000 color server 
default folder (D:\Shared\HighRes), you can print APR or OPI jobs 
without adjusting APR settings. 

Perform the following steps:

1. Print, download, or import the job from the client workstation to the 
Spire CXP8000 color server Storage window.

The job is processed according to the settings of the selected virtual 
printer using APR or OPI high-resolution files.

2. Double-click the job in the Spire CXP8000 color server workspace.

3. Select the Print Quality tab in the Job Parameters window.

4. Adjust the job parameters.

5. Set other high-resolution job parameters as desired. 

Notes:

• The Spire CXP8000 color server default HiRes folder used for APR and 
OPI is D:\Shared\HiRes.

• Paths other than the default path are defined on a per-job basis. You 
can define the APR path to any connected server or disk.

Important:  OPI support is unavailable by default. If you would like to select 
the Spire OPI support, see To select OPI support: on page 253.

Note:  If your high-resolution files are not located in the Spire CXP8000 
color server default folder, specify the APR path(s), see To add a high-
resolution path: on page 251.

Note:  If the masking data in the PS Image file defines a completely different 
part of an image than the masking data in the high-resolution file, no 
masking data is used. 
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6. Click Submit. 

The job is processed on the Spire CXP8000 color server and sent to the 
Xerox DocuColor 8000 Digital Press for printing.

Sample Job: Printing a Brochure Using the Creo APR Workflow
In this example, you can use Creo APR to print a brochure that contains a 
high-resolution file.

Brochure

The picture used in the sample brochure is a high-resolution file called 
milkmaid. In this example, it is assumed that you already created the low-
resolution file milkmaid.e and that your brochure has already been 
designed in a DTP application using milkmaid.e. 

Note:  On the Spire CXP8000 color server, the APR workflow is functionally 
identical to the OPI workflow, so while the high-resolution image used in this 
example has a *.e extension, if it was an OPI image, it would have a alternative 
extension, such as *.lay.
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To print a brochure using the APR workflow:

1. The Spire CXP8000 color server first searches for high-resolution 
images in the same folder as the PDL file. 
Or:
Place your high-resolution file milkmaid in the path: 
D:\Shared\High Res.

2. Print or import the brochure job from your client workstation to the 
Spire CXP8000 color server.

The job is processed on the Spire CXP8000 color server and then sent 
to the Xerox DocuColor 8000 Digital Press for printing.

PDF Workflow
When you print PDF jobs with repeated elements, you can decrease 
processing time significantly if you apply the PDF workflow.

The PDF workflow caches the repeated elements in the PDF once, and 
reuses them as many times as needed without repeated processing.

To select PDF optimization:

In the Job Parameters window, click the Services tab, and then select 
the PDF optimization parameter.
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3. In the PDF optimization options area, select Yes.

In addition, you need to use the Adobe Acrobat Distiller application to 
distill the PostScript file. Distilling the file ensures that the repeated 
elements will be marked as repeated in the PDF file.

If you do not have the Adobe Acrobat Distiller application installed on 
your client workstation, you may use the Adobe Acrobat Distiller 5.0 
application located on the Spire CXP8000 color server.

To distill a PostScript file on the Spire CXP8000 color server:

1. In your client workstation, copy the desired PostScript file.

2. Locate the Spire CXP8000 color server on the network, and paste the 
file to D:\Shared.

3. On the Spire CXP8000 color server station, click the Start button and 
select Programs>Acrobat Distiller.

Important:  Verify that in your Acrobat Distiller settings, Optimize for Fast 
Web View is selected (in Acrobat 4.0 the corresponding option is Optimize 
PDF).
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4. From the Settings menu, select Job Options.

5. In the General tab, verify that Optimize for Fast Web View is selected 
and click Cancel. If this option is not selected, select the Optimize for 
Fast Web View check box, and click OK.
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6. From the File menu, select Open.

The Acrobat Distiller - Open PostScript file dialog box appears.

7. Locate the desired PostScript file, and then click Open.

The Acrobat Distiller - Specify PDF File Name dialog box appears. 

8. The default name is the PostScript file name. You can change it in the 
File name box.

9. Verify that the file is saved in D:\Shared.

10. Click Save.

Your file is distilled and a PDF file is created.

11. In the Spire CXP8000 color server application, from the Job menu, 
select Import.

You can import the PDF file for printing.

Export as PDF2Go
PDF2Go is a port through which you can export RTP and PDL files, and 
convert them to a PDF file during export.

The Spire CXP8000 color server is capable of exporting jobs that are 
standard PDF files, both before and after processing. For an exported RTP 
job, the PDF file includes the rasterized data of the job.

The operation converts the RTP information to raster files that can be 
encapsulated in a PDF format. This process ensures that the file can be 
processed and printed on any PDF printer. 

Tip:  You can create a shortcut to the Acrobat Distiller on the Spire CXP8000 
color server desktop. This shortcut can be used to drag files onto the Acrobat 
Distiller for quick distilling. To create a shortcut, click the Start button on your 
Windows desktop, and follow the path Programs>Acrobat Distiller. Right-
click Acrobat Distiller and follow the path Send To>Desktop (create 
shortcut).

Note:  Except for RTP jobs that were originally VI jobs, you can export every type 
of file.
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While exporting as PDF2Go, a running bullet starts to move from right to 
left in the bottom arrow adjacent to the server-printer animation.

To export as PDF2Go:

1. Right-click a file in the Storage window, and from the menu select 
Export PDF2Go.

2. Select the Print Optimized option to generate a high-resolution PDF 
file in 300dpi. 

The Screen Optimized option (default) generates a low-resolution 
PDF file in 72 dpi. 

3. Click OK.

Tip:  Use the Screen Optimized option when you want to generate a light PDF 
file—for example, a file that you can send as a proof by e-mail.
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4. Locate the folder in which to save the file, and then click Export.

The file is saved as a PDF file under the job's name in the selected 
location.

Note:  When you export PDL files as PDF, the file is converted to PDF using 
the Acrobat distiller. 
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Page Exceptions 
Page exceptions are used when you want to use different paper sets for 
special exceptions within a job or add inserts (interleaves).This feature 
uses the following terminology:

• Exceptions are special pages within a job for which you want to assign 
different paper stock. For example, you can choose to assign a different 
paper stock for each chapter within a book. 

• Inserts are blank pages of a selected paper stock that are assigned to a 
job after a specified number of pages. For example, you can choose to 
add blank pages between sections within a brochure. 

The Exceptions Tab

The Exceptions tab enables you to add and delete page exceptions and 
inserts. 

For more information about paper sets, see The Paper Stock Tab on 
page 166.

Note:  You also use the Exceptions tab to map paper sets for dynamic page 
exceptions.
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Managing Exceptions
You can add and delete exceptions in the Exceptions tab.

To add exceptions to a job:

1. In the Exception area, click the Add button.

2. In the From and To boxes, type the desired page range for the 
exception. For example, if you want to print a page divider on heavy 
paper, in the From box, type 15 and in the To box, type 15. 

3. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

Fo

For more information about the dynamic page exceptions workflow, see 
Dynamic Page Exceptions on page 275.

Exception
area

For information about adding a paper set, see Managing Paper Sets on 
page 167.

Note:  The default paper stock properties are those specified for the job.
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4. In the Tray list, select the desired tray: 

• Tray 1: Load the specific stock in this tray.

• Tray 2: Load the specific stock in this tray.

• Tray 3: Load the specific stock in this tray.

• Tray 4: Load the specific stock in this tray.

• Auto: Any tray with the specific paper stock will be used.

5. To set image position options:

a. Click Advanced.

b. Clear the Same as job check box. 

c. To shift an image, follow one of these steps:

• Click the arrows to shift the image on both sides.

• Type a value in the Rear and Lead boxes.

d. To set the values back to 0.0, click Center Image.

e. Click Save.

6. Click Apply.

The exception is added to the Exception area.

To delete an exception:

1. In the Exception area, select the desired exception.

2. Click the Remove button.

3. In the message that appears, click Yes.
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Managing Inserts

To add an insert:

1. In the Insert area, click the Add button.

2. In the After page box, type the number that will precede the insert. 

3. In the Quantity box, type the number of inserts that you want.

4. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

Insert area

Note:  The default paper stock properties are those specified for the job.

For information about adding a paper set, see Managing Paper Sets on 
page 167.
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5. In the Tray list, select the desired tray: 

• Tray 1:The specific paper stock should be loaded in this tray.

• Tray 2: The specific paper stock should be loaded in this tray.

• Tray 3: Load the specific stock in this tray.

• Tray 4: Load the specific stock in this tray.

• Auto: Any tray with the specific paper stock will be used. 

6. Click Apply.

The insert is added to the Insert area.

To remove an insert:

1. In the Insert area, select the desired insert.

2. Click the Remove button.

3. In the message that appears, click Yes.

Using Page Exception Workflows

Setting Exceptions for Imposed Jobs
You can set different paper sets for special exceptions within a job and also 
add inserts (interleaves) in imposed jobs. You set these exceptions and 
inserts in the Exceptions tab.

If the selected imposition method is Saddle Stitch or Perfect Bound, the 
exceptions are handled in the imposed sheet level (and not on a page level).

You cannot set exceptions or inserts if the selected imposition method is 
Step & Repeat and it’s sub-option Cut & Stack.

Notes:

• For the Step & Repeat imposition method, exceptions are handled on a 
page level (same as for non-imposed jobs).

• An imposed sheet contains the multiple images that are all printed on the 
same physical sheet.
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Printing on Tabs
The Spire CXP8000 color server supports the option to print tabs for both 
regular page exceptions and dynamic page exceptions workflows. This 
section contains a description of the setup steps you need to perform to 
print on tabbed stock using the regular page exceptions workflow.

File Preparation

This example describes how to print a document using Xerox 5 TAB 
(multipurpose) stock. The tabs are printed on both sides (duplex). The 
text pages were designed in QuarkXPress and the tabs were designed in 
Microsoft Word. 

Xerox DocuColor 8000 Digital Press Setup

In this example, you can print the PDF file on the following types of stock:

• Text pages on US Letter (8.5 × 11 inches)

• Tabs on tab stock (9 × 11 inches)

Color Calibration

Use the US Letter paper stock to perform calibration, and then you can use 
this paper stock for the entire job.

For information about dynamic page exceptions, see Dynamic Page Exceptions 
on page 275.

Note:  The Xerox DocuColor 8000 Digital Press also support the option to print 
tabs for both regular page exceptions and dynamic page exceptions workflows.

Note:  You can modify this procedure to fit your specific tab requirements.
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Loading the Paper Stock

Follow these steps when you load the paper stock: 

• Load the paper as Short Edge Feed for all stocks because the tabbed 
stock is printed on both sides (duplex), and requires straight edges on 
both right and left sides. Load the stock with the tabs pointing to the 
rear end of the tray.

• Although the text and tab media can be different weights, on the tray 
controls you should set all media weight to 106-135gsm to avoid the 
automatic image quality adjustment that occurs when printing on 
different stock weight ranges.

To load the paper stock:

1. Load the letter paper stock in Tray 1.

2. Load the tabbed stock:

a. Place the tabs in Tray 2 in forward collated order—for example, 
Tab 1 is the top tab when the tab sheets are loaded into the printer.

b. Make sure that the stock is loaded as SEF.

c. Select Non-Standard on the left hand side of the tray controls.
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This example uses 9 × 11 custom size tabs (SEF). Use the tab stock 
Xerox P/N #3R4405 - in forward order for the tab pages. The job prints 
face up. 

Access Panel

You program the custom size for any job through the Xerox DocuColor 
8000 Digital Press Access Panel.

1. On the Access Panel, press the Access button and enter the password 
11111.

2. Navigate to Tools Pathway>Non-Standard Paper Size.

3. Select Tray #2, X=11, Y=9.

4. Exit all the windows and return to the main menu.

Notes:

• It is essential that you load the tab stock in Tray 2.This allows for a 
straight path from this tray onto the imaging belt. You can load other 
types of stock in any other tray without affecting print production.

• Tabs are duplex printed, which requires that the tab stock be positioned 
so that both the left and right sides of the media are straight sides going 
into the engine.

The tab on

the left hand

side is the top

tab.

Custom

button
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Creating Paper Sets

In the Printer Monitor window, you can view the paper sets that are loaded 
in the paper tray. 

To create paper sets:

1. On the toolbar, click the Resource Center button. 

2. In the Resource list, select Paper Sets.

3. Click Add.

The Paper Set Properties dialog box appears.

4. Set the parameters for the Text stock. 

5. Click OK.

6. Click Add and set the parameters for the Tab stock. 

For more information about the Printer Monitor window, see The Printer 
Monitor on page 23.
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7. Click OK. 

Icons in the Paper Sets area provide information about the defined 
media that is available and the print direction of the media.

Note:  If the icon for the Tab and Text media does not reflect the print 
direction you set, you need to review your paper set definitions.
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Printing the Job

The regular (manual) page exception workflow is good for single jobs.

To set the job parameters for a job with two media trays:

1. In the Job Parameters window, click the Print Settings tab and set the 
following parameters:

• Print Method: Duplex head to head

• Delivery: Face Up

• Rotate 180: Yes

2. On the Paper Stock tab, set the Paper set name to Text.
Or:
Set the following parameters:

• Paper set name: Undefined

• Paper size: SEF Letter

• Weight: 106-135 gsm

3. On the Exceptions tab, click Add and use Table 10 to add page 
exceptions:

Important:  Before you start this workflow, open the PDF file and note which 
pages are the tab pages.

Table 10: Sample Page Exceptions

Pages Use Paper Set Tray

5 -6 Tab Auto

19-20 Tab Auto

31-32 Tab Auto

59-60 Tab Auto

103-104 Tab Auto

Note:  The tabs are printed on both sides.
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4. Set any other job parameters as desired, and then click Submit.

Further Information

The following list provides useful Web sites about printing tabs and 
templates:

• Templates: Download the Xerox templates from the following Web 
site:
http://www.xerox.com/go/xrx/template/
Promotions.jsp?view=MP6&active=active&promoID=Laser_Printer_
Template_tabs&Xcntry=USA&Xlang=en_US

• Design Hints: Some good design hints for printing tabs are available 
on the following Web site:
http://www.xerox.com/go/xrx/template/
Promotions.jsp?view=MP6&active=Active&promoID=Printer_Templ
ate_Using_Graphics&Xcntry=USA&Xlang=en_US

• The Speciality Media Gudie can be downloaded from the following 
Web site: http://www.xerox.com/

http://www.xerox.com/go/xrx/template/Promotions.jsp?view=MP6&active=Active&promoID=Printer_Template_Using_Graphics&Xcntry=USA&Xlang=en_US
http://www.xerox.com/go/xrx/template/Promotions.jsp?view=MP6&active=active&promoID=Laser_Printer_Template_tabs&Xcntry=USA&Xlang=en_US
http://www.xerox-techsupport.com/dc2000/DC6060/DC6060_home.htm
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Dynamic Page Exceptions
Dynamic page exceptions are page exceptions or inserts that you want to 
include within a file, mainly VI jobs or a very large PostScript file.

Standard PostScript setpagedevice commands that specify different paper 
types are embedded into the incoming files and enable you to print 
complex jobs of varying paper size, stocks, and paperweight. These 
commands indicate that the printer must switch media during the printing 
of a job. When a job is RIPed, the Spire CXP8000 color server identifies the 
dynamic page exception commands and maps them to the selected paper 
sets. The printer then uses the desired paper sets for the job.

The Spire CXP8000 color server supports dynamic page exceptions for the 
following file formats:

• PostScript

• Variable Print Specification

• VIPP

• PDF

Setting the Spire CXP8000 Color Server for Dynamic Page Exceptions
To set up the job flow for dynamic page exceptions you need to:

1. Create a file with embedded setpagedevice commands on your client 
workstation.

2. Select Resource Center>Paper Sets and create the paper sets that you 
need to print your file. 

3. Create a dedicated virtual printer that supports dynamic page 
exception commands, and then map specific paper sets in the 
Exceptions tab. 

For more information about adding dynamic page exception commands, 
see page 276 - page 284.

For more information about adding a new virtual printer and mapping 
specific paper sets, see Creating a Dedicated Virtual Printer on page 282.
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4. Import the file into the Spire CXP8000 color server via the dedicated 
virtual printer, and submit the job for printing.

When the job is RIPed, the dynamic page exception commands are 
identified and mapped to the selected paper sets. The desired paper 
sets are used when the job is printed.

Adding Dynamic Page Exceptions in PostScript and Variable Print 
Specification Formats

The Spire CXP8000 color server accepts Adobe “red book” command keys 
to dynamically change the media at a page level. Dynamic page exceptions 
are set through the standard PostScript setpagedevice command and 
embedded in the PostScript file. In the setpagedevice command, the media 
selection category honors four keys:

• /MediaType - paper set name (string)

• /MediaColor - paper set color (string)

• /MediaWeight - paper set weight range (number)

• /MediaPosition - tray number (integer)

Notes:

• If a job is printed using a dynamic page exceptions virtual printer, the 
Imposition tab in the Job Parameters window is unavailable.

• Once you import your file via the dedicated virtual printer, you can 
perform a preflight check before the job is sent to print, see Preflight 
Check on page 368.
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The following example shows the MediaColor key:

%%

<< /MediaColor (red) >> setpagedevice

612 0 translate

90 rotate

/Times-Roman ISOfindfont 12 scalefont

90 203 moveto

gsave

0 0 0 SetRGB

(ASSET ALLOCATION SUMMARY) show

grestore

showpage

%%

<< /MediaColor (white) >> setpagedevice

%%

%%

Adding Dynamic Page Exceptions in PDF
There are three XRX comments that are defined in the Xerox Manual for 
Job Ticket Programming Guide and that are involved in defining dynamic 
page exceptions. The Spire CXP8000 color server reads these three 
comments.

The comments are XRXbegin and XRXend, which encapsulate the XRX 
block, and XRXpageExceptions, which defines the page exceptions 
attributes. 

• %XRXbegin: <ureal> 

This comment indicates the beginning of the XRX comment block. 
You can write any number as a value. The Spire CXP8000 color server 
checks the comment’s existence and not the value. 

Example:%XRXbegin: 100.0300 
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• %XRXend 

This comment indicates the end of the XRX comments block. 

• %XRXpageExceptions: <cardinal> <cardinal> <cardinal> <cardinal> 

{<word>/<multiword>} <word> {<word>/<multiword>} <cardinal> 
<cardinal>

This comment indicates that specified pages will be printed on a media 
identified by the accompanying record values. You may include 
multiple page exception records in one job ticket and the values may be 
the same as the main stock. 

• Range: The first <cardinal> and the second <cardinal> denote the 
beginning and the ending page number of the exception range. The 
first <cardinal> must be less than or equal to the second <cardinal>. 

• Size (not supported): The third <cardinal> and the fourth <cardinal> 
specify the x dimension value and the y dimension value, respectively, 
of the page exception media. The values must be in millimeters. 

• Color: The first {<word>/<multiword>} specifies the color of the page 
exception media. The value can be one of the standard defined colors 
or a custom “user–defined” color. The entered value matches the 
paper stock color for the Spire CXP8000 color server. 

• Opaque (not supported): The second <word> specifies the opaqueness 
of the page exception media. Valid values are: transparency and 
opaque. 

• Finish (not supported): The third {<word>/<multiword>} specifies 
the preprocessed finish of the page exception media. The value can be 
one of the standard defined finishes or a custom “user–defined” finish. 

• Holes (not supported): The fifth <cardinal> specifies the inline hole 
count. This is the number of holes in a predrilled page with positioning 
and alignment typical of a punch binding pattern. Since allowable 

Note:  Exception ranges can’t overlap if the PDF contains multiple 
%XRXpageExceptions: comments.

Note:  The Spire CXP8000 color server doesn’t read these numbers.
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values are either 0, to indicate no holes, or 3, this is not intended to 
identify a media with an arbitrary number of holes in arbitrary 
locations, such as a printed novelty application. 

• Ordered count (not supported): The sixth <cardinal> specifies the 
ordered count. This is the number of possible media instances, in an 
identifiable and sequenced collection of media, that will be repeated 
within the insert. For example, this value is the number of tab 
positions when tabs are to be inserted. Ordered count can be any 
integer in the range of 0 (zero), to indicate no ordered count, to 100. 

Example

%XRXbegin: 002.00.00

%XRXdocumentPaperColors: white

%XRXpageExceptions: 7 8 216 279 red opaque acmep_ing 0 12 75

%XRXpageExceptions: 35 36 216 279 red opaque acmep_ing 0 12 75

%XRXpageExceptions: 41 42 216 279 blue opaque acmep_ing 0 12 75

%XRXpageExceptions: 49 50 216 279 red opaque acmep_ing 012 75

%XRXpageExceptions: 59 60 216 279 red opaque acmep_ing 012 75

%XRXend

%PDF-1.3

:

Adding Dynamic Page Exceptions in VIPP Format
Dynamic page exceptions are supported through SETMEDIA and are 
defined in the Xerox VIPP Reference Manual. 

• The SETMEDIA command sets the media requirement. In the syntax 
example, SETMEDIA sets MediaType, MediaColor, and MediaWeight 
as the current media type requirements for subsequent pages.

The Spire CXP8000 color server mapping is similar to the mapping of 
PostScript and Variable Print Specification file formats. 

The MediaType value is mapped to the paper stock name.

The MediaColor is mapped to the paper stock color.

The MediaWeight is mapped to the paper stock weight.

For more information about PostScript and Variable Print Specification 
formats, see Adding Dynamic Page Exceptions in PostScript and Variable 
Print Specification Formats on page 276
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• When any of the media attributes are specified as null, those attributes 
are ignored in the following media selections. This example ignores 
MediaColor.

(Drilled:null:100) SETMEDIA

• When any of the media attributes such as type, color, or weight are 
omitted, the last specification or the default value for that attribute 
remains in effect. The trailing “:” may be omitted as shown in this 
example.

(Plain::) SETMEDIA

(Plain:) SETMEDIA

(Plain) SETMEDI

Example

!PS-Adobe-2.0

:

%Page1

:

%SPD Type Drilled, Color blue, Weight 98)

(Drilled:blue:98) SETMEDIA

:

% Page 3

%SPD Type Cover, Color yellow, Weight 105)

:

(Cover:yellow:105) SETMEDIA

:

% Page 5

%SPD Type Transparency, Color Clear, Weight 125)

:

(Transparency:Clear:125) SETMEDIA

:

The following is the SETMEDIA definition:

%!PS-Adobe-3.0

%%Title: newVItest_US.dbm

XGFdict /STARTBOOKLET known { STARTBOOKLET } { } ifelse

%Page1 Front Side

%SPD Type Drilled, Color blue, Weight 98)

(Drilled:blue:98) SETMEDIA

(1_newVItest_US.ps) CACHE SETFORM 0 NL
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%% Run the PostScript master form

% (Text) Box # 4 (Front Page: 1) Xpos: 223.972 Ypos: 368.679 Width: 
370.028 Height: 45.366

% Page 3 Front Side

%SPD Type Cover, Color yellow, Weight 105)

(Cover:yellow:105) SETMEDIA

(1_newVItest_US.ps) CACHE SETFORM 0 NL %% Run the PostScript master 
form

% (Picture) Box #1 (Page: 3) Xpos: 226.355 Ypos: 634.648 Width: 
358.263 Height: 254.99 % Page 5 Front Side

% Page 5 Front Side

%SPD Type Standard, Color goldenrod, Weight 108)

(Standard:goldenrod:108) SETMEDIA

(1_newVItest_US.ps) CACHE SETFORM 0 NL %% Run the PostScript master 
form

% (Picture) Box #1 (Page: 3) Xpos: 226.355 Ypos: 634.648 Width: 
358.263 Height: 254.99

Printing Tabs Using the Dynamic Page Exceptions Workflow
The Spire CXP8000 color server supports the option to print tabs using the 
dynamic page exceptions workflow. This workflow enables you to handle 
many jobs with different settings without having to manually set page 
exceptions in the Job Parameters window for each job—for example, if 
you want to print 100 separate booklets that all use the same stock types, 
but each booklet has a different number of pages and the tabs are inserted 
in different places in each booklet. 

Perform the following steps to set up the workflow:

1. Load the stock types in the trays, see Loading the Paper Stock on 
page 269.

2. Program the job through the Xerox DocuColor 8000 Digital Press 
Access Panel, see Access Panel on page 270.

3. Create paper sets, see Creating Paper Sets on page 271.

4. Create a dedicated printer and map the paper sets in the Exceptions 
tab, see Creating a Dedicated Virtual Printer on page 282.

5. Import all the PDF files via the dedicated virtual printer, and then 
submit the job for printing. The files are processed and printed using 
the page exceptions that were coded in the files.
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Creating a Dedicated Virtual Printer 
1. On the toolbar, click the Resource Center button. 

2. In the Resource list, select Virtual Printers.

3. Click Add.

The Add Virtual Printer dialog box appears.

4. In the Name box, enter a printer name.

5. Select the Support dynamic page exceptions check box.

6. Click Edit.

The Job Parameters window appears with the Print Settings tab 
selected. 

7. On the Print Settings tab, set the following parameters:

• Print Method: Duplex head to head

• Delivery: Face Up

• Rotate 180: Yes

8. On the Paper Stock tab, set the Paper set name to Text.
Or:
Set the following parameters:

• Paper set name: Undefined

• Paper size: SEF Letter

• Weight: 106-135gsm
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9. On the Finishing tab, set the following parameters:

• Admin page: Select the Print Admin. page check box, and in the 
Paper set list, select Admin sheet

• Tray: Tray 3

10. On the Exceptions tab, perform the following steps to map the paper 
set names to the individual trays:

• In the Paper Set column, select the paper set names that you 
created—for example, Text and Tab.

• In the Exception Type column, select Exception. 

• Click Save.

 

11. In the Edit Virtual Printer dialog box, click OK.

12. In the Resource Center, click Close.

Note:  If you are adding a blank page, select Insert in the Exception Type 
column.
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Tips and Limitations
The following list describes the current limitations for the dynamic page 
exceptions workflow:

• Define all pages in the original file using the dynamic page exceptions 
commands.

• To add inserts, use a dynamic page exceptions command in the file 
that requires a paper stock but will not print anything on it. If a job is 
duplex, make sure that you use the command twice.

• Virtual printers that support dynamic page exceptions should not be 
used for other jobs. 

• Virtual printers that support dynamic page exceptions do not support 
page exceptions and imposition. In addition, the paper stock selection 
is limited to the assigned stocks and not the entire database.

• When you create the dedicated virtual printer, you should define the 
paper feed direction for the paper sets in the job. All paper sets that are 
used in a dynamic page exceptions job must be in the same paper feed 
direction. Make sure you do not select the Best Fit option. 

For information about defining the paper feed direction, see The Paper 
Stock Tab on page 166.
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The Finishing Tab
The Finishing tab enables to select various options to finalize your printed 
documents.

Admin. Page

The Administration page contains job-related information such as the job 
title, page size, number of pages or sets, and the sender name. 

The Administration page is printed in the same order as the job, for face-
down printing the page is printed before each set and for face-up printing 
the page is printed after each set.

Note:  If you change the options in the Admin page parameter, the job needs 
to be re-RIPed.
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To print an admin. page:

1. Select the Print Admin page check box.

2. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

3. In the Tray list, select the desired tray:

• Tray 1: The specific paper stock should be loaded in this tray.

• Tray 2: The specific paper stock should be loaded in this tray.

• Tray 3: The specific paper stock should be loaded in this tray.

• Tray 4: The specific paper stock should be loaded in this tray.

• Auto: Any tray with the specific paper stock will be used. 

Slip Sheet

For more information about adding paper sets, see Managing Paper Sets on 
page 167.
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You can print slip sheets with your job and select a different paper set in 
which to print the slip sheet. If the job is collated, the slip sheets will be 
printed between sets. If the job is uncollated, the slip sheets will be printed 
between groups.

To set slip sheet options:

1. Select the Print slip sheet check box.

2. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

3. In the Tray list, select the desired tray:

• Tray 1: The specific paper stock should be loaded in this tray.

• Tray 2: The specific paper stock should be loaded in this tray.

• Tray 3: The specific paper stock should be loaded in this tray.

• Tray 4: The specific paper stock should be loaded in this tray.

• Auto: Any tray with the specific paper stock will be used.

4. In the Frequency list, type the number of slip sheets you want to print. 
The default is 1; a slip sheet is printed between each set.

For more information about adding paper sets, see Managing Paper Sets on 
page 167.
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Front Cover

By default, your job is printed without a front cover. However, you can 
choose to print a front cover, and you can also select a different paper set. 

To print a front cover:

1. Select the Print front cover check box.

2. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

3. In the Tray list, select the desired tray:

• Tray 1: The specific paper stock should be loaded in this tray.

• Tray 2: The specific paper stock should be loaded in this tray.

• Tray 3: The specific paper stock should be loaded in this tray.

• Tray 4: The specific paper stock should be loaded in this tray.

• Auto: Any tray with the specific paper stock will be used.

For more information about adding paper sets, see Managing Paper Sets on 
page 167.
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4. In the Cover printing area, select one of the following options:

a. None: Use this option to print a blank front cover.

b. Print on front side: Use this option to print the first page of the job 
as the cover page.

c. Print on both sides: Use this option to print the first two pages of 
the job as the cover page.

Back Cover

By default, your job is printed without a back cover. However, you can 
choose to print a back cover, and you can also select a different paper set. 

Note:  A blank page will automatically be inserted between the cover 
page and the first page of the job so that both sides of the cover page 
are defined and the job starts on the next odd page.
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To print a back cover:

1. Select the Print back cover check box.

2. In the Paper set list, select the desired paper set. If you need to add a 
new paper set, click the browse button.

3. In the Tray list, select the desired tray:

• Tray 1: The specific paper stock should be loaded in this tray.

• Tray 2: The specific paper stock should be loaded in this tray.

• Tray 3: The specific paper stock should be loaded in this tray.

• Tray 4: The specific paper stock should be loaded in this tray.

• Auto: Any tray with the specific paper stock will be used.

4. In the Cover printing area, select one of the following options:

a. None: Use this option to print a blank back cover.

b. Print on back side: Use this option to print the last page of the job 
as the back cover.

c. Print on both sides: Use this option to print the last two pages of 
the job as the back cover.

For more information about adding paper sets, see Managing Paper Sets on 
page 167.

Note:  A blank page will automatically be inserted between the back 
cover and the last page of the job so that both sides of the back cover 
are defined.
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Finisher

The Finisher parameter enables you to select the destination of the printed 
output.

In the Module list, select one of the finisher options:

OCT (Offset Catch Tray): This is the default option.

• Clear the Offset check box to stop the offset on the OCT (by 
default the Offset check box is selected).

EHCS( Enhanced High Capacity Stacker) 

Note:  The available stapling methods for PostScript files depend on the page 
orientation and size. The stapling methods for PDF files depend on the page size.

Note:  If the page size is larger than A3 (standard or custom), the Offset check 
box is unavailable.
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a. Choose a tray option.

b. If you select the Stack Tray option, select the Offset check box for 
the following types of jobs:

• Collated: Each copy is offset from the next copy.

• Uncollated: If you need more than one copy of each page, 
offset shifts the sheets when a new page number is delivered. 
For example, if you request three copies of each page, the 
printing output sequence is as follows: Page1, Page1, Page1, 
Offset, Page2, Page2, Page2, Offset, and so on.
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HCSS (High Capacity Stacker Stapler)

a. Choose a tray option.

b. If you select Stack Tray, select one of the following check boxes:

• Offset: Use this option for both collated and uncollated jobs. 
For uncollated jobs, offset shifts the sheets when a new page 
number is delivered. For example, if you request 3 copies of 
each page, the printing output sequence is as follows: Page1, 
Page1, Page1, offset, Page2, Page2, Page2, offset, and so on.

• Staple: Use this option to select the desired stapling method. 

EHCS + HCSS (Enhanced High Capacity Stacker and High Capacity 
Stacker Stapler)

EHCS-1 + EHCS-2

EHCS-1 + DFA (Enhanced High Capacity Stacker and Document 
Finishing Architecture)

DFA (Document Finishing Architecture)

a. Select the desired Profile from the list (according to the profile set 
in the printer you are using).

b. Select the desired Function (according to the profile set in the 
printer you are using). 
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Fonts
This section lists all the fonts available on the Spire CXP8000 color server, 
and explains how to work in the Fonts area of the Resource Center. 

A step-by-step procedure explains how to use the FontDownLoader driver 
to download fonts from a Macintosh client workstation.

In addition, you can download Windows fonts from a client workstation 
to the Spire CXP8000 color server. This is done by dragging the fonts to the 
HF_Fontdownloader hot folder.

Font List
Table 11 lists the standard fonts that are available on the Spire CXP8000 
color server.

Table 11:  Standard fonts

AdobeSansMM AdobeSerifMM AlbertusMT

AlbertusMT-Italic AlbertusMT-Light AntiqueOlive-Bold

AntiqueOlive-Compact AntiqueOlive-Italic AntiqueOlive-Roman

Apple-Chancery Apple-ChanceryCE Arial-BoldItalicMT

Arial-BoldMT Arial-ItalicMT ArialCE

ArialCE-Bold ArialCE-BoldItalic ArialCE-Italic

ArialMT AvantGarde-Book AvantGarde-BookOblique

AvantGarde-Demi AvantGarde-DemiOblique AvantGardeCE-Book

AvantGardeCE-BookOblique AvantGardeCE-Demi AvantGardeCE-DemiOblique

Bodoni Bodoni-Bold Bodoni-BoldItalic

Bodoni-Italic Bodoni-Poster Bodoni-PosterCompressed

Bookman-Demi Bookman-DemiItalic Bookman-Light

Bookman-LightItalic BookmanCE-Demi BookmanCE-DemiItalic

BookmanCE-Light BookmanCE-LightItalic Carta

Chicago ChicagoCE Clarendon

Clarendon-Bold Clarendon-Light CooperBlack

CooperBlack-Italic Copperplate-ThirtyThreeBC Copperplate-ThirtyTwoBC

Coronet-Regular CoronetCE-Regular Courier
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Courier-Bold Courier-BoldOblique Courier-Oblique

CourierCE CourierCE-Bold CourierCE-BoldOblique

CourierCE-Oblique EuroMono-Bold EuroMono-BoldItalic

EuroMono-Italic EuroMono-Regular EuroSans-Bold

EuroSans-BoldItalic EuroSans-Italic EuroSans-Regular

EuroSerif-Bold EuroSerif-BoldItalic EuroSerif-Italic

EuroSerif-Regular Eurostile Eurostile-Bold

Eurostile-BoldExtendedTwo Eurostile-ExtendedTwo Geneva

GenevaCE GillSans GillSans-Bold

GillSans-BoldCondensed GillSans-BoldItalic GillSans-Condensed

GillSans-ExtraBold GillSans-Italic GillSans-Light

GillSans-LightItalic Goudy Goudy-Bold

Goudy-BoldItalic Goudy-ExtraBold Goudy-Italic

Helvetica Helvetica-Bold Helvetica-BoldOblique

Helvetica-Condensed Helvetica-Condensed-Bold Helvetica-Condensed-BoldObl

Helvetica-Condensed-Oblique Helvetica-Narrow Helvetica-Narrow-Bold

Helvetica-Narrow-BoldOblique Helvetica-Narrow-Oblique Helvetica-Oblique

HelveticaCE HelveticaCE-Bold HelveticaCE-BoldOblique

HelveticaCE-Cond HelveticaCE-CondBold HelveticaCE-CondBoldObl

HelveticaCE-CondObl HelveticaCE-Narrow HelveticaCE-NarrowBold

HelveticaCE-
NarrowBoldOblique

HelveticaCE-NarrowOblique HelveticaCE-Oblique

HoeflerText-Black HoeflerText-BlackItalic HoeflerText-Italic

HoeflerText-Ornaments HoeflerText-Regular HoeflerTextCE-Black

HoeflerTextCE-BlackItalic HoeflerTextCE-Italic HoeflerTextCE-Regular

JoannaMT JoannaMT-Bold JoannaMT-BoldItalic

JoannaMT-Italic LetterGothic LetterGothic-Bold

LetterGothic-BoldSlanted LetterGothic-Slanted LubalinGraph-Book

LubalinGraph-BookOblique LubalinGraph-Demi LubalinGraph-DemiOblique

Table 11:  Standard fonts
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Marigold Monaco MonacoCE

MonaLisa-Recut NewCenturySchlbk-Bold NewCenturySchlbk-BoldItalic

NewCenturySchlbk-Italic NewCenturySchlbk-Roman NewCenturySchlbkCE-Bold

NewCenturySchlbkCE-
BoldItalic

NewCenturySchlbkCE-Italic NewCenturySchlbkCE-Roman

NewYork NewYorkCE Optima

Optima-Bold Optima-BoldItalic Optima-Italic

Oxford Palatino-Bold Palatino-BoldItalic

Palatino-Italic Palatino-Roman PalatinoCE-Bold

PalatinoCE-BoldItalic PalatinoCE-Italic PalatinoCE-Roman

StempelGaramond-Bold StempelGaramond-
BoldItalic

StempelGaramond-Italic

StempelGaramond-Roman Symbol Tekton

Times-Bold Times-BoldItalic Times-Italic

Times-Roman TimesCE-Bold TimesCE-BoldItalic

TimesCE-Italic TimesCE-Roman TimesNewRomanCE

TimesNewRomanCE-Bold TimesNewRomanCE-
BoldItalic

TimesNewRomanCE-Italic

TimesNewRomanPS-
BoldItalicMT

TimesNewRomanPS-
BoldMT

TimesNewRomanPS-ItalicMT

TimesNewRomanPSMT Univers Univers-Bold

Univers-BoldExt Univers-BoldExtObl Univers-BoldOblique

Univers-Condensed Univers-CondensedBold Univers-CondensedBoldOblique

Univers-CondensedOblique Univers-Extended Univers-ExtendedObl

Univers-Light Univers-LightOblique Univers-Oblique

Wingdings-Regular ZapfChancery-MediumItalic ZapfChanceryCE-MediumItalic

ZapfDingbats

Table 11:  Standard fonts
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Table 12 lists the standard Kanji fonts that are available on the Spire 
CXP8000 color server Japanese version:

Managing Fonts on the Spire CXP8000 Color Server
1. On the toolbar, click the Resource Center button. 

2. In the Resource list, select Fonts.

3. Choose a Font Library option. The default option is Latin.

4. To set the default font, select a font from the list, and click Set as 
Default.

5. To delete a font, select the font, and click Delete font.

Table 12: Kanji fonts

FotoMinA101-Bold FutoGoB101-Bold GothicBBB - Medium

Jun101-Ligh MidashiMin-MA31 MidashiGo-MB31

Ryumin-Light ShinGo - Bold ShinGo - Light

ShinGo - Medium ShinGo - Ultra ShinseiKai - CBSK1

Note:  To add new fonts to the Spire CXP8000 color server, copy the 
new fonts to the C:\CXP8000\General\RIP\Font folder.
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Downloading Fonts 

Using the Fontdownloader for Macintosh Networks
The Fontdownloader is a driver provided for Macintosh networks and 
enables you to download fonts from a Macintosh client workstation. The 
Fontdownloader functions as a communications port and sends messages 
between the Fontdownloader program and the Spire CXP8000 color 
server. You cannot send files through the Fontdownloader, only fonts.

To download fonts using the Fontdownloader driver (Mac OS 9.X):

1. From the Apple menu, select Chooser.

2. Select AppleShare and browse the network to where the Spire 
CXP8000 color server is configured.

3. Select the Spire CXP8000 color server—for example, CXP8000—and 
then click OK.

The Login dialog box appears.

4. Log in as Guest and click the Connect button.

The corresponding Spire CXP8000 color server window appears.

Note:  Mac OS 10.X users that want to download fonts need to use a 
previous Mac OS version—for example, Mac OS 9.X. It is recommended that 
you embed the fonts in the file.
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5. Select the Utilities folder, and then click OK.

6. Double-click the Adobe Downloader 5.0.5 folder. 

7. Copy the Adobe Downloader 5.0.5 to your desktop.

8. From the Apple menu, select Chooser.

The Chooser window appears.

Note:  Do not select the check box, otherwise it will mount with every 
reboot.
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9. Select LaserWriter (8.x) and select the desired fontdownloader.

10. Click Create.

11. Double-click the Downloader 5.05 on your desktop.

12. On the File menu, select Download Fonts.

13. In the font area, select the desired font directory.

14. Verify that Disk 0 is the selected device.

15. Add all the desired PostScript fonts and click the Download button.
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Using the Fontdownloader Hot Folder for Windows

You can use the HF_Fontdownloader hot folder to install new or missing 
fonts to the Spire CXP8000 color server fonts dictionary. The hot folder is 
located with the other hot folders on your client workstation and can be 
used with the following operating systems:

• Windows 2000

• Windows NT 

• Windows XP

For more information about hot folders, see Using Hot Folders on page 85.
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Substituting Fonts

The Substitute Fonts parameter enables you to set font substitution 
preferences.

Select a Substitute fonts option:

Yes: Use this option to substitute a missing font with the default 
font that is set in the Settings window.

No: Use this option if the desired font is missing and you want to 
stop processing the job.

Note:  If a font is substituted, a message appears in the Job History window.

For more information about managing fonts, see Managing Fonts on the 
Spire CXP8000 Color Server on page 297.
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Calibration
One of the most important issues in obtaining satisfactory print quality is 
steady toner density. Toner density is affected by many factors such as heat, 
humidity and service settings. You should perform a daily calibration to 
compensate for these factors. 

The calibration process corrects the printer colors by measuring their 
density and creating calibration look-up tables. The Spire CXP8000 color 
server uses the data in these tables to compensate for the differences 
between the actual, measured density level and the target level, the target 
density.

You should perform calibration in the following instances:

• When you use a new paper stock

• When you use a different screening method

• At least once every eight hour shift for every combination of paper 
stock and screening method used

• When prints show “color casts”

• After machine maintenance or hardware changes—for example, 
replacing a “Charge Coroton”

• On drastic ambient changes (temperature and humidity)

Important:  Perform a different calibration for every combination of media and 
screen type you are going to use for printing. When calibrating, always use the 
same media that you intend to use for printing.

Tip:  You can set a reminder to remind you to calibrate the Xerox DocuColor 
8000 Digital Color Press. For more information, see Calibration Reminder on 
page 415.



Calibration 305

Guidelines for Successful Calibration
To ensure your calibration is as accurate as possible, check the following 
guidelines before you calibrate:

• Ensure that your X-RiteColor® DTP32HS densitometer is connected 
properly

• Ensure that your X-RiteColor DTP32HS densitometer is calibrated. 
You should calibrate the device at least once a week, or whenever the 
power to the device is interrupted. Use the manufacturer calibration 
chart supplied with the device. After you finish calibrating the device, 
make sure you store the chart in the designated envelope. 

• To warm up the printer, use any media to print at least 25 duplex 
sheets of any four color test job.

• Print a reference job and use the same media and screen type on which 
you will print the final job. 

• Prepare the calibration pad to measure the calibration charts. If a 
calibration pad is not available, set a white media, at least 200 gsm, or 
two sheets of lighter paper, on the surface. Read the calibration chart 
on this surface.

• Set the Spire CXP8000 color server emulation method to the method 
you will use to print the customer job (CSA or Device Link).

The Calibration Process
The calibration process consists of the following steps:

1. Calibrate the densitometer, see Calibrating the DTP32HS Densitometer 
on page 306.

2. Load the paper set you are going to use for printing in the Xerox 
DocuColor 8000 Digital Color Press.

3. In the Spire CXP8000 color server application, from the Tools menu, 
select Calibration, see Calibrating the Spire CXP8000 Color Server on 
page 311.

4. Click Calibrate to run the Color Calibration Wizard, and to create a 
calibration table.

For more information about the DTP32HS densitometer, see Calibrating the 
DTP32HS Densitometer on page 306.
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5. Follow the Color Calibration Wizard steps.

6. When you measure the two calibration charts, place them on the 
surface you prepared—for example, on top of the white paper.

7. When the calibration is complete, print the job using the calibration 
table, see Printing the Job with the Calibration Table on page 327.

Calibrating the DTP32HS Densitometer
The X-Rite DTP32HS densitometer is a “high speed”color measurement 
instrument that reports densitometer and dot data.

Perform the following steps before first time use of the X-Rite DTP32HS 
densitometer:

• Familiarize yourself with the X-Rite DTP32HS Densitometer Operator’s 
Manual. 

• Connect the X-Rite DTP32HS Densitometer.

• Calibrate the X-Rite DTP32HSDensitometer.

Note:  Make sure you set the screen type to the one you are going to use to print 
the job—for example, 200 dot.

Tip:  It is strongly recommended that you include the specific paper name and 
screen method in the calibration table file name. This helps you select the correct 
calibration table in the job setup.

You can also use the DTP32HS Tutorial to learn how to use the DTP 32HS 
densitometer correctly. Access the tutorial from Tools>Calibration, and 
then click Calibrate. In Step 1 of the Color Calibration wizard, click 
DTP32HS Tutorial - Click & Learn.
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Connecting the X-Rite 32HS Densitometer to the Spire 
CXP8000 Color Server

Before calibrating the DTP32HS densitometer, make sure that you 
perform the following steps:

• Interface the X-Rite DTP 32HSdensitometer directly with one of the 
computer's serial ports

• Quit all programs and shut down the computer before you install 
interface cabling

• Plug the small end of the switching power supply into the power input 
connector of the interface cable.

• Plug the detachable line cord into the power supply and then into the 
AC wall receptacle. The instrument does not have an ON/OFF switch.

The LED indicates a variety of instrument operation conditions, such as 
calibration mode and operation. 

For a complete list of all conditions reported by the LED, see the X-Rite DTP32HS 
Densitometer Operator’s Manual.
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Calibrating the X-Rite DTP 32HS Densitometer

Frequency of Calibration

Your X-Rite DTP32HS densitometer should be calibrated weekly. 

Handling the Reflection Reference

Handle the reflection reference by the edges. Make sure that the reflection 
reference is free of dust, dirt, and smudge marks. 

Calibration Procedure
You can perform a  calibration at any time. The only required action is that 
you insert the reflection reference into the instrument as you would with 
any other strip.

1. Center the designated end of the reflection reference under the 
alignment mark.

2. Insert the reference strip until it is automatically advanced by the 
drive motor.

3. The LED slowly flashes green while the strip is pulled through the 
instrument and out the back. The LED turns solid green and a short 
beep sounds after a successful calibration. If the calibration fails (fast 
flashing green LED and long beep), verify strip is clean and reread.

4. Place the reflection reference in its protective envelope, and store the 
envelope away from light and heat.
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Color Calibration Methods
The Spire CXP8000 color server provides you with two color calibration 
methods:

• Target Calibration
This calibration method enables you to calibrate the Xerox DocuColor 
8000 Digital Color Press according to the following fixed, predefined 
density values:

The target calibration method ensures that the density values of the 
printed output do not exceed the predefined density values. The 
purpose of this color calibration method is to ensure consistency over 
time. 

• Auto Adjusted Calibration
This calibration method enables you to calibrate the Xerox DocuColor 
8000 Digital Color Press according to the printer’s performance 
capabilities.
With this method, you can set the maximum density of the printed 
output by selecting the desired percentage level. The higher the 

Table 13: Fixed density values for uncoated paper

Toner Density value

Cyan 1.7

Magenta 1.27

Yellow 0.82

Black 1.8

Table 14: Fixed density values for coated paper

Toner Density value

Cyan 1.9

Magenta 1.44

Yellow 0.87

Black 1.9
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percentage, the greater the density of the printed color.
The purpose of this method is to achieve optimal color intensity for a 
specific printer at a certain point in time.

The default setting for the color calibration method of the Spire CXP8000 
color server is target calibration. You can change the setting, if necessary, 
before calibrating the Spire CXP8000 color server.

To specify the calibration method:

1. In the Settings window, select Preferences>Color.

2. In the Calibration Method area, select the required calibration 
method, Target or Auto Adjusted.

3. If you selected Auto Adjusted and you would like to change the 
default settings, click Advanced.
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The Auto Adjusted window appears.

4. Change the Percent of Printer Max Setup density if required, by 
moving the slider, or by typing a percentage value in the 
corresponding box.

5. Click Save.

Calibrating the Spire CXP8000 Color Server
The Calibration window enables you to create and edit calibration tables. 
You can use the Color Calibration Wizard to create a calibration table, or 
edit an existing calibration table. 

The Color Calibration Wizard analyzes the measurements and creates 
calibration tables. Using these tables, the Spire CXP8000 color server 
compensates for the difference between the printer’s performance and the 
required values.

The following calibration look up tables are provided: 

• None: Applies no calibration table to the job.

• SpireNormal: Applies the factory default calibration table. Since this is 
a default look up table it cannot be overwritten. 

Note:  The default percentage value is 85%.

Important:  Changes to the calibration method during RIP will not take effect. 
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• SpireSaturated: Applies the factory default saturated calibration table. 
This look up table applies a darker calibration table in comparison to 
the SpireNormal look up table. Since this look up table is a default table 
it cannot be overwritten. 

• Normal: Initially the Normal look up table is identical to the 
SpireNormal look up table. This resemblance changes as soon as you 
calibrate your Spire CXP8000 color server, and at the end of the 
calibration process choose to save your calibration table as default. As 
a result, your calibration table is saved as the Normal look up table. 

• Saturated: Initially the Saturated look up table is identical to the 
SpireSaturated look up table. This resemblance changes as soon as you 
calibrate your Spire CXP8000 color server, and at the end of the 
calibration process choose to save your calibration table as default. As 
a result, your calibration table is saved as the Saturated look up table. 

To open the Calibration window:

1. From the Tools menu, select Calibration.

The Calibration window appears.

Note:  Each time you save a calibration table as default, it is saved twice, once 
as Normal look up table, and once as the Saturated look up table.
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The following options are available:

• Click Calibrate to run the Color Calibration Wizard. This wizard 
guides you in the use of the X-Rite 32HS to create calibration tables, 
see Creating a Calibration Table on page 313.

• Select a calibration table from the Calibration Name list and select one 
of the following options: 

Click Edit to edit the calibration table, see Editing Calibration Tables 
on page 321.

Click Delete to delete the calibration table.

Click Info for the Density Graph, see Reading Color Density Data on 
page 325.

Click Close to end a test job and close the Calibration window.

Creating a Calibration Table
1. In the Calibration window, click Calibrate.

The first step in the wizard is Printing Start Point Chart. This step 
enables you to detect the point where you start to see toner on the 
paper. Before printing the start point chart, you need to set the 
following parameters according to the values of your job:

• Tray

• Screening method

• Media type
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2. Select the required input tray from the Select tray list.

Note:  Click the DTP32HS Tutorial - Click & Learn icon to display an 
animation of the measurement process and to learn how to use the DTP 
32HSdensitometer correctly.
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The default tray setting is Auto. When this option is selected, the 
wizard looks for a tray that contains Letter LEF or A4 LEF paper. If the 
wizard does not find a tray with either of these sizes, an alert appears.

You can print calibration charts on any size paper. Just ensure that the 
required paper is in one of the trays, and then select that tray in the 
wizard.

3. Select the required screening method from the Select screening 
method list. 

4. Select the required Paper Weight from the list.

5. From the Paper coating options, select Coated or Uncoated paper 
stock.

6. Set the number of copies you need by typing the number or using the 
arrows next to the box to select the number.

7. Click Print.

The Xerox DocuColor 8000 Digital Color Press prints a Start Point 
Density calibration chart. 

8. Collect the chart from the printer.

Step 2 of the Color Calibration Wizard appears. In this step you scan 
the start point chart so that the wizard can measure each separation 
and find the point at which the toner appears on the paper.
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9. Make sure that the green light on the X-Rite DTP32HS is on and 
blinking. Center the cyan column under the alignment mark on the 
densitometer.

10. Slowly insert the Image Start Points Calibration Chart to the X-Rite 
DTP32HS densitometer until it is automatically advanced by the 
densitometer motor.The green light slowly flashes while the chart is 
pulled through the densitometer and out the back.

A beep sounds and a green light blinks when the scan is complete. A 
check mark appears over the cyan icon and instructions appear for the 
next sweep, this time for the magenta column. 

11. After each color sweep, wait for the check mark to appear over the 
appropriate icon and follow the instructions as listed.

When all of the separation columns have been successfully scanned, a 
check mark appears next to all icons.

Note:  Ensure that the separation columns on the Continuous Tone Chart 
are scanned in the order they appear in the icons: 
Cyan>Magenta>Yellow>Black.

Notes:

• If at any stage the scanning has not been completed properly, click 
Reset and scan again.

• If an error occurs while you are scanning the chart, an alert message 
appears. Click OK and re-scan the charts.
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Step 3 of the Color Calibration Wizard appears. 

12. Click Print.

13. Collect the chart(s) from the printer.

Note:  If you selected automatic screening in Step 1 of the wizard, the Xerox 
DocuColor 8000 Digital Color Press prints two charts, an Image Density 
Calibration Chart and a Text/Line Art Chart. If you selected any other 
screening method, only the Image Density Calibration Chart is printed. 
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Step 4 of the Color Calibration Wizard appears.

  

14. Center the cyan column under the alignment mark on the 
densitometer. Slowly insert the Image Density Calibration Chart to 
the X-Rite DTP32HS densitometer until it is automatically advanced 
by the densitometer motor. The green light slowly flashes while the 
chart is pulled through the densitometer and out the back.

A beep sounds when the scan is complete and the green light stops 
flashing. A check mark appears next to the cyan icon and instructions 
appear for scanning of the next column (magenta).

Note:  If at any stage the scanning has not been completed properly, click Reset 
and scan again.
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15. After each scan, wait for the check mark to appear next to the 
appropriate icon and follow the instructions as listed.

When all of the separation columns have been successfully measured, 
a check mark appears next to all icons. 

16. If in Step 1 of the wizard, you selected Auto from the Select screening 
method list, you are now required to sweep the Text/Line Art Chart. 
Follow the same scan sequence. Begin each chart with the cyan 
column.

When all of the Text/Line Art separation columns have been 
successfully measured, a check mark appears next to all icons.

Note:  Ensure that the separation columns on the Image Density Chart are 
scanned in the order they appear in the icons: 
Cyan>Magenta>Yellow>Black.

Note:  After the LW Density black separation is scanned and the beep is 
heard, it can take several seconds until the check mark appears in the box.

Note:  If at any stage the scanning has not been completed properly, click 
Reset and scan again. 
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Step 5 of the Color Calibration Wizard appears.

17. Select Save as and select the required name for the calibration table. 
Type your own or select one from the list.
Or: 
Select As default table to save the calibration table as Normal.

If you choose the As default table option, the Spire CXP8000 color 
server automatically overwrites the existing Normal and Saturated 
calibration tables.

18. Click Finish. 

Regardless of the option you choose, two calibration tables are saved:

• Normal: A table that maintains the gray balance throughout the 
range of colors in the print job file

• Saturated: A table that is the same as the normal table for 80% of 
the color range but from that point on, each color has a greater 
density. You can use this table when you need dark colors that are 
more intense than in the normal table.

For example, if you name your Normal calibration table Tuesday23, 
the Saturated table is automatically named Tuesday23.sat.
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Editing Calibration Tables
You can review a calibration table to make sure that the curves are 
relatively smooth and continuous. If you are not satisfied with the results, 
the Edit option enables you to adjust the values of the image in the value 
table.

To edit a calibration table:

1. From the Tools menu, select Calibration.

2. In the Calibration Name box, select a calibration table, and then click 
Edit.

The Edit Calibration window appears.

Screen

If you selected Automatic as the screening method, you can view two 
calibration tables, CT or LW. In the Screen list, select the table you want to 
view.

Separation

The graph displays cyan, magenta, yellow, and black separations. You can 
see information about each separation by selecting it from the list. 
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Value Table

You can change the separation values by adjusting the File Value and 
Printer Value settings. The table displays some of the dot percentage values 
shown in the graph. You can add, edit, or delete entries in the table. Your 
changes will be displayed immediately in the calibration graph.

Editing Calibration Value Tables

To add an entry to the value table: 

1. Highlight a row in the value table. The new entry row will appear 
below this row.

2. Click Add Entry. 

The Add Entry dialog box appears.

3. Select the required values from the File and Printer lists.

4. Click OK. 

The value table is updated and the calibration graph is adjusted.

To change an existing value table:

1. Highlight a row and double-click on the row you want to edit.

The Edit Entry dialog box appears.
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2. Adjust the File Value and Printer Value as required by clicking on the 
arrow buttons.

3. Click OK. 

The value table is updated and the calibration graph is adjusted.

To delete an entry from the value table:

1. In the value table, highlight the entry to be deleted.

2. Click Delete Entry.

The entry is removed. 

Calibration Graph

The graph shows the values from your calibration table.

Calibration graph showing separations

The horizontal axis represents the dot percentage values of the RTP file. 
The vertical axis represents the dot percentage values of the final output 
data (after applying the calibration table) that is sent to the printer. 

During printing, the Spire CXP8000 color server automatically replaces 
the CMYK values in the RTP file with new values that compensate for the 
printer’s current performance level.
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To open or hide the calibration graph, click the arrow button in the 
Edit Calibration dialog box.

Viewing Separations
The graph displays cyan, magenta, yellow, and black separations. You can 
view detailed information about each separation by clicking its button. To 
view the information for all the separations together, click the button that 
shows all four colors.

Organizing Calibration Tables
You can use the Save and Save As functions to organize your calibration 
tables.

To save an existing calibration table:

1. In the Edit Calibration dialog box, adjust calibration table values and 
parameters as required.

2. Click Save.

The edited calibration table is saved with its original name.

To save a new calibration table:

1. In the Edit Calibration dialog box, adjust calibration table values and 
parameters as required.

2. Click Save As. 

The Save As dialog box appears.

Note:  When you click Save, new calibration settings override previous 
calibration table settings.
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3. In the File Name box, type the new calibration table name.

4. Click OK. 

The calibration table is saved with the new name. 

5. Click Close to exit the Edit Calibration dialog box.

Backing Up Calibration Tables
1. Locate the ColorCalibrationDB folder, following the path 

C:\CXP8000\General\ColorCalibration\ColorCalibrationDB.

2. Open the ColorCalibrationDB folder.

3. Copy the required calibration table files to your backup location. 

Reading Color Density Data

To view the Density Graph:

1. In the Calibration window, from the Calibration Name list, select the 
table for which you want to receive detailed color information.

2. Click Info. 

Note:  You can’t overwrite the default calibration tables, Spire Normal and 
Spire Saturated.

Note:  To edit a calibration table, select Tools>Calibration>Edit. To view 
information about a calibration table, select Tools>Calibration>Info.
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The Density Graph appears. The Density Graph gives you detailed 
information about the saved calibration tables.

Calibration graph showing Cyan, Magenta, Yellow and Black separations.

The Density Graph contains the following data:

• Calibration name

• Measured D-Max values for each separation

• Target D-Max values for each separation 

• Minimum accepted density values for each separation (Xerox values) 

• View options: filtering by color - select which colors are shown/hidden

• Calibration curves (target and measured) for each separation

Target is displayed as bold lines

Measured is displayed as thin lines

• Index - emphasizes the difference between target lines and measured 
lines
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• Properties: paperweight, screening, paper coating 

Printing the Job with the Calibration Table
Now that you have calibrated the paper you are going to use for printing, 
you can select the calibration table to print any job on the same paper stock 
using the same screen type. You can print the reference job you printed 
before with the new calibration table to evaluate the calibration results.

To print the reference job:

1. In the Spire CXP8000 color server workspace, suspend the Process 
Queue.

2. Import the job.

3. Double-click the job to open the Job Parameters window.

4. In the Paper Stock tab, select the desired paper stock.

5. On the Color tab, select the calibration you created for the particular 
stock from which you printed. 

6. In the Color tab, select the screening method you used for the selected 
calibration.

7. Set all other desired parameters, and then click OK to close the Job 
Parameters window.

8. Activate the Process Queue and Print Queue, and inspect the printed 
job.

If you see that the print out has any color imperfection, review the job 
parameter settings and make changes if necessary. If there are still color 
imperfections, perform machine maintenance and repeat the calibration 
process.

Note:  When the density of the Xerox DocuColor 8000 Digital Color Press is 
lower than 80% of the target density, the following message appears: 
“Attention: Below standard D-Max value(s) measured for <cyan, 
magenta, yellow, black>. Standard (Minimum): <C - 1.5>, <M - 1.4>, 
<Y - 0.9>, <K - 1.5>
Measured: <C - >, <M - >, <Y - >, <K - >”.

For more information about the Color tab, see Default Color Flow on 
page 328.
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Default Color Flow
Color job parameters are located in the Job Parameters window>Color tab. 
The Color tab provides you with tone compression tools such as 
brightness, contrast and gradation, as well as color tools, including 
rendering intent, ink saving, and RGB+CMYK Workflow. In addition, you 
can select various screening methods for your job.

The tone compression tools and screening methods, Gradation, 
Brightness, Contrast, and Calibration, can be applied to your RTP jobs 
without requiring the Spire CXP8000 color server to re-RIP the jobs. The 
color tools, Destination, Rendering Intent, Emulation, RGB Workflow, and 
Spot Color Editor, should be applied prior to initial RIPing or your job will 
need to be re-RIPed. 

The Spire CXP8000 color server accepts the following color formats:

• RGB

• CMYK

• L a* b*

• Spot Color

• Greyscale

• Duotone

To submit jobs for color adjustment on the Spire CXP8000 color 
server:

1. Import the job to the Spire CXP8000 color server workspace.

2. Double-click on the job in the Storage window.

3. Select the Color tab in the Job Parameters window.

The Color tab enables you to apply last-minute color corrections, or to 
set the output job to match other output devices.

4. Adjust the required color parameters (see the relevant parameter in 
the Color tab).
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5. Click Submit to send your job to print. 

The job is processed on the Spire CXP8000 color server and sent to the 
Xerox DocuColor 8000 Digital Color Press for printing.

Color Workflow Terminology
This section defines the terms used in the RGB and CMYK workflow.

• CSA (Color Space Array) is the spectrum of specific variants of a color 
model with a specific gamut or color range. For example, within the 
color model RGB, there are numerous color spaces, such as Apple 
RGB, sRGB, and Adobe RGB. While each of these define color by the 
same three axes (R, G, and B), they differ in gamut and other 
specifications. CSA is comprised of a three-dimensional geometric 
representation of colors that can be seen or generated using a certain 
color model and are quantitatively measured. Source CSA is to be used 
only under the assumption that the upstream color workflow was 
managed and monitored. Otherwise it should be replaced with a Creo 
profile, which is the default.

• CSA Profiles: There are three CSA profiles with gammas of 1.8, 2.1 and 
2.4. The higher the gamma, the darker the RGB appears. This 
workflow should be used when you have images from different 
sources, such as digital cameras, Internet, and scanners and you want 
the images to have the common RGB color spaces. 
Other possible CSA profiles are sRGB and Adobe RGB.

• Rendering Intent: All printers, monitors and scanners have a gamut or 
range of colors that they can output (or view in the case of a scanner). 
If a color needs to be output and is outside the gamut of the output 
device, it must be mapped or approximated to some other color, which 
exists within the gamut. Rendering Intent enables you to compress 
out-of-gamut colors into the color capability of the press you are 
using. You can set any rendering intent value for RGB elements by 
selecting the required from the Rendering intent options list. The 
default value for RGB is Perceptual (photographic). The default value 
for CMYK is Relative Colorimetric. 

Note:  You can also use a virtual printer to adjust job parameters.

For more information about submitting jobs to the Spire CXP8000 color server, 
see Importing and Printing Jobs on page 154.
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There are several methods that can be used when translating colors 
from one color space to another. These methods are called Rendering 
Intents because they are optimized for various uses. When working 
with ICC profiles, it is important that you select the Rendering Intent 
that best preserves the important aspects of the image. Each rendering 
method specifies a CRD for color conversions. You can modify the 
rendering method to control the appearance of images, such as prints 
from office applications or RGB photographs from Photoshop.

• Relative Colorimetric: a rendering intent method in which colors that 
fall within the output color space remain the same. Only colors that 
fall outside are changed to the closest possible color within the output 
color space. 
When using this method, some closely related colors in the input color 
space can be mapped to a single color in the output color space. This 
reduces the number of colors in the image.

• Absolute Colorimetric: a rendering intent method similar to Relative 
Colorimetric except that it does not make adjustments according to 
the white point. In this method, colors that do not fit within the 
output color space are rendered at the extremes of the output color 
space. Colors that fall inside the output color space are matched very 
accurately. 
This method is valuable for representing “signature colors“. Colors 
that are highly identified with a commercial product such as the cyan 
in the Creo logo.

• Saturated (presentation) - a rendering intent method which scales all 
colors to the strongest saturation possible. The relative saturation is 
maintained from one color space to another.
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This rendering style option is optimal for artwork and graphs in 
presentations. In many cases, this style option can be used for mixed 
pages that contain both presentation graphics and photographs.

• Perceptual (Photographic) (default for RGB) - a rendering intent 
method which preserves the visual relationship among the colors as 
they are perceived by the human eye. In other words, all colors are 
proportionally scaled to fit the output gamut. All or most colors in the 
original are changed but the relationship between them does not 
change.
This method is recommended when working with realistic images such 
as photographs, including scans and images from stock photography 
CDs. 
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Color Mode

The Color Mode parameter enables you to print color jobs in black and 
white using the black toner only. When a color job is printed using the 
Grayscale option, the Cyan (C), Magenta (M), and Yellow (Y) separations 
are also printed in Black (K) toner, giving a dense appearance similar to the 
CMYK grayscale image.

To set the color mode:

1. Select Grayscale to print the job as black and white using Black (K) 
toner only.
Or:
Select Color to print the job in color using CMYK.

Note:  When you print color jobs using the Color option, you can also select the 
Print grays using black toner check box in the RGB Workflow parameter, so 
that RGB gray text and graphics will be printed using black toner only.

For more information about the Print grays using black toner check box, see 
RGB Workflow on page 333.
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2. If you have selected Color, select the Print grays using black toner 
check box in the RGB Workflow parameter, to print RGB gray text 
and graphics using black toner only. 

RGB Workflow

The RGB Workflow parameter enables you to select a RGB profile and 
apply it to RGB elements in your job. You can use predefined profiles, or 
to achieve better color results, import your own custom profile via the 
Profile Manager. 

Note:  Grayscale images created in RGB applications, such as PowerPoint, 
should be specified as Monochrome or submitted to the system with 
Grayscale selected in the PPD file. This selection ensures that grayscale 
images are counted as black and white instead of color in both the Spire 
CXP8000 color server and in the Xerox DocuColor 8000 Digital Color Press 
billing meters.

For more information about importing RGB profiles, see Profile Manager on 
page 346.
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To set the RGB workflow options:

1. In the RGB Workflow list, select the required RGB source profile: 

• To use the embedded CSA or source CSA, select Use SourceCSA.

• To use a Spire or Adobe CSA, select a CSA from the list. The 
default option is SpireRGB_2.1.

• To use a custom RGB profile, select the profile name from the list.

2. In the Rendering intent list, select the required option

3. Select the Print grays using black toner check box if you want RGB 
gray text and graphics to be printed with black toner only.

CMYK Workflow

For more information about choosing the correct rendering intent, see To 
set the RGB workflow options: on page 334.

Note:  The Print grays using black toner check box not only affects 
R=G=B values, but may also cause slightly different values 
(R+/-4=G+/-4=B+/-4) to produce gray.
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The CMYK workflow is used to emulate various standards used in 
lithographic printing. These standards represent specific combinations of 
paper and ink, as well as popular proofing systems. It is also used to 
emulate other printing devices such as offset presses, or other digital 
printers. An example of a CMYK workflow job would be printing a test 
sample for a survey before moving to an offset press to print millions of 
survey forms. In such a case, it is best to emulate the offset before the job 
actually goes to offset printing.

The Spire CXP8000 color server supports two CMYK emulation methods, 
Device Link (default) and CSA. If you would like to use the CSA method, 
select Tools>Settings>Color and change the emulation method.

The CMYK workflow parameter is also used to specify the required 
rendering intent for CMYK elements. All printers, monitors, and scanners 
have a gamut or range of colors that they can output (or view in the case of 
a scanner). If a color needs to be output and is outside the gamut of the 
output device, it must be mapped or approximated to some other color, 
which exists within the gamut.

Rendering Intent enables you to compress out-of-gamut colors into the 
color capability of the press you are using. You can set any rendering intent 
value for CMYK elements by selecting the required from the Rendering 
intent list. The default value for CMYK is Relative Colorimetric.

In addition, you may also select to emulate the paper tint and adjust the 
white point value of the used paper stock. For example, if you want to 
simulate pink paper stock while using white paper stock, you may use the 
corresponding emulation profile and select the Emulate source paper tint 
check box. The result will be that in addition to the job emulation, the 
paper tint will be also emulated and will have a pink shade. 

Note:  RGB colors are not affected by the CMYK workflow.

For more information about choosing an emulation method, see Emulations on 
page 414.
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To select CMYK workflow options:

1. In the Original list, select one of the following options:

• Direct: This is the default CMYK workflow. The CMYK elements 
are printed without any color transformation.

• Use Source CSA: Uses the embedded CSA from the PostScript file.

2. In the Emulation list, select the required emulation. 

• Select the Emulate source paper tint check box to emulate the 
original paper tint. 

• Select Emulate RGB elements to convert RGB elements according 
to the selected CMYK emulation method. The RGB elements 
receive the same look as the CMYK elements, creating a consistent 
appearance.

• Select the Preserve pure colors check box to preserve pure cyan, 
magenta, yellow, and black during transformation.

3. In the Rendering intent list, select the required option.

Note:  The system emulates the selected option during the RIP process. GCR 
and CMYK Emulation do not affect the processed job.

Notes:

• The Emulate source paper tint check box is available only if you 
select Device Link as the emulation method.

• When the Emulate source paper tint check box is selected, 
Absolute Colorimetric will be used as the rendering method.

• If the job is simplex, only the front side will be printed using the tint 
emulation.

For more information about choosing the correct rendering intent, see To 
set the RGB workflow options: on page 334. 
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Spot Workflow

By default, the Spire CXP8000 color server looks in the spot color 
dictionary for the correct value each time there is a spot color with a 
recognized name. 

To ignore the spot color dictionary:

In the Spot workflow options area, clear the Use Spire spot color 
dictionary check box.

For more information about the Spire spot color dictionary, see Spot Color 
Editor and Workflow on page 351.
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Destination Profile

The Destination profile parameter enables you to select a custom or 
predefined destination profile. After you import a custom destination 
profile via the Profile Manager, it is displayed in the Profile list. There are 
two predefined Spire CXP8000 color server profiles, DC_8000_C.GA and 
DC_8000_U.COM. If you map, or link, a profile to a specific paper color, the 
same profile will always be used for that paper set.  

To set the destination profile:

In the Profile list, select the required profile.

For more information about destination profiles, see Profile Manager on 
page 346.
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Screening

Screening converts CT (Continuous Tone) and LW (Line Work) images 
into information (halftone dots) that can be printed. The human eye 
“smooths out” this information, which seems visually consistent with the 
original picture. Thus, the more lines per inch, the more natural the image 
appears. 

Screening is achieved by printing dots in numerous shapes or lines in an 
evenly spaced pattern. The distance between the screen dots or lines is 
fixed and determines the quality of the image.

Printers can work with even amounts of toner and still produce a wide 
range of colors when you use screening. The darker the color, the larger the 
dot. 

The Spire CXP8000 color server supports six types of screening: 

• Automatic applies two types of screens: 
For CT, the system uses dot type screen of 200 lpi. 
For LW (text and line-art elements), the system uses line type screen of 
200 lpi. 
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Automatic screening results in the printing of text and graphic shapes 
at Continuous Tone. Automatic screening is the recommended 
screening mode.

• Dot 150 applies Dot type screen of 150 lpi. The screen of each 
separation is printed at a different angle.

• Dot 200 applies Dot type screen of 200 lpi. The screen of each 
separation is printed at a different angle.

• Line 200 applies Line type screen of 200 lpi. The screen of each 
separation is printed at a different angle.

• Dot 300 applies Dot type screen of 300 lpi. The screen of each 
separation is printed at a different angle.

• Dot 600 applies Line type screen of 600 lpi. The screen of each 
separation is printed at a different angle.

• Stochastic

To select a screening method:

In the Screening list, select the required option. For CT images, use a 
dot option, and for LW images, use a line option. If you select the 
Automatic option, Dot 200 will be used for CT images and Line 200 
will be used for LW images.

Note:  To change the Automatic screening values, see Automatic Screening 
on page 414.
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Calibration 

The purpose of color calibration is to achieve a consistent level of color 
quality. The calibration process corrects printer colors by measuring a 
chart using a densitometer, which measures color density. 

The Spire CXP8000 color server Calibration tool enables you to create and 
edit calibration tables, either through an automatic process or by editing 
an existing calibration table. The available calibration options are Normal, 
Saturated and None.

The Calibration parameter enables you to select the required calibration 
table for the job.

For more information about calibration tables, see Calibration on page 304.
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To select a calibration table for a job:

In the Calibration list, select a calibration table. The default calibration 
table is Normal.

Ink Saving (GCR)

The Ink Saving GCR (Gray Component Replacement) parameter enables 
you to conserve toner by replacing the gray component (CMY) of pixels 
with black toner.

The gray component replacement also prevents the consequences of 
excessive toner buildup, such as flaking and cracking, or the "curling" 
effect that may occur when printing transparencies.

Tip:  For optimal printing performance, use the Normal (default) calibration 
setting (with Medium GCR).
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While the gray component of each color is replaced by black, there is no 
change in the color quality of the printed image.

To set the Ink Saving GCR, select one of the following options:

• None: When this option is selected, no GCR is performed on the file 
and the printer applies maximum dry ink coverage

• Select the required amount of CMY dry inks to be replaced by the 
black dry ink:

Low 

Medium 

High 

No GCR Low GCR Medium GCR High GCR

Note:  Use the High option to provide minimum ink coverage and thus save 
on toner. This setting also prevents curling effects.
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Color Adjustments

Gradation
The Gradation option contains a list of gradation tables that were created 
by the Spire CXP8000 color server’s Gradation tool. Each gradation table 
contains specific settings for brightness, contrast and color balance.

When you select your predefined gradation table, your job is adjusted 
according to the specific table’s settings. 

To select a gradation table:

In the Gradation list, select one of the defined gradation tables. 

For more information about creating gradation tables, see Gradation Tool on 
page 354.

Note:  The default setting is None. No gradation table is applied to your job.
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Brightness
By changing the Brightness setting, you can control how light or dark your 
output will appear. 

Brightness is generally used to make last-minute adjustments to the print 
job after proofing. 

To select a brightness level for a job, move the Brightness slider to the 
required brightness level (the range starts from Light, which applies -
15%, to Dark, which applies +15%). 

Contrast
Adjusting the Contrast option enables you to control the difference 
between the light tones and the dark tones in your image.

Lighter Normal Darker

Note:  Changing the brightness level for an RTP job, does not require re-RIPing 
of the job.

Note:  When you set the brightness level to Normal, no change is applied.

Less Normal More
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The Contrast option is generally used to make last-minute adjustments to 
the print job after proofing.

To select a contrast level for the print job, move the Contrast slider to 
the required contrast level (the range starts from Less - which applies -
10%, to More - which applies +10%).

Color Tools

Profile Manager
The Profile Manager enables you to import and delete source and 
destination ICC profiles, and map destination profiles to specific paper 
colors.

Source profiles are used to emulate other devices, or color spaces. You can 
import source CMYK or RGB profiles. To use a profile in a job, in the Job 
Parameters window, select Color>RGB workflow or Color>CMYK 
workflow>Emulation, depending on the profile you imported. 

Destination profiles define the color space of your printer and are based on 
the combinations of paper and toner that you are using. For different 
paper stocks, you need different destination profiles. Each custom 
destination profile will be used with coated and uncoated paper. To use a 
different destination profile in a job, in the Job Parameters window, select 
Color>Destination profile.

Note:  Changing the contrast level for an RTP job, does not require re-RIPing of 
the job.

Note:  When you set the slider to Normal, no change is applied.

Note:  Custom source RGB profiles are not available in the CSA emulation mode.

For more information about selecting a source profile in a job, see RGB 
Workflow on page 333 and CMYK Workflow on page 334.

For more information about selecting a destination profile in a job, see 
Destination Profile on page 338.
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After you import a destination profile, you can use the Media Color 
Mapping dialog box to map the profile to a paper color. The profile is 
linked to the paper color and the Spire CXP8000 color server will 
automatically select the correct profile for your job. This is useful—for 
example, in jobs that have mixed paper types. Select Linked from 
Color>Destination profile.

Managing Device Link Profiles

To import a source ICC profile:

1. On the toolbar, click the Resource Center button. 

The Resource Center opens.

2. In the Resource list, select Profile Manager.

The Source Profile tab appears, and the predefined source ICC profiles 
are displayed.

3. Click Import.

The Import Source ICC Profile dialog box appears.
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4. In the Source profile area, click the browse button. Locate and select 
the required source profile, and then click Open.

The new emulation name is displayed in the Emulation name box; if 
you would like to change the name you may do so.

5. Click Import.

The new source ICC profile is added to the Emulation (Device Link) list 
in the Job Parameters window, in the CMYK Workflow parameter or 
to the RGB workflow parameter. 

To import a destination ICC profile:

1. In the Resource Center>Profile Manager, click the Destination Profile 
tab.

The predefined ICC profiles are displayed.
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2. Click Import.

The Import Destination ICC Profile dialog box appears.

3. In the Destination profile area, click the browse button. Locate the 
required source profile, and then click Open.

The new emulation name is displayed in the Emulation name box; if 
you would like to change the name you may do so.

4. Click Import.

5. If you would like to set the imported destination as your default, select 
it and click Make Default.

6. To map ICC profiles to specific paper colors:

a. Click Color Mapping.
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The Media Color Mapping window appears.

b. In the Profile column, select the required profile for each paper 
color.

c. To add a new paper color, click the import button.

d. In the Add New Color box, type the name of the new color, and 
then click OK.

e. To delete a paper color, select the required paper color and click 
the delete button.

f. In the message that appears, click OK.

g. In the Media Color Mapping dialog box, click Close.

Note:  If you don’t map a destination profile to a paper color, the Spire 
CXP8000 color server uses the default profile, which is for white paper.
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To delete an ICC Profile:

1. In the Resource Center>Profile Manager, select the profile you would 
like to delete.

2. Click the delete button.

The profile is deleted from the profile list.

Spot Color Editor and Workflow
Individual job pages can contain continuous tone (CT), line work (LW), 
and spot color elements. The Spire CXP8000 color server Spot Color 
Editor enables the editing of CMYK values of every spot color in the Spot 
dictionary. You can edit these values without affecting the CT or LW page 
elements. It also enables you to create custom spot colors and to define 
fixed CMYK values for those spot colors. The Spire CXP8000 color server 
supports HKS and PANTONE 2000 Spot colors.

To edit an existing PANTONE color:

1. From the Tools menu, select Spot Color Editor.

The Spot Color Editor window appears with the Spire CXP8000 color 
server's entire collection of colors listed.

Note:  You cannot delete predefined ICC profiles.

Note:  Spot colors—for example PANTONE—are not effected by CMYK 
emulation. A spot color has the same appearance with any selected CMYK 
emulation.

For more information about the Spot Color Editor, see Spot Workflow on 
page 337.
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2. Search for a particular color under Color.

3. Alternatively, from the Spot dictionary list, select the color dictionary 
that contains the color you wish to edit.

4. Highlight the required color. 

The color's CMYK values and a color preview appear in the right hand 
side of the Spot Color Editor window.

5. Change the CMYK values as required.

6. Click Apply. 

The new color is added to the Custom color dictionary.

Note:  Under Color, you cannot perform an exact query. This input stream 
only reads one character. For example, you want “Cool Grey 4” and type 
“Cool“. As soon as you type “C”, the cursor only moves to “Cool Grey 1” 
and does not continue to a more specific selection. 

Note:  Use the PANTONE CV dictionary if you are working in QuarkXPress.
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To create a new spot color:

1. In the Spot Color Editor window, click the add button.

The Spot Color Editor dialog box appears.

2. Type the new color name as it exists in the PostScript file. 

3. Adjust the CMYK values as required.

4. Click OK. 

The new color is added to the Custom dictionary.

To delete a spot color (from the custom dictionary only):

1. From the Spot dictionary list, select Custom Dictionary. 

2. From the list of custom colors, highlight the color you wish to delete.

3. Click Delete.

The following message appears.

4. Click Yes to delete the color. 

Note:  The Spot color names are case sensitive and should match the name 
as it appears in the DTP application.
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Gradation Tool
Sometimes it is necessary to perform tone corrections when printing a job. 
These changes in gradation can include brightness, contrast and color 
balance adjustments throughout the tone range of an entire image, or in 
specific tone ranges. 

Gradation tables you create using the Gradation tool are added to the 
Gradations list in the Color tab and may be applied to print jobs. The Spire 
CXP8000 color server also enables you to visually check the effect of 
different gradation adjustments on RTP jobs prior to printing.

With Spire CXP8000 color server Gradation, you can apply the default 
gradation table or another pre-configured gradation table to a job. You 
can also edit an existing table and save your changes. Gradation is an 
interactive function and changes are automatically applied to the displayed 
image.

The Gradation Dialog Box
The Gradation dialog box is used to create and edit gradation tables and to 
check the effect of different gradation adjustments on specific RTP jobs. 
These tables can then be applied to your jobs during job processing for 
tailored gradations.

To open the Gradation dialog box:

1. From the Tools menu, select Gradation.

The Gradation dialog box appears.

Note:  You can edit an existing gradation table, but you can not overwrite the 
default gradation table, DefaultGradTable.
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Preview
Click Preview to view how a page from a specific RTP job changes with 
changing Gradation tables or Gradation adjustments. 

Notes:

• Gradation is an interactive function. Gradation changes are automatically 
applied to the displayed image.

• The gradation table created is not automatically applied to the previewed 
job. You must use job parameters to assign a gradation table to a job.
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To view gradation adjustments:

1. Click Preview to expand the Gradation dialog box.

2. Click Browse to select a job for display in the Preview window. 

The RTP Jobs window appears.

The displayed jobs are the RTP jobs listed in the Storage window.

3. Click on the RTP job you wish to modify.

4. Click OK. 
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The job appears in the Gradation dialog box.

5. Click Show Original (located at the bottom of the Gradation dialog 
box) to toggle back and forth between edited and unedited gradation 
table views. 

6. To view the effects of your gradation table changes on a different page 
of the RTP job, select the Page or Booklet you wish to view from their 
lists at the top of the Preview window.

The selected page appears.

Gradation Table Box
Upon opening the Gradation dialog box, the default gradation table 
DefaultGradTable is selected.

This table consists of a 45° gradation curve, with Brightness and Contrast 
set to 0, Contrast Center set to 50 and all color separations selected. 

Notes:

• The job name is listed at the top of the Preview viewer.

• Click Browse at any time to select a different RTP job on which to view 
the effects of gradation table changes.
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If you have previously created or edited gradation tables, select the 
required gradation table from the Gradation table list.
For viewing and editing purposes, the preconfigured settings of the 
selected gradation table are immediately applied to the RTP job on which 
you are working.

Separation Field
The Separation field is used to select the separations to be edited for a 
particular gradation table. You can select one, all, or any combination of 
separations. Selecting a specific separation and a specific gradation control 
enables you to change the color balance for a specific tonal range.

The Gradations window appears with all separations selected. 

This tools enables simultaneous editing of all separations.

To edit one, or several separations:

1. Click this button to clear all separations.

2. Click the individual separations you wish to edit—for example, select 
the cyan separation only.

3. Change the separation parameters using the Gradation controls.

Your changes to gradation tables are immediately presented as 
changes to the gradation graph.

For more information about each preview button and the display modes, see 
Previewing the Job on page 203.
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Gradation Graph
Spire CXP8000 color server gradation tables are represented visually in the 
Gradation dialog box in the form of a graph: 

The horizontal axis represents the tone values of the image before 
gradation changes (input). The vertical axis represents the tone values of 
the image after gradation changes (output). All four separations (CMYK) 
are shown, but if they have identical curves, the graphs appear as if there is 
only one curve.

Gradation Controls
The gradation controls are used to adjust brightness in specific tone 
ranges.

Click the arrow buttons to increase or decrease the graph value of the 
active separation(s) for a specified section of the graph. 

If only one separation is active, the gradation values are listed, ranging 
from -50 to 50. If more than one separation is active, no gradation values 
are listed.

Changes to gradation tables are immediately presented as changes to the 
gradation graph.

DefaultGradTable (Input equals Output) Modified gradation graph
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The gradation controls

• Start
Moves the point of origin of the gradation graph at the highlight end 
along the horizontal or vertical axis. This affects the image file from 
0% dot to 100% dot, where the greatest change is at 0% dot.

• Highlight
Changes brightness mainly in the highlights. This affects the image file 
from 0% dot to 50% dot, where the greatest change is at 25% dot.

Start Point Low Start Point High

Highlight Low Highlight High
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• Mid
Changes brightness mainly in the midtones. This affects the image file 
from 15% dot to 85% dot, where the greatest change is at 50% dot.

• Shadow
Changes brightness mainly in the shadows. This affects the image file 
from 50% dot to 100% dot, where the greatest change is at 75% dot.

Mid Low Mid High

Shadow Low Shadow High
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• End
Moves the endpoint of the gradation graph at the shadow end along 
the horizontal or vertical axis. This affects the image file from 0% dot 
to 100% dot, where the greatest change is at 100% dot.

Brightness and Contrast Slider Controls
The Brightness and Contrast slider controls are active only when all of the 
separations are selected.

Brightness

Brightness increases or decreases the luminance of the image. Increasing 
brightness brightens the image and results in a concave curve. Decreasing 
brightness darkens the image and results in a convex curve. 

Move the Brightness slider to the right to increase brightness or to the 
left to decrease brightness.
Or:
Click the arrow button to select a value from the drop-down list.

End Point Low End Point High



Color Tools 363

Contrast

Contrast increases the image contrast by making the highlights lighter and 
the shadows darker. It can also be used to decreases the contrast.

Move the Contrast slider to the right to increase contrast (S shaped 
curve), or to the left to decrease contrast (inverted S shaped curve).
Or:
Click the arrow button to select a value from the drop-down list.

Contrast Center

Contrast increases the image contrast mainly in the midtones. Using 
Contrast Center, you can adjust where the contrast is increased. To 
enhance contrast in highlights, the Contrast Center is shifted toward the 
highlights. To enhance contrast in shadows, the Contrast Center is shifted 
toward the shadows.

Set the image contrast, by adjusting the Contrast slider.
Or:
Set the Contrast Center slider to the right to enhance contrast in 
highlights, or to the left to enhance contrast in shadows.
Or:
Click the arrow button to increase or decrease the Contrast Center 
value. The Contrast Center value appears to right of the Contrast 
Center slider. Your change affects the gradation graph by moving the 
point where the curve changes from convex to concave.

Organizing Gradation Tables
The Gradation window provides a number of options for organizing 
gradation tables, including Reset, Save, Delete and Save As.

If you work only with the default gradation table, the Reset and Save As 
options are activated. This option enables you to use the default gradation 
table as a base on which to build and save new gradation tables. When you 
work on gradation tables other than the default table, Save and Delete also 
become active.

Note:  Contrast Center only affects the image if Contrast has also been 
adjusted.
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The gradation organization options

Click Reset to reset all Gradation window settings. 

The gradation curve is reset to a 45° line. 

Click Delete to delete the selected gradation table. 

Click Save to save the specified gradation settings.

Click Save As to create new gradation tables by saving existing 
gradation tables with new names.

To create a new gradation table:

1. In the Gradations window, modify your gradation table as required.

2. Click Save As. 

The Save As dialog box appears.

3. In the File name box, type the required name for the new gradation 
table. 

4. Click OK. 

The gradation table is saved and added to the Gradation table list and 
to the Job Parameters Gradations list.

Note:  You can not delete the DefaultGradTable.

Note:  You can only save the default gradation table under a new name.

For more information about gradation tables, see Gradation on page 344.
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Printing PrePress Files - GAP Files
The Graphic Art Port (GAP) is a port through which you can import 
various file formats used in the Graphic Arts industry. GAP files are already 
rasterized. The Spire CXP8000 color server only needs to prepare the files 
for printing, which means adjusting the file resolution and rotation. 

Importing GAP Files
To print a specific page, import the assigned file for the specific page. To 
print a specific job, import the assigned file for the specific job. 

Supporting GAP Files
The Spire CXP8000 color server can import and convert the following file 
types:

• Brisque jobs

• TIFF

• TIFF IT

• CT / LW

The system converts these file types to “pre-rasterized” PDF files. GAP 
PDF files behave the same as any other PDF file and have the same job 
parameters.

Note:  While the assigned job file is imported, the file is converted to a PDF file 
that is displayed in the Spire CXP8000 color server queues. The PDF file can be 
programmed and printed as any other PDF file. 

Note:  The Spire CXP8000 color server supports the following GAP file formats, 
pre-separated and composite.
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GAP File Structure

TIFF IT
A TIFF IT file has 3 components:

• CT.TIF

• LW.TIF

• FP (final page) file, which combines CT.TIF and LW.TIF

To import a TIFF IT file to the Spire CXP8000 color server, first import the 
FP file. During import, the file is converted to a PDF, which is displayed in 
the Spire CXP8000 color server queues. The PDF can be programmed and 
printed as any other PDF file.

CT, LW, TIFF
The components of a Brisque job and TIFF IT, are, CT, LW and TIFF, and 
can be imported and printed separately to the Spire CXP8000 color server.

Rasterized Brisque Jobs
All rasterized Brisque jobs have a typical structure. Each job contains an 
assigned file with one or more pages (in case of a multiple job). Also, every 
page contains its own assigned file, which combines LW and CT.

• To import a Brisque job to the Spire CXP8000 color server, import the 
assigned file of the job.

• To print a specific page, import the assigned file of the specific page.

Note:  Make sure that in the Spire CXP8000 color server Import window, Gap 
files is selected in the Files of type box.
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Preflight Check

The Preflight parameter enables you to check the status of key job 
components before the job is sent for printing. 

During the preflight check, your job is RIPed and the missing components 
are identified. The preflight detects the status for the following key job 
components:

• High-resolution images or the wrong links to the high-resolution 
images folder

• Missing fonts

• Spot colors that are not defined in the Spire CXP8000 color server spot 
color dictionary

• Dynamic exception commands for a file that was submitted via a 
dynamic page exceptions virtual printer

Note:  You can only run a preflight check on PostScript jobs.

Note:   If a job component is missing, the job will fail before it is RIPed and an 
alert message will appear. Information about missing components will appear in 
the Job History window.
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The results of the preflight check are displayed in a Preflight Report. By 
default, a preflight report is not issued for each job. To issue this report, 
you need to run a preflight check for the job using the Preflight job 
parameter.

To run a preflight check:

In the Preflight options area, select Run Preflight check.

All four check boxes of the key job components are active but you can 
clear any check box that you don’t want to include in the preflight 
check. 

Preflight Report
The preflight report is a job-related report that provides information 
about the status (missing or found) of key job components prior to 
printing and enables you to correct your files accordingly.

It is especially useful to run the preflight check before you print a complex 
job with a large quantity of pages or copies. The preflight check detects the 
missing job components and displays them all at once in the Preflight 
Report dialog box. You can review the report and handle the missing 
components and thus save inefficient printing time with constant error or 
failed messages.

If you run a preflight check, and all key components are found, the job is 
processed and printed according to the job flow you have selected. If the 
test fails (missing key elements are detected), the job is returned to the 
Storage window with the preflight report available for inspection.

The preflight report always reflects the last preflight run, if more than one 
preflight check is run on a job, the latest preflight report overrides the 
previous. When a preflight report is produced, the date and time of the 
preflight check are indicated in the Jobs History window.

Note:  If one of the selected elements on the list is missing, the job status at 
the end of the preflight check is “Failed” and the job is transferred to the 
Storage window.

Note:  Since the Preflight Report dialog box lists all key job components (missing 
and found), you can choose to use this report to view the existing (found) key job 
components, for example the list of the existing fonts in a job, and their 
corresponding paths.
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To view the preflight report:

1. Right-click the job in the Storage window, and from the menu select 
Preflight Report.

The Preflight Report dialog box appears. If you selected the HiRes files 
option in the Preflight Options area, the HiRes Report appears first.

If there are key components in the job not found, this will be indicated 
by the missing indicator next to the HiRes, Spot Colors, and Fonts 
report options.

If you did not select a preflight option for the preflight check, the not 
preflighted indicator appears next to the report option. 

If all of the files are found for a preflight option, the found indicator 
appears next to the report option.

2. From the Show list select one of the following options:

• To display all files, select All.

• To display only files that were found, select Found Only.

• To display only the missing files, select All Missing.
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3. Select the Spot Colors report option.

The Spot Colors Report area displays the missing spot color names 
(spot colors which were not found in the spot color dictionary) and 
the found spot color names (spot colors which were found in the spot 
color dictionary). The C,M,Y,K columns display the spot color CMYK 
equivalences:

If the status is missing the Spire CXP8000 color server used the 
original CMYK values that are embedded in the PS file to emulate 
the desired spot color.

If the status is found the Spire CXP8000 color server used the 
CMYK values that are in the spot color dictionary.
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4. Click the Fonts report option.

The Font Report area displays the name of the missing fonts that are 
not embedded in the file and do not exist in the Font Library and also 
the found fonts.

The Source column indicates whether the font is embedded in the file 
or was found in the Font Library.
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5. Click the Dynamic Exceptions report option.

The Dynamic Exceptions area displays the dynamic page exception 
commands found in the file. 

6. To save the preflight report, click Save and browse to the desired 
location.

7. To print the report, click Print.

Export as Creo Synapse InSite Job
Creo Synapse InSite™ provides an Internet-based communication 
between you and your customers and enables you to proof jobs and receive 
approvals remotely. 

If your site includes a Creo Synapse InSite server, exporting your job as 
InSite from the Spire CXP8000 color server allows you and your customers 
to proof online with geographically dispersed users simultaneously, 
append annotations or comments, and approve or reject pages over the 
World Wide Web using a standard browser.

For more information about dynamic page exceptions, see Dynamic Page 
Exceptions on page 275.

Tip:  If more than one preflight check is run on a job, the latest preflight 
report overrides the previous. If desired you may save the report for future 
usage.
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After the RTP job is created on the Spire CXP8000 color server, it can be 
exported as InSite from the Storage window. When the customer logs on 
(using their unique username and password), they see the status of their 
jobs, view a thumbnail of all pages in each job, and quickly identify which 
pages require further corrections. The customer can measure color 
density, make annotated comments, and approve pages. The online 
proofing cycle is shortened and accurate, and consequently, the need for 
reprints is reduced.

To export as InSite:

1. Select the desired job in the Spire CXP8000 color server Storage 
window.

2. Right-click the job, and from the menu select Export as InSite Job.

The InSite window appears.

3. Locate the file in which you want to export the job, and then click 
Export.

A Brisque job is created in the selected location. You can now register 
the files on the InSite server and start the approval cycle.
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VI Overview
Variable information (VI) jobs are jobs in which the printed materials are 
individualized for specific recipients or purposes. These materials can 
include bills, targeted advertising, and direct mailings.

VI jobs are composed of booklets, which are personalized copies of a 
document. A booklet can consist of one or several pages, but the entire 
document is targeted at a specific individual or address. For example, a 
booklet can be either a single-page gas bill or a multipage personalized 
document.

Each page in the booklet is constructed as a collection of individually 
RIPed elements that may differ from booklet to booklet, including text, 
graphics, pictures and page backgrounds. These elements are self-
contained graphical entities that may be line art, text, RIPed images, or a 
combination of these. There are two types of elements in VI jobs:

• Unique elements are used only once for a specific individual or 
purpose. An individual’s name is an example of a unique element.

• Reusable VI elements can be used more than once in different pages, 
booklets, or jobs. A company logo is an example of a reusable element.

On the Spire CXP8000 color server, each element, text, graphic, picture, or 
page background is RIPed only once, even if the element is used once, 
several times, or in every page of the VI job. If it is used more than once, 
then it is cached, or stored, for further use. You can manage these elements 
in the Resource Center under the Cached VI Elements area. Each set of 
elements associated with a particular job is assigned a unique name. Inline 
variable elements that are used only once, usually text, are not cached. 

Pages are assembled from the pre-RIPed reusable elements and the RIPed 
unique elements just before printing. Then the job is printed in the same 
way as all other jobs in an RTP format.

For more information about cached VI elements, see Managing VI Elements on 
page 385.
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VI Document Formats
VI jobs are created using VI authoring programs that support Variable 
Print Specification and VIPP formats. Most VI authoring programs can 
convert VI files to conventional PS files, which can also be processed by the 
Spire CXP8000 color server, although less efficiently than Variable Print 
Specification and VIPP files. Each authoring program creates VI code that 
instructs the RIP where to place the VI elements and each authoring 
program does so in a slightly different manner.

The format you choose can be a stand-alone format that covers all aspects 
of document design, data management and text capture or it can be an 
extension of an existing program that enables the creation of VI 
documents and VI jobs.

The Spire CXP8000 color server can process VI jobs that are in one of the 
following file formats:

• Creo Variable Print Specification

• Xerox Variable data Intelligent Postscript Printware (VIPP)

• Personal Print Markup Language (PPML)

• PostScript.

Note:  Variable Print Specification, VIPP, and PPML elements are displayed in the 
Resource Center under the Cached VI Elements area. 
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Creo Variable Print Specification
Creo Variable Print Specification is the Creo developed formal language 
designed for effective production of VI documents.

Creo Variable Print Specification is comprehensive and can specify a 
complete range of VI documents. It also provides the means for efficient 
implementation - fast and efficient data processing, and storage prior to 
printing.

A Variable Print Specification job consists of the following components: 

• Booklet
A personalized copy of a document within a single print run where 
pages and/or elements within a page may vary from booklet to booklet.

• Sub-job
All copies of a particular document—for example, book, brochure, or 
flyer—within a single print run. On the Spire CXP8000 color server, 
sub-jobs can be deleted, archived, or reprinted at any time. However, 
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you can still maintain reusable elements for future runs. Reusable 
elements are cached elsewhere, so only the unique data, which is 
embedded in the job, is deleted.

• Reusable Elements
Self-contained graphical entities that can be line art, text, raster images 
or a combination of these types. Reusable elements are represented in 
PostScript and can be stored as EPS files when appropriate. Reusable 
elements include clipping and scaling instructions as well as the image 
data.

Reusable elements can be used repeatedly in different pages, booklets 
and jobs. On the Spire CXP8000 color server, all reusable elements are 
processed once and cached as RTP elements for further use. They can 
then be reused either within the sub-job itself, or in additional runs of 
sub-jobs.

• Inline Elements 
Unique information is drawn from a database and is embedded in the 
sub-job. This data prints only once for individual booklets.

VIPP 
The VIPP format was developed in 1993 by Xerox. The VIPP is a 
PostScript-based format that merges the VI pages during the processing 
stage. The VIPP is used mostly for financial applications, which typically 
employ the dynamic graph charting capability of VIPP, and for bank 
statements, telephone bills, and electric bills.

Note:  Grayscale TIFF and EPS images that are created in CMYK applications 
(such as PhotoShop) are counted correctly as B&W instead of Color in both 
the Spire CXP8000 color server and the Xerox DocuColor 8000 Digital Color 
Press billing meters.

Note:  To use VIPP files on your Spire CXP8000 color server, you first need to 
install the VIPP software on your system. This installation should be done by a 
service engineer. Contact your service provider for more information.
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VIPP jobs are composed of the following four files:

VIPP software creates xgf and xgfc folders on your system. Within the xgfc 
folder, a number of sub-folders are created. Table 16 lists in which sub-
folders you should store VIPP job files.

To print a VIPP job:

Import the *.DBF file to the Spire CXP8000 color server. 

The VIPP job is processed and printed.

Table 15: VIPP files

File Name File Description

File.PS The PostScript Master Form, which holds 
all of the fixed elements from the original 
document.

File.JDT The Job Descriptor Ticket, which holds 
header and setup information for the job.

File.DBM The Database Master, which holds the VIPP 
coding.

File.DBF The Database File, which holds all the 
ASCII data to be merged. It should contain 
database information taken from the range 
of database records that were specified in 
the DataMerge dialog.

Table 16: VIPP sub-folders

File Name Store in VIPP Sub-folder

File.PS formlib

File.JDT jdtlib

File.DBM formlib

File.DBF mislib

Variable Image Files imglib
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VIPP 2001 and PPML
The PPML format is a new XML-based industry standard that print-
technology manufacturers developed for the high-speed production of 
reusable page content.

The Spire CXP8000 color server supports VIPP 2001 and PPML formats. 
Some of the features that are included enable you to:

• Process VIPP 2001 and PPML jobs efficiently

• Manage VIPP 2001 and PPML reusable elements

• Import jobs in various VI formats to the Spire CXP8000 color server 

• Import VI elements to the Spire CXP8000 color server and submit 
them for pre-cache

• View VI elements in their structural hierarchy

Both PPML and VIPP 2001 have a hierarchical structure. Document 
components are separated from their submission file and can be organized 
and stored in different levels of the hierarchical structure.

In PPML there is an ability to store different jobs in one PPML file. Thus, 
the display in the navigation pane varies from the way Variable Print 
Specification and VIPP appears.

PostScript Files
PostScript files are suitable for simple, very short run jobs. All page 
elements are re-RIPed for each page. These jobs do not use a VI authoring 
tool at all. Instead, they use a mailmerge function in a Microsoft Word 
document or a Microsoft Excel spreadsheet.

Using Creo Variable Print Specification to Print a VI Job
The Spire CXP8000 color server first searches for high-resolution files in 
the input folder that contains the PDL file, and then in the predefined APR 
path—D:\Shared\High Res. The Spire CXP8000 color server will look for 
VI images in these locations when it RIPs the job.

Note:   You can also define a custom path to any connected server or disk. For 
more information about adding an APR path, see Setting a High-Resolution Path 
on page 250.
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To print a VI job:

1. Copy VI graphic elements to one of the defined APR folders on the 
Spire CXP8000 color server. 

2. Submit your job to the Spire CXP8000 color server.

Reusable elements are identified, processed, and placed in the Resource 
Center under the CachedVI Elements area. They are ready for rapid 
assembly into pages and for reuse during the printing stage.

Your VI job is processed and printed on the Spire CXP8000 color server. 
The Xerox DocuColor 8000 Digital Color Press prints RTP booklets at full 
engine speed working uninterrupted from the printer disk. Booklets are 
compiled concurrently while the printer prints. As pages are sent to the 
print engine, they are assembled from the various inline and reusable 
elements on-the-fly.

After the job is completed, an RTP job is placed in the Storage window. 
This RTP job contains the complete variable job including all booklets, 
variable images, and unique elements.

Useful VI Print Options

Gallop
The Gallop parameter on the Print Settings tab enables the Spire CXP8000 
color server to RIP and print VI jobs concurrently. Large jobs do not have 
to be RIPed entirely to disk before printing. You can predefine the number 
of pages to be processed before the engine starts to print. As soon as these 
pages are processed, printing starts while the rest of the job is streamlined 

For more information about how to import files, see Importing Files on 
page 154.

Notes:

• If an element is to be used more than once but with different clipping or 
scaling parameters, it is treated as a new page element and processed again.

• The cache is kept intact until the job is completed. This enables you to reuse 
RIPed elements anywhere in the job. Elements may remain in the cache for 
subsequent jobs. You can also archive job elements.

• Deleting a job does not delete the cached job sub-folder. This must be done 
manually in the Resource Center.
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through the Spire CXP8000 color server. The Xerox DocuColor 8000 
Digital Color Press continues printing at its rated speed without 
interruption or slowing down until the job is finished.

Job Deletion

When you are printing a large VI job that takes up a substantial amount of 
the Spire CXP8000 color server disk space, it is recommended that you use 
the Job Deletion parameter.

When you select this parameter, the Spire CXP8000 color server deletes 
each page on the fly once it has been successfully printed. In this way, the 
Spire CXP8000 color server maintains enough free disk space for the 
duration of the print run. Reusable elements are not deleted.

For more information about setting the Gallop option, see Gallop on page 165.

Notes:

• This option sustains enough free disk space for the duration of the print run 
and only affects the sub-job. 

• The Variable Print Specification file is also deleted.
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To set a deletion policy:

1. Suspend the Process Queue and import your job.

2. Double-click your job to open the Job Parameters window.

3. Select the Services tab.

4. In the Automatic deletion options area, select one of the following 
options:

• To remove pages or jobs from the Spire CXP8000 color server after 
printing is completed, select Delete after complete.

• To remove failed jobs while processing or printing from the Spire 
CXP8000 color server, select Delete on job failure.

5. Click Save. 

6. Select the resume button to resume the Process Queue and start the 
processing of your job.

Imposition
When you impose VI jobs:

• Every booklet must have the same number of pages 

• When you use the Step & Repeat method to print a single page 
booklet, the VI job does not print the same image repeatedly. Several 
booklets are printed on the same sheet and each record is printed on 
the sheet once.

For a booklet with several pages, the pages are printed in order along 
the length of the sheet. The next booklet is printed beside the first. After 
the sheets are cut, the booklets are aligned with their pages in the 
proper order.
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Managing VI Elements
When the Spire CXP8000 color server processes your VI job, it stores the 
reusable VI elements in a specific location. When the job is printed, the 
RIP engine looks for the VI elements in that locations and reuses the 
elements when necessary. The VI elements can also be reused in future 
jobs.

In the Resource Center, use the Cached VI Elements area to manage the VI 
elements on your system and to perform the following tasks:

• Delete VI elements

• Archive VI elements

• Retrieve VI elements

Note:  The above example uses the step and repeat method. There are no 
special considerations for VI jobs using saddle stitch and perfect bound 
methods.

For more information about setting Imposition parameters, see The 
Imposition Tab on page 227.
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Deleting VI Elements
VI elements that are no longer in use take up valuable disk space on the 
Spire CXP8000 color server. To free up disk space, you can delete the VI 
elements you no longer need.

1. On the toolbar, click Resource Center. 

2. In the Resource list, select Cached VI Elements.

Your VI jobs are listed in the left pane. In the right pane, you can see 
all of the VI elements that are associated with your job. In addition, a 
thumbnail viewer lets you check elements visually.

3. Select the element that you want to delete, and then click Delete.

Note:  You can also delete the entire folder.
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Archiving VI Elements
If you have finished printing a large VI job and you know that you will 
need to reprint it in the future, it is a good idea to archive the VI elements 
and retrieve them when needed. You can archive your VI job folder in a 
location that you specify.

1. On the toolbar, click Resource Center. 

1. In the Resource list, select Cached VI Elements.

2. Select the VI folder in which to archive, and then click Archive.

The Open dialog box appears.

3. Find the location in which to archive your VI elements, and then click 
Archive.

Retrieving VI Elements
When you need to reprint your job, you can retrieve the VI elements from 
the archive.

1. From the Job menu, select Retrieve from Archive.

The Open dialog box appears.
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2. Select the folder in which your VI elements are archived.

3. Select the desired file and then click the add button.

4. Click Retrieve.

The Spire CXP8000 color server retrieves the archived VI elements and 
displays them at the end of the file list in the Cached VI elements 
dialog box.

Note:  Use SHIFT or CTRL to select several files or CTRL+A to select all the files. 
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Applying VI Structure to Large Files (Split to Booklets)

The Split to booklets parameter enables you to split a PostScript, PDF, or 
large VI job that does not have a booklet structure into booklets. 

If you split a VI, PostScript, or PDF job into booklets, you can simulate the 
VI job structure. If your VI, PostScript, or PDF job contains variable 
information, setting the imposition method per booklet, the stapling 
options per booklet, and using duplex printing per booklet is a more 
efficient way to manage your job. Duplex printing will automatically insert 
blank pages if the number of pages per booklet is an odd number.

To split a job to booklets:

1. In the Split to booklets options area, select Yes.

2. In the Number of pages per booklet box, type the desired number.

Note:  A VI job that doesn’t have a booklet structure can be split to booklets 
using this feature. Unexpected results might occur when you use this option for 
VI jobs that already have a booklet structure.

Note:  If the specified number of pages per booklet is not sufficient to 
produce complete booklets and there is a remainder of pages, the last pages 
will form a booklet that contains less pages then specified.
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Setting Up and Configuring the Spire CXP8000 Color Server
Basic system configuration and settings are defined in the Spire CXP8000 
color server Settings window. The Settings window contains items that 
enable you to manage your system.

To open the Settings window:

From the Tools menu select Settings.

The Settings window appears. The settings are divided into two lists: 
Administration and Preferences. Both lists are explained in the 
following sections.

Administration items can be viewed by users of all levels, but are only 
available to users of Administrator level. Preferences items can be 
viewed by all user levels, but are only available to users of Administrator 
and Operator user levels. All items in the Settings window are view only 
to Guest users.

Server Setup
Set the server’s name and the current date and time in Server Setup.
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Changing the Server Name
1. In the Settings window, select Administration>Server Setup.

2. In the Server Name area, click Change.

The System Properties dialog box appears.

3. In the Network Identification tab, click Properties.

The Identification Changes dialog box appears.
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4. In the Computer Name box, type a new name for the computer. 

5. If you want to change the Workgroup or the Domain in which your 
computer appears, select the desired option and type a new name in 
the corresponding box.

6. Click OK.

7. Click OK in the System Properties window.

The system prompts you to reboot your computer for the new settings 
to take effect. 

8. Click No if you want to change other system parameters, or click Yes 
and reboot your computer.

Changing the Date and Time
1. In the Settings window, select Administration>Server Setup.

2. In the Date & Time area, click Change.

The Date/Time Properties dialog box appears.

3. In the Date & Time tab, select your local time settings.

Note:  Do not change the workgroup or domain unless you are instructed to 
do so.

Important:  If you want to change the domain, you will be required to type 
the password for the domain account. If the password is unavailable, the 
computer will be locked.
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4. Select the Time Zone tab and set the correct time zone.

5. Click OK.

Network Setup
The IPX Printing settings, TCP/IP settings and the Apple Talk Setup settings 
are set in the Network Setup parameter.
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IPX Printing
IPX Printing enables the Spire CXP8000 color server to act as a job server 
for the Novell queue. A job server checks each assigned queue at a specified 
interval, taking care of jobs on a first-in, first-out basis. Once a job is 
processed, its associated file is deleted from the queue directory.

To set the Spire CXP8000 color server IPX parameter:

1. In the Settings window, select Administration>Network Setup.

2. In the IPX Printing area, click Change Settings next to the Tree 
parameter.

The Local Area Connection Properties dialog box appears, followed by 
the NWLink IPX/SPX Properties dialog box.

3. To change the frame type, select a frame type from the Frame type list, 
then click OK.

4. Click OK also in the Local Area Connection Properties window.

You are prompted to restart your computer. 

5. Click No if you need to make more changes, or Yes to reboot.

Note:  Using this procedure requires further setup by the network 
administrator.
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TCP/IP Setup
The Spire CXP8000 color server is predefined with a default IP address. 
The TCP/IP option enables you to change this IP address and other TCP/
IP settings.

To change the TCP/IP network settings:

1. In the Settings window, select Administration>Network Setup.

2. In the TCP/IP area, click Change Settings next to the IP Address 
parameter.

The Local Area Connection Properties dialog box appears, followed by 
the Internet Protocol (TCP/IP) dialog box.

3. Change the IP Address by selecting Obtain an IP address 
automatically.
Or:
Select Use the following IP address and type the desired address—for 
example, IP address:192.168.62.1 and Subnet mask:255.255.255.0.

4. Click OK.

Note:  Before changing the network settings, consult your System Administrator.
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5. Click OK in the Local Area Connection Properties window.

You are prompted to restart your computer. 

6. Click No if you need to make more changes, or Yes to reboot.

Apple Talk Setup
The AppleTalk Setup utility enables you to change the AppleTalk zone in 
which your Spire CXP8000 color server is located.

To change the Apple Talk network settings:

1. In the Settings window, select Administration>Network Setup.

2. In the Apple Talk Setup area, click Change Settings next to the The 
System will appear in zone parameter.

The Local Area Connection Properties dialog box appears, followed by 
the AppleTalk Protocol Properties dialog box.

3. From the zone list, select the desired AppleTalk zone for your 
computer, and click OK.
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Remote Tools Setup
The Remote Tools Setup includes setup for the Remote Admin tool and 
enables the connection of clients to the Spire CXP8000 color server over 
the network using the Spire Web Center.

Remote Admin
The Remote Admin utility enables the System Administrator to connect, 
view, operate and perform administration actions on the Spire CXP8000 
color server from his client workstation. While this remote connection and 
operation takes place, the regular operation of the Spire CXP8000 color 
server is not affected. In fact, the only indication the spire operator has that 
such connection takes place, is in the DFE and Printer Animation and in 
DFE Monitor window.

The following graphic shows the DFE and Printer Animation as it is 
presented when the remote session is active.

To secure the remote connection, a password should be assigned by the 
System Administrator. 

The remote admin setup process includes the following stages:

1. On the Spire CXP8000 color server: 
The remote admin service is enabled and a password is assigned.

2. On the System Administrator’s station: 
The client program is downloaded and launched.

To enable the remote admin service and set a password:

1. In the Settings window, select Administration>Remote Tools Setup.

2. In the Remote Tools Setup area, select Enable RemoteAdmin Service.

Note:  This tool is designed for the exclusive usage of the System Administrator. 
Clients who would like to connect to the Spire CXP8000 color server from their 
workstations may do so by using the Spire Web Center, which enables you to 
view and monitor your jobs in the Spire CXP8000 color server queues.

For more information about viewing and monitoring your jobs from a client 
workstation, see Spire Web Center on page 76.
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3. In the Password box, type a password.

4. Click Save.

To download and launch the Remote Admin Client application:

1. From the System Administrator workstation, connect to the desired 
Spire CXP8000 color server, and from the Utilities folder (related to 
your computer type, Windows or Macintosh) double-click 
SpireRemoteAdmin.exe.

When the installation is complete, the Login window appears.

Note:  This password will be used later on to connect to the Remote Admin 
application from the System Administrator workstation.

Tip:  You can also download the application from the Spire Web Center 
under Downloads. 
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2. From the Spire Server list, select the desired Spire CXP8000 color 
server.

3. Click OK.

The next Login window appears.

4. In the Session password box, type the password you have previously 
created in the Remote Tools Setup window.

5. Click OK.

The Spire CXP8000 color server workspace appears on your screen 
and you can perform any desired action.

Web Connect Setup
The Web Connect Setup enables clients to connect to the Spire CXP8000 
color server over the network by using the Spire Web Center. This 
possibility is disabled by default.

For more information about viewing and monitoring your jobs from a client 
workstation, see Spire Web Center on page 76.
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To enable web connections:

1. In the Settings window, select Administration>Remote Tools Setup.

2. In the Web Connect Setup area, select Enable Web Viewer.

Security
The user Passwords and Disk Wipe settings are set in Security.

User Passwords

To set Password settings:

1. In the Settings window, select Administration>Security.

2. Select Auto Log On to enable users to log on automatically. 

3. Select Disable Guest Connection to prevent Guest users from 
accessing the Spire CXP8000 color server.

Note:  This option is not available if you selected the Auto Log On option.
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To change Administrator/Operator passwords:

1. In the Settings window, select Administration>Security.

2. In the Administrator/Operator area, enter the old password.

3. Enter the new password.

4. Verify the new password.

5. Click Apply and Save in the Settings window.

The password is changed and the Settings window closes.

Disk Wipe
Usually when you delete a file, the file’s dictionary entry is removed but 
data still remains on the disk. The Disk Wipe utility enables you to clear 
previously deleted files. The utility eliminates the contents of your deleted 
files by scanning all of the empty sectors on the disk and replacing them 
with zeros. Nonempty sectors are left untouched. This feature enables you 
to work in a more secure environment. If there is a system shutdown, the 
disk wipe operation can begin immediately.

To operate the Spire Disk Wipe utility:

1. In the Settings window, select Administration>Security.

2. To enable the disk wipe feature, select Wipe disk on system 
shutdown.

3. Exit the Spire Color Server application.

4. On the Windows desktop, double-click My Computer, and then select 
D:\Utilities\PC Utilities\Disk Wipe.

5. To install the utility, double-click the Disk Wipe installer icon.

The Disk Wipe utility icon appears on the Spire CXP8000 color server 
desktop.

6. Double-click the Disk Wipe utility icon.

The Disk Wipe utility appears.
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7. To start the disk wipe operation, click Start Wiping.

A progress bar appears while the disk wipe operation permanently 
deletes files. 

8. Close the Disk Wipe application when the operation finishes.

System Disks
When the Printer or User Disks reach a pre-defined threshold of minimum 
available space (the default is 250 MB), RIP is suspended and the system 
provides a warning message. The RIP will resume automatically only after 
disk space is available. 

Notes:

• The disk wipe operation does not function well when the Norton Utilities 
application is installed. Before you activate the Disk Wipe utility, make sure 
that Norton Utilities is not installed on the Spire CXP8000 color server.

• In rare cases, the process of deleting files from the Storage window is not 
completed—for example, the system shuts down before the deletion process 
is completed. In these cases, parts of the deleted files still reside in the 
D\:Output folder. Therefore, it is recommended that before you start the 
disk wipe operation, check the D\:Output folder to ensure that all the 
relevant files were deleted.

• The Disk Wipe utility affects the user disk and printer disk.

• Do not operate the Disk Wipe utility while another application is running.

• The supported language is English.
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To set the system disks threshold:

1. In the Settings window, select Administration>System Disks.

2. In the System Disks area, set the minimum free disk space desired for 
RIP.

Backing up the Configuration
The Configuration Backup item enables you to backup your Spire 
CXP8000 color server configuration to a local hard disk, to a network drive 
or to an external media—for example, an external zip drive—connected to 
the Spire CXP8000 color server.
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Configuration Backup

To backup the configuration of your Spire CXP8000 color server:

1. In the Settings window, select Administration>Configuration Backup.

2. In the Configuration Backup area, click Browse.

The Save window appears.
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3. Browse to the desired directory path for the backup.

4. Click Save.

5. In the Settings window, click Start Backup.

Configuration Restore

To restore the configuration of your Spire CXP8000 color server:

1. In the Settings window, select Administration>Configuration Backup.

2. In the Restore Configuration area, click Browse and locate a different 
directory path in which to restore the configuration.

3. Click Start Restore.

Note:  You can also backup to an external media.

Note:  The last path will be saved and displayed to the path box. If the 
backup was made to an external media, the displayed path will be the 
default: C:/CXP000/General/Configuration.

Notes:

• The configuration files name will always be: "SpireConf.Cab" (Cabinet 
file.)

• You may also restore the configuration from an external media.
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The Restore Configuration window appears.

4. Select the categories you want to restore, and click OK.

The following message appears:

5. Click Yes if you would like the restored files to replace the current 
ones. Click No if you do not want the restored files to replace the 
existing files.

Note:  When restoring the configuration all the custom tables/sets are 
added to the system (for example imported user-defined imposition 
templates, new virtual printers, downloaded fonts etc.

Note:  The Restore Configuration date is updated in the Configuration 
Backup window.
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Localization
The Localization measurements and the Language are set in the 
Localization parameter.

Setting the Localization Measurement
1. In the Settings window, select Preferences>Localization.

2. In the Localization area, select Millimeters or Inches, as desired.

Setting the Language
1. In the Settings window, select Preferences>Localization.

2. In the Language area, select the language, as desired.

Note:  If you switch to another language, you need to restart the Spire CXP8000 
color server application.
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Pre-RIP Preview
1. In the Settings window, select Preferences>Pre-RIP Preview.

2. In the PS Preview area, select your choice: 

• Save as PDF: to save the file as PDF

• Return to original PS file: to return to the original PS file

3. In the VI Job Preview area, select the desired number of booklets for 
pre-RIP preview.
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General Defaults

1. In the Settings window, select Preferences>General Defaults.

2. In the Default Image Size area, select the Size.

3. Select the desired OPI setting.

4. Select the Default Archive Path.

5. Set the Custom Paper Function to On or Off, as desired.

6. By default, the OCT Offset between jobs check box is selected, 
meaning offset is always done between jobs. Clear the check box if you 
do not require this option.

Print Queue Manager
The Job Batching and Held Jobs Policy options are set in the Print Queue 
Manager parameter.

For more information about setting the OPI, see OPI on page 252.

For more information on the default archive path, see Archiving and 
Retrieving Jobs on page 200.
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The Job Batching utility enables you to print several jobs with the same 
settings in a batch, one after the other without the cycle down, and 
consequently save production time.

To set the desired job batching option:

1. In the Settings window, select Preferences>Print Queue Manager.

2. Select Enable Job Batching to print jobs with the same page 
parameters, one after the other without the cycle down.

Or:
Select Disable Job Batching to disable the printing of jobs with the 
same page orientation, one after the other, and enable cycle down.

For more information about job batching, see Batching Jobs on page 191.
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To set the desired held jobs option:

In the Held Jobs Policy area, select Bypass held jobs, to bypass frozen 
jobs in the In Print queue.
Or:
Select Don’t Bypass held jobs to stop the printing from the queue 
when a job is assigned a frozen status.

Color
The Calibration Method, Emulations, Automatic Screening, Color 
conversion tables, and Calibration Reminder settings are set in Color.

Calibration
For more information on setting the calibration method, see Color Calibration 
Methods on page 309.
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Emulations
Using this utility, you can select the desired emulation method: 

• Device Link (default)

• CSA

To specify the emulation method:

1. In the Settings window, select Preferences>Color.

2. In the Emulation area, select the desired emulation method from the 
list.

Automatic Screening
The Spire CXP8000 color server supports Dot and Stochastic screening. 
When you print a job from the Spire CXP8000 color server, select the 
desired screening method or choose Automatic in the Color parameter of 
the Settings window. By default, Automatic applies two types of screens:

• For CT (Continuous Tone):
The system uses Dot type screen of Dot 200.

• For text / line-art elements - LW (Line Work):
The system uses Line type screen of Line 200.

To change the values of the automatic screening method:

1. In the Settings window, access Preferences>Color.

2. In the Automatic Screening area, select the desired Auto screen 
settings for LW from the LW list.

3. Select the desired Auto screen settings for CT from the CT list.

You are prompted to restart the application for the new settings to take 
effect.

Note:  The emulation profiles that are displayed in the Job Parameters window 
are related to the chosen emulation method.
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Color Conversion Tables
The Color Conversion Tables utility enables you to select the set of color 
conversion tables used for your jobs. 

To select the color conversion tables:

1. In the Settings window, select Preferences>Color.

2. In the Color conversion tables area, select the conversion table to be 
used.

By default the current version color tables are selected. To apply the 
previous version color tables, select Previous version color tables.
The following message appears.

3. Click OK.

Calibration Reminder
Set the Calibration Reminder to remind you when to perform a calibration.

1. In the Settings window, select Preferences>Color.

2. In the Calibration Reminder area, select the Set calibration reminder 
every (Hours) check box and select the number of hours in the list.

 The calibration reminder indicator appears when it is time to 
calibrate.

Important:  The Process queue needs to be suspended while changing the 
color tables set.
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Messages
The Alert Messages, Accounting Log Setup, and Message Viewer Log 
Setup settings are set in Messages.

Alert Messages
The Alert Messages utility enables you to select whether the Alerts window 
will open automatically, or not, when an error occurs.

To set the Alerts window settings:

1. In the Settings window, select Preferences>Messages.

2. In the Alert Messages area, select Launch Alerts window 
automatically on new error (default).

If you would like to open the Alerts window upon selection only, select 
Launch Alerts window on user selection only.
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Accounting Log Setup
By default, all the jobs that were handled during the past 90 days are listed 
in the Spire CXP8000 color server Accounting window. This utility enables 
you to specify different values for how long information remains before 
being overwritten.

To setup the accounting log:

1. In the Settings window, select Preferences>Messages.

2. In the Accounting Log Setup area, select the desired value to 
Overwrite messages after. 

3. To remove all the existing information from the windows, whenever 
desired, click Clear Log Now.

Message Viewer Log Setup
By default, all the jobs that were handled during the past 90 days are listed 
in the Spire CXP8000 color server Message Viewer. This utility enables you 
to specify different values for how long information remains before being 
overwritten.

To setup the message viewer log:

1. In the Settings window, select Preferences>Messages.

2. In the Message Viewer Log Setup area, select the desired value to 
Overwrite messages after. 

3. To remove all the existing information from the windows, whenever 
desired, click Clear Log Now.

Note:  For more information about the Accounting window, see Viewing 
the Accounting Information on page 213.

Note:  For more information about the Message Viewer, see Viewing the 
Accounting Information on page 213.
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View Configuration
The View Configuration utility enables you to view the configuration of 
your Spire CXP8000 color server and to print it to any printer on the 
network connected to your Spire CXP8000 color server. In addition you 
can save the configuration in the network or export it to an external media 
as a text file.

To view the configuration:

1. In the Settings window, select Preferences>View Configuration.

2. Click Print to print the configuration.

The Print window appears.

3. From the Printer list, select one of the defined printers and click OK.

4. If you would like to save the configuration click Export.

The Save window appears.
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5. Locate the desired folder, and click Save.

System Messages
While jobs are being handled by the Spire CXP8000 color server, various 
messages are emitted. You can view the messages of each job in the Job 
History window, of the entire session in the Message Viewer window, or 
just the error messages within the Alerts window.

The Alerts Window
By default, the Alerts window is open in the Spire CXP8000 color server 
workspace. Any time the system emits an Error type message, the message 
appears in the Alerts window. The Alerts window lists all the error 
messages that were generated during the workflow (the total number of 
messages is also indicated). 

From the View menu, select Alerts.

The Alerts window appears, listing all the Error messages that were 
generated during the workflow. 

Note:  You can specify whether you would like the Alert window to launch 
automatically on a new error, or upon user selection only. To set the preferred 
option, see Alert Messages on page 416.
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To delete messages from the Alerts window:

Select the message(s) you want to delete and click Clear. 
Or:
Click the Clear All button to remove all messages.

System Disks Threshold Message
When the Printer or User Disks reach a pre-defined minimum available 
space threshold (usually of 250 MB), RIP is suspended and the system 
provides a warning message. The RIP resumes automatically only after disk 
space is available. In this case, you may increase the System Disk threshold.

Note:  By default, new messages are shown at the top of the list. For each 
message, the origin of the message is indicated, and a task that will solve the 
problem is suggested.

Note:  Cleared messages are not removed from the Message Viewer or from 
related Job History windows.

For more information about setting the system disks threshold, see System Disks 
on page 404.
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Job History

To view the job history:

Right-click a job in the Queues window or in the Storage window, and 
from the menu select Job History.
Or:
Select a job and from the Job menu select Job History.

The Job History window appears, listing all the messages that were 
generated during the workflow of the selected job. 
The Job History window indicates the job title and the sender name 
(the user name of the system from which the job originated).

Message Information
For each message, the following information is indicated by default:

• An icon denoting the type of message (Error, Warning, or 
Information)

• The date and time on which the message was emitted (the time stamp)

• The stage in the workflow (for example, Print or Process)

• The message text

You may filter the messages by type, and/or sort the list by one of the 
column headers. 
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The Message Viewer

To open the Message Viewer:

At any stage of work, from the Tools menu, select Message Viewer.

The Message Viewer window appears, listing all the messages that were 
generated during the workflow. 

By default, all the jobs that were handled during the last 3 months (90 
days) are listed. 

Managing Messages
You can filter the messages by type, and/or sort the list by one of the 
column headers. In addition, you may print the list of messages.

If desired, you may reorder and resize columns, filter the list or sort the list 
by one of its column headers.

For more information about viewing messages related to a specific job, see 
Job History on page 421.

The default may be changed in the Settings window under Messages. For 
more information about changing the default setting, see Messages on 
page 416.

Notes:

• This section is relevant for the Message Viewer and Job History windows (but 
not for the Alerts window).

• These settings are retained after closing a window.
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Filtering the Messages by Type

Each message in the Message Viewer and Job History windows is assigned 
an icon to denote the message type:

You can filter the list in order to view only messages of certain types. 

Click any message type icon—for example, Error— in order not to list 
such messages.

By default, all message types are listed in the Message Viewer. 

The list updates accordingly.

Printing the Message List

You can print the information as it is presented in the Message Viewer (as 
it is currently filtered and sorted).

To print the message list:

1. Filter and sort the list as desired (the data is printed according to the 
current filtering and sorting).

2. Click Print List.

The Print window is displayed.

Information

Warning

Error

Note:  If the message type is not selected, messages of this type do not 
appear in the list.
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3. Set the printing options as desired, and then click OK.



24 bit/3 byte image An image can be either RGB or CMY and each of the three colors uses 
1 byte or 8 bits of data. Since 3 bytes equals 24 bits, these images are 
also known as 24 bit images. This system is used for high quality video 
imaging and scanning. For process color printing, a fourth color 
(black) is added for optimum effect. 

32 bit/4 byte image An image that uses 8 bits each for CMYK pixels, or 8 bits for each RGB 
pixel and 8 pixels for a mask layer or other future use. Since 4 byte 
equal 32 bits, these images are also known as 32 bit images. An 8 bit 
CMYK image is the minimum required for high quality print 
reproduction. 

4 color printing Color reproduction method used to create full color output by 
overlaying cyan, magenta, yellow and black inks.

8 bit/1 byte image An image limited to 256 tones of one color or 256 different colors. 
Since 1 byte contains 8 bits and each bit has two choices, 1 byte equals 
28 choices or 256 possibilities.

Additive color model Color system in which the picture is composed of the combination of 
Red (R), Green (G) and Blue (B) light transmitted by the original 
subject. Effective for monitors and TV's but not for print. Scanners 
normally first scan in RGB and it is converted into CMYK for 
printing. See also RGB, CMYK, Process colors, Subtractive color 
model.

Amplitude Modulation Halftone screening, as opposed to FM screening, has dots of variable 
size with equal spacing between dot centers.

Anti-Aliasing A step effect in which angled lines or curved edges of elements in an 
electronic image look broken or jagged, as a result of producing it in 
a grid format. Increasing resolution can reduce this effect or using a 
technique called anti-aliasing where the edges are softened.

Glossary
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APR Creo's Automatic Picture Replacement workflow. In this workflow, 
two versions of a file are created - a high-resolution file and a low-
resolution file called PSImage. The latter is used for positioning and 
manipulation within a DTP application. The low-resolution file is 
replaced automatically by the high-resolution version during the RIP 
process. See also PSImage.

Binding The process by which pages of a book or other publication are 
attached to one another.

Bit Abbreviation of binary digits. The smallest unit of information used 
to store information in a computer. Bits are expressed as a binary 
notation, that is, in ones and zeros.

Bitmap graphics An image composed of individual pixels. The color value and position 
of each pixel are individually described in bits and bytes of computer 
memory. It is called a bitmap because it is effectively a map of bits. See 
also Raster file.

Bleed An extra amount of printed image, which extends beyond the trim 
edge of the sheet or page.

Booklet VI jobs are composed of booklets, which are personalized copies of a 
document. A booklet can consist of several pages, but the entire 
document is targeted at a specific individual or address. VI jobs 
include elements that may differ from booklet to booklet, including 
text, graphics, pictures and page backgrounds. 

Butt To join without overlapping or space between.

Byte A grouping of 8 bits of stored information, giving 256 levels of data. 
Each byte represents a value or character such as a letter or a number. 
In a color system, a byte can describe one out of 256 distinct shades. 

CIE Abbreviation for Commission Internationale d'Eclairage. This body 
was created for the study of illumination problems. CIE color 
coordinates specify proportions of the three additive colors required 
to produce any hue and are used for comparative color measurement.

CMYK The process colors - Cyan, Magenta, Yellow and Black. See also Color 
separations, Process colors, and Subtractive color model.

Color gamut The range of colors possible with any color system. 
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Color separations Separate films are prepared for each of the process printing inks - 
cyan, magenta, yellow and black. These films are used to prepare the 
printing plates for printing on press. See also CMYK.

Composite mode In composite mode, the data required to separate a page into its 
CMYK components is all contained within one single (composite) 
file. Brisque or PS/M then separates the file into CMYK as part of the 
conversion process. This processing mode is the fastest and most 
efficient in the majority of cases.

Creep The effect of middle pages of a folded signature extending slightly 
beyond outside pages, compensated by shingling. See also Shingling.

Crop To eliminate portions of an illustration or photography so the 
remainder is more clear, interesting or able to fit the layout.

CT Abbreviation for continuous tone. Color or black and white 
photographic images with tones that change gradually from dark to 
light (unlike the abrupt changes in linework). 

DCS Abbreviation for Desktop Color Separation, an EPS format 
containing 5 files. Four of the files contain the color information for 
each of the CMYK colors and the fifth is a low-resolution composite 
file for use in electronic page layout. See also OPI.

Degradé A gradual blend or transition between colors. Also known as vignette 
or graduated blend (Vector drawing).

Digital front end system In electronic publishing, this is the workstation or group of 
workstations containing the applications software for preparing pages 
of type and graphics. In prepress, this is the workstation that gives 
access to the user for the operation of hardware. For example, proofer, 
platesetter, imagesetter.

Digital proof A black and white or color image reproduction made from digital 
information without producing intermediate films. It can be output 
as a digital hard proof using a peripheral output device or displayed as 
a digital soft proof on a video monitor.

Dot  The individual element of a halftone.

Dot area The percentage of an area covered by halftone dots ranging from no 
dots at 0% to a solid ink density at 100%. The size of a single dot is 
stated in a percentage of the area it occupies.
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DTP Abbreviation for Desktop Publishing. The process of page production 
using personal computers, off-the-shelf software and an output 
device such as a printer or imagesetter. Usually, these components 
form a system that is driven by a device-independent page description 
language such as PostScript.

EPS Abbreviation for Encapsulated PostScript, a graphic file format used 
to transfer PostScript, graphic files from one program to another. It 
includes both a low-resolution preview and the high resolution 
PostScript image description. On the Macintosh, the preview is in 
PICT format, on the PC it is in TIFF format. Also known as EPSF.

Finishing stage Stage following the press process, which may include procedures such 
as laminating, perforating and varnishing.

Font A complete assortment of letters, numbers, punctuation marks, 
characters etc. of a given design and size.

Frame A color overlap created intentionally at a color border so as to 
minimize the effects of misregistration. Also known as trap or grip. 
See also Trapping.

Frequency modulated screens A method of creating halftones where the spots are all the same size, 
but the frequency or number of dot changes in a given area. There are 
more dots in a dark area and fewer in a light area.

Frozen job A job for which the appropriate paper stock is not available, for 
example, the correct paper type, paper size or paper weight.

GCR Abbreviation for Gray Component Replacement. Method for 
reducing the CMY amounts that produce the gray component in a 
color, without changing the color hue. 

Graduated blend See Degradé.

Gravure printing  A printing method in which the image is engraved through a screen 
below the surface of a cylinder. The ink is transferred to paper when 
pressed to the cylinder. Gravure is used for very long print runs and 
on many substrates.

Gray component The amounts of CMY in a color, which result in neutral gray, based on 
the lowest separation value of the color. See also GCR.

Grayscale A scale of gray tones from white to black. Digitally, grayscale images 
have up to 256 different levels of gray. See also 8 bit/1 byte image.
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Halftone A negative or positive image whereby detail of the image is 
reproduced with dots varying area but of uniform density. Creates the 
illusion of continuous tone when viewed with the naked eye.

Highlights The whitest portions of the original or reproduction that have no 
color cast. The highlight dot is ranged in the reproduction from the 
smallest printable dot to approximately 25%. See also Midtones and 
Shadows.

HSL Abbreviation of Hue, Saturation and Lightness. This is a color model, 
which specifies a color by its wavelength (Hue), chroma or purity of 
the color (Saturation) and value of its brightness (Lightness).

Image area Portion of a negative or plate corresponding to inking on paper. The 
portion of paper on which ink appears.

Imposition The arranging of pages in a press form to ensure the correct order 
after the printed sheet is folded, bound and trimmed.

Ink jet proof A proof of a digital image printed by using jets that squirt minuscule 
drops of ink. Ink jet proofers can print onto a variety of surfaces.

Job Flow Job flow refers to the job parameter settings of selected virtual 
printers that are automatically applied to all jobs printed using that 
virtual printer. These settings determine how a sent or imported file 
is processed. For example, a file sent to a virtual printer with a Process 
& Print job flow will be RIPped, printed and stored in the Storage 
Folder. A file sent to a Process & Store job flow virtual printer will be 
RIPped and stored, without printing.

LEF A printer page orientation, where pages are delivered long edge first.

Laserwriter driver A part of the Macintosh system software which generates PostScript 
instructions from an application file when the Print command is 
activated.

Look-up table (LUT) A two or three-dimensional array of values stored for specified input-
output relationships. When one input value is known, the system can 
automatically determine the correct output value. For example, the 
system can find the needed dot size for a given set of printing 
conditions based on the stored gray level; color setups can be saved in 
color tables (color transformation tables) which are one of the many 
kinds of LUTs.
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Linework Linework graphics are characterized by sharply defined lines and very 
clear transitions from one color to another. Linework is stored in the 
computer as a series of geometric (vector) drawing instructions.

Metamerism Metamerism occurs when two colors match under one light source, 
but appear different under another light source. Those two colors are 
called a metameric match. A metameric match might cause problems 
when trying to match proofs to press-sheets under different lighting 
conditions.

Midtones Density values of an image (original or reproduction) between the 
highlights and the shadows. In the reproduction, midtones are 
printed with dot areas between approximately 40% or 60%. See also 
Highlights and Shadows.

Misregistration A situation common during printing where one or more of the color 
separations is slightly misaligned with regard to the others on press. 
Misregistration shows up as white gaps or tinted overlaps at the 
borders of color pairs. Colors containing such files are trapped to 
compensate for this possibility. On Continous Tone images, 
misregistration can lead to blurring. See also Overprint and 
Trapping.

Moiré An interference pattern caused by differences in halftone screen 
angles or rulings. In process color printing, screen angles are selected 
to minimize this pattern. If the angles are not correct, a pattern that 
distracts the eye from the picture may be produced.

Newton's rings Small concentric circles that can appear on film when two surfaces are 
closed together but not in perfect contact.

OPI Abbreviation of Open Prepress Interface. A prepress convention 
established by Aldus Corps. OPI refers to tags or place holders in 
source PostScript that point to TIFF or EPS images that have not been 
embedded in the PostScript. These images reside in other locations 
and are merged with the PostScript file when processed. Normally 
used for performing high res/low res image substitution (alternative 
to Creo APR).

Output resolution The number of laser dots per unit of linear measurement (millimeter, 
inch etc.) on film or paper. 
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Output tone curve A graph showing the relationship of original input densities and the 
corresponding dot percentages on film. 

Overprint A technique, which overlaps colored elements to eliminate the 
appearance of gaps between elements caused by misregistration of the 
various separations during printing. For example, black text is 
normally set to overprint. See also Trapping and Misregistration.

PDL Printer Description Language files (for example, PostScript, PDF, 
EPS, VPS, VIPP). The CXP8000 Color Server processes image files in 
PDL formats, converting them into a suitable Ready-To-Print format 
for direct, high-quality printing.

PICT A Macintosh file format for bitmaps and vector graphics.

Pixels Contraction of Picture Element. The smallest element of a digital 
image.

PostScript® A programming and page description language that has become 
industry standard for electronic publishing. It is used to describe the 
entire page, including both text graphics and images. PostScript is 
completely independent of the printing device. Developed by Adobe 
Systems, Inc.™

Prepress Generic term used to describe the processes involved in preparing 
images for printing. Includes the input, edit and output stages.

Printer description files PPDs (PostScript Printer Definition), and PDFs (Printer Definition 
Files). These files are used by the Macintosh applications to prepare 
page and documents for specific output devices.

Process colors The four ink colors used to reproduce full color images - cyan, 
magenta, yellow and black.

PSImage A low-resolution EPS file used in the Creo APR workflow. This file is 
used for positioning in page layout. Changes made to this file will be 
applied to the high-resolution file, which automatically replaces it 
shortly before exposure. See also APR.

Quartertone The tone area of an image influencing highlight detail and with 
density values between the white point and midtone. Typically, 
printed with a dot area near 25%. See also Highlights, Midtones, 
Shadows.
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Raster file A file of data that was scanned, processed or output sequentially, bit 
by bit and line by line. Also known as a bitmap.

Rasterization The translation of vector information into bitmap information. 
Bitmaps may also require a new rasterization to comply with the 
screening parameters (dot shape, dot size) of the imagesetter that will 
expose them on film. See also RIP and RIPing.

Register Fitting of two or more printing images or plates in exact alignment 
with each other.

Register marks Crosses or other targets applied to original copy prior to printing. 
Used for positioning films in register or for register of two or more 
colors in process printing.

Resolution The number of pixels, points or dots per unit of linear measurement. 
For example, pixels per millimeter on a video display, number of dots 
per inch or millimeter on film or paper.

The resolution of an image is usually set the same vertically and 
horizontally. For example, a square millimeter with a resolution of 12 
contains 144 pixels. The higher the resolution, the more image detail 
is recorded and the larger the digital file size.

RGB Abbreviation for the additive primaries Red, Green and Blue. They 
are used in video monitors, scanning, and other uses where the light 
is direct and not reflected. The component colors are the three 
predominant colors in the visible light spectrum detected by the 
human eye. Combining these 3 colors together creates white light.

RIP Abbreviation for Raster Image Processor. This is a software program 
or hardware device that converts vector information into pixel 
information to be imaged on an output file. This output file is imaged 
based on commands from the page description language.

RIPing The process of rastering or converting bitmaps and vector graphics 
into raster images suitable to the screening parameters of the output 
device. Files are RIPed prior to exposure or plotting.

Saturated color A color where the high and medium values approach 100%. In a 
saturated clean color, the values of the wanted colors are near 100% 
and the value of the unwanted color is near 0%. For example, when 
the color is red, 5% cyan, 90% magenta, 80% yellow is more saturated 
than 30% cyan, 90% magenta, 80% yellow.
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Saturation  The strength of a color.

Screen angle The angle of rows of halftone dots represented in degrees. During 
output of films for reproduction, the dot arrangement of each 
separation film is placed at a distinct and different angle to the other 
separations. See also Moiré.

Screen rulings The number of rows of printing dots per inch on a halftone film. A 
150lpi-screen ruling provides much better quality than 65lpi.

SEF A printer page orientation, where pages are delivered short end first.

Shadows The darkest part of an image (original and reproduction) having 
densities near to maximum density. In the reproduction, shadows are 
printed with dot areas between 80% and 100% See also Highlights 
and Midtones.

Shingling A procedure that moves the image area of a page toward the direction 
specified, usually towards the binding, in order to compensate for 
creep.

Signature Sheet of printed pages which when folded becomes part of the 
publication.

Solid The point in the picture printed with a dot area of 100%. See also 
Highlights, Midtones and Shadows.

Spectrophotometer Spectrophotometer (X-Rite DTP41), which is a 24 band color 
measurement instrument that reports densitometric, colorimetric 
and spectral data.

Spot color An additional separation (fifth, or more) that is used with special inks 
to achieve difficult color combinations, such as gold, or chocolate 
brown. Spot color is sometimes used by graphic artists to define 
special corporate colors, for example, for company logos. On the 
Spire CXP8000 Color Server, spot colors are tanslated into CMYK 
values using a dictionary, that can be edited to adjust CMYK values.

Step and repeat The procedure of copying the same image by stepping it in position 
both horizontally and vertically according to a predetermined layout.
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Stochastic screening A method of creating frequency-modulated halftones that depends 
on the number of laser dots in a given area rather than the size of the 
laser dots in a given area. The dots are randomly placed and very 
small. Areas with a higher dot percent have more spots exposed in 
that area and those with a low dot percent have fewer spots. Stochastic 
screening is used to eliminate moiré and improve picture detail and 
sharpness in high-end color printing.

Subtractive color model A color process in which the red, green and blue components of the 
original subject are reproduced as three super-imposed images in the 
complementary (subtractive) colors of cyan, magenta and yellow 
respectively. See also CMYK, Process colors, Additive color model.

Three quartertone Tone area of an image influencing the shadow detail and with density 
values between the Midtone and the Dark Point. Typically printed 
with a dot area near 75%.

Three quartertone Tone area of an image influencing the shadow detail and with density 
values between the Midtone and the Dark Point. Typically printed 
with a dot area near 75%.

Tone compression The reduction of the density range of an original to the density range 
achievable in the reproduction.

Tone reproduction curve A graph showing the density of each point of the original and its 
corresponding density on the reproduction.

Trapping Creating and overlap (spread) or an underlap (choke) between colors 
that adjoin each other to hide misregistration during printing. 
Trapping is sometimes referred to as spreads and chokes, or fatties 
and skinnies.

UCR Abbreviation of Undercolor Removal. This is a method for reducing 
the CMY content in neutral gray shadow areas of a reproduction and 
replacing them with black. As a result, the reproduction appears 
normal but less process color inks are used. See also GCR.

Unsaturated color A color whose highest value is less than approximately 80%. In an 
unsaturated, dirty color, the difference in the values of the wanted 
colors and the unwanted color is relatively low. 

For example, when the color is red, 30% cyan, 80% magenta, 70% 
yellow is more unsaturated than 0% cyan, 90% magenta, 80% yellow.
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Variable Information (VI) Variable information (VI) jobs are jobs in which the printed materials 
are individualized for specific recipients or purposes. These materials 
can include bills, targeted advertising and direct mailings.

Vector drawing The geometric system used to define lines and curves in many 
computer graphics most often used for line drawings.

Vignette See Degradé.

Virtual Printer For Macintosh and PC networks, the Spire CXP8000 Color Server 
provides three default network printers, known as virtual printers. 
Virtual printers contain preset workflows that are automatically 
applied to all print jobs processed with that virtual printer. 

White point The whitest neutral area of an original or reproduction that contains 
detail and is reproduced with the smallest printable dot (typically 3% 
to 5%).
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Aborted status,  198
Absolute colorimetric,  43,  330
Accounting Log

printing and exporting,  216
setup,  417

Accounting Viewer
setting,  215
viewing log,  213

Actual size button,  204
Adding

crop marks,  235
fold marks,  236
interleaves,  171
new virtual printer,  218

Admin Page,  46,  285
Administration Items,  392
Administrator user,  18
Adobe

Acrobat,  64
Photoshop,  9,  254

Alert Messages,  416
Alerts tab,  81
Alerts window,  20,  419
Anti-aliasing,  9,  41
AppleTalk Setup,  398
Application, opening,  17
APR. See Automatic Picture 

Replacement
Archiving

a job,  201
VI elements,  387

Auto Adjusted Calibration,  309
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Automatic

deletion,  46
screening,  340

Automatic Picture Replacement
about,  249
file formats,  254
preparing to print,  254
printing with,  255
sample job,  256
setting APR options,  249
workflow,  257

Automatic Screening,  414

B
Back Cover,  289
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calibration tables,  325
Black overprint,  42,  180
Bleed,  235
Book-finishing technique,  229
Booklets tab,  204
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slider,  362
Brochure,  256
Bypass held jobs,  413
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Calibration,  45,  304

auto adjusted calibration,  309
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methods,  309
organizing tables,  324
process,  305
saving tables,  324
select table,  341
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target calibration,  309
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when to calibrate,  304
window,  311
wizard,  313
X-Rite DTP34 QuickCal 

Densitometer,  306
Calibration Method,  310
Client workstations

Macintosh,  65
Windows,  48

CMYK
editing values,  351

workflow,  44,  334
Coating,  41,  173
Collating templates,  239
Collation,  40,  162
Color

adjustments,  344
conversion tables,  415
flow,  328
formats,  328
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management,  9
mapping,  349
tab,  328,  354
tools,  346
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Color mode,  43,  332
Color Server, turning on,  16
Color settings,  413
Color Space Array. See CSA (Color 

Space Array)
Colorimetric
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Relative,  330

Completed status,  198
Configuration

Backup,  406
Restore,  407
view,  418

Consumables tab,  25
Contrast,  45,  345
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slider,  362
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gradation tables,  364
spot colors,  353

Creep,  237
Creo Synapse InSite

export,  373
Crop marks,  235
CSA (Color Space Array),  329,  335,  

414
CT (Continuous Tone),  45,  339,  351, 

 414
Curling effect,  45
Cut & Stack,  228
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D
Data flow,  12
Date changing,  394
Default Archive Path

setting,  411
Default Gradation Table,  354,  357
Default Paper Size

setting,  411
Deleting

pages from a job,  210
spot colors,  353
VI elements,  386
virtual printers,  221

Deletion policy,  166
Delivery,  161
Densitometer. See X-Rite DTP34 

QuickCal Densitometer
Density graph,  325
Destination ICC profile

importing,  348
Destination profile,  45
Device Link,  335

managing profiles,  347
DFA (Document Finishing 

Architecture), profile,  47
DFE and Printer Animation,  399
DFE Monitor,  22
Disk threshold,  405
Disk Usage tab,  22
Disk wipe,  403
Distilling a PS file,  258
Domain changing,  394
Dotted line,  233
Downloads,  83
DTP application,  236
DTP34 Tutorial,  314
Duplex

head to head,  40,  160
head to toe,  40,  159

Dynamic page exceptions,  275
adding in PDF,  277
adding in PS and Variable 

Specification formats,  276
adding in VIPP format,  279
creating a dedicated virtual 

printer,  282
in PS and VPS,  276
printing tabs,  281

setting the Spire Color Server,  275
tips and limitations,  284
viewing preflight report,  373

E
Editing

calibration tables,  321
CMYK values,  351
imposition jobs,  247
pantone colors,  351
separations,  358
virtual printers,  221

Emulate
RGB Elements,  44
RGB elements,  336
source paper tint,  44

EPS,  10
Exceptions

dynamic page exceptions,  275
Exceptions tab,  263

deleting exceptions,  265
managing exceptions,  264
managing inserts,  266

Exporting
accounting log,  216
as InSite,  373
as PDF2Go,  261

F
Face Down,  40,  161
Face Up,  40,  161
FAF,  9,  41
Failed status,  198
Fast Web View,  259
Features, new,  6
File formats,  10
Filtering

messages,  423
Finisher,  291

module,  47
offset,  47

Finisher tab,  24
Finishing tab,  285
Fit to page button,  204
Fit to paper,  164
Fold marks,  236
Font Report,  372

Fontdownloader,  38,  294
Fonts,  294

downloading,  298
fontdownloader hot folder for 

Windows,  301
list of,  294
managing fonts,  297
substituting,  302

Front Cover,  288
Frozen job,  174,  186

G
Gallop,  165,  166
GAP (Graphic art port),  10,  86
GAP (Graphic art port). See also 

Graphic Art Port files,  366
GCR (Gray Component 

Replacement),  45,  342
General Defaults,  411
Gradation,  344

brightness,  362
contrast,  362
controls,  359
creating tables,  364
end,  362
graph,  359
highlight,  360
mid point,  361
organizing tables,  363
shadow,  361
start point,  360
table,  344
tool,  354
window,  354

Graphic Art Port files,  366
importing,  366
structure,  367
supporting,  366

Gray RGB,  43
Grayscale,  43
Grayscale images,  39
Guest user,  18
Gutter size,  234

H
Hardware components,  6
HCS (High Capacity Stacker),  47
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Held Jobs Policy,  413
Held status,  198
Help

online help,  30
Help menu,  29
High-resolution

Automatic Picture Replacement,  
249

deleting a path,  252
modifying a path,  252
Open Prepress Interface,  252
setting a path,  250
workflow,  248

Hot folders
file formats,  86
GAP formats,  86
Mac OS 9,  87
Mac OS X,  89
using,  85
using from client workstations,  86
Windows,  86

HTH,  40
HTT,  40

I
ICC profiles

deleting,  351
Ignoring overprint information,  182
Image

noise,  43,  182
quality,  41

Image orientation for imposition,  40
Image Position,  163
Image quality,  177
Image Scale,  40,  164
Importing

destination ICC profiles,  348
files,  154
GAP files,  366
jobs,  154
source ICC profiles,  347
user-defined imposition 

templates,  245
Imposed sheets,  206

view,  207
Imposition,  9

editing jobs,  247
method,  227

settings,  206
tab,  226,  227
workflow,  226

Imposition templates,  238
collating templates,  239
deleting,  247
predefined,  239
renaming,  247
user defined,  245

Improving quality of images,  177
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Ink saving,  45,  342
Inline elements,  379
Inserts,  263
Interleave,  171
Internet Explorer,  77
IPX printing,  396

configuring,  149,  150
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Job

abort running,  193
accounting,  212
archiving,  201
batching,  191,  412
deleting,  196
deleting pages,  210
duplicating,  200
editing parameters,  195
flow,  46,  222
frozen,  186
history,  421
merging jobs,  210
move to storage,  194
moving pages,  209
Preview & Editor,  203
reprinting,  156
retrieving,  202
run immediately,  195
running job,  187
submitting,  200
ticket report,  223
Variable Information (VI),  376
waiting job,  187

Job Deletion,  383
Job Parameters window,  27

Color tab,  29

Exceptions tab,  29
Finishing tab,  29
Imposition tab,  29
Paper Stock tab,  28
Print Quality tab,  28
Print Settings tab,  28
Services tab,  29

K
Key job components,  369

L
Landscape,  40,  159
Language settings,  409
Last-minute
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Lead,  163
LEF,  170
Line Work (LW),  414
Links,  84
Linux

printing from,  114
user interface,  108,  115
using commands,  114

Localization,  409
Logging On

as a different user,  18
LPR printing,  91

in Windows NT 4.0,  91
setting up in Mac OS X,  106
Spire over TCP/IP in Mac OS 9,  

108
using Windows commands,  105
Windows 2000 and Windows XP,  

97
LW (Line Work),  10,  45,  339,  351

M
Mac OS 9

copying PPD file,  66
setting network printer,  68
using a hot folder,  87
using Spire over TCP/IP,  108

Mac OS X
copying PPD file,  68,  70
setting up an LPR printer,  106
using a hot folder,  89
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Macintosh,  10
defining a printer on client 

workstations,  66
printing from,  75
using the fontdownloader,  298
working from client workstations,  

65
Margins,  233,  234
Marks & bleed,  235
Max details button,  204
Menu bar,  20
Merging jobs,  210
Message Viewer,  422
Message Viewer Log

setup,  417
Messages,  416

system disks threshold,  420
Misregistration,  41
Mode,  43
Monitoring jobs,  78
Moving

pages within a job,  209
waiting jobs to storage,  194

N
Navigation buttons,  203
NDS PConsole

using,  138,  149
Network printer

setting for Mac OS 9,  68
setting for Mac OS X,  72

Network Setup,  395
Network tab,  22
No. of Copies,  157
Novell client

installing printer drivers using 
Adobe PS,  152

Novell Directory Services
configuring and setting,  136
defining printer queues,  137
defining the Spire Color Server as a 

client,  152
Novell Netware Administrator

opening,  137
Novell NetWare Administrator 

application
using,  137

Number of copies,  157

O
Online help,  30
Open Prepress Interface,  252

file formats,  254
preparing to print,  254
printing with,  255

Operator user,  18
OPI. See Open Prepress Interface
Optimize for Fast Web View,  259
Orientation,  40,  230
Override PPD parameters,  220

P
Page exceptions

dynamic,  275
Exceptions tab,  263
inserts,  263
printing on tabs,  268
setting for imposed jobs,  267
workflows,  266,  267

Pantone colors,  351
Paper

stock tab,  166
tint,  44,  336
type,  40

Paper Set Name,  167
Paper sets,  40

adding,  167
deleting,  169
modifying,  169
name list,  167

Paper Size,  169
Paper Stock tab,  23,  166
Paper type,  171
Passwords,  402

changing,  403
PC,  10
PDF,  10

optimization,  257
workflow,  257

PDF2Go
exporting,  260

PDL,  32
PDL files,  13
Perceptual (photographic),  43,  331
Perfect bound,  229

Personal Print Markup Language 
(PPML),  10,  377,  381

Photoshop,  9
Portrait,  40

jobs,  160
PostScript,  377
PostScript files

creating on Windows,  58
PowerPoint,  39
PPD file

copying for Mac OS 9,  66
copying for Mac OS X,  70
copying from Windows,  64
setting job parameters,  39

PPML. See Personal Print Markup 
Language (PPML)

Preferences,  392
Preflight Check,  368
Preflight Report

about,  369
viewing,  370

Pre-RIP
editing,  8
Preview,  410

Preserve Pure Colors,  44
Preview

buttons,  203
gradations,  355

Print
grays using only black toner,  332,  

334
quality tab,  255

Print Method,  40,  159
Print Order,  160
Print Quality tab,  175
Print Queue,  33,  186

status indicators,  188
Print Queue Manager,  411
Print range,  158,  159
Print Settings tab,  157
Printer

defining on Macintosh client 
workstations,  66

defining on UNIX,  117
defining on Windows client 

workstations,  48
Printer icon,  21
Printer Monitor,  23
Printer tab,  82
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Printer’s default,  39,  65
Printers

default network,  38
Printing

accounting log,  216
book-style hard copies,  160
from Linux,  114
from UNIX,  118
jobs,  154
LPR,  91
using a hot folder (Mac OS 9),  87
using a hot folder (Mac OS X),  89
using a hot folder (Windows),  86

Process Queue,  33,  186
status indicators,  188

Processing,  33
ProcessPrint,  13,  46,  218
ProcessStore,  13,  46,  218
Product overview,  4
Profile Manager,  346
PS (PostScript)

distilling files,  258
files,  381
Image Exporter,  254
overprint,  42,  181

PS overprint,  181
PS Preview,  410

Q
QuarkXPress,  9,  252,  352
Queues

changing order,  192
managing,  186
resuming,  193
suspending,  192
window,  33,  186

Queues tab,  79
Queues window,  20
QuickCal Densitometer. See X-Rite 

DTP34 QuickCal Densitometer

R
Rasterized Brisque jobs,  367
Realistic images,  331
Rear,  163
Red corners,  233
Relative colorimetric,  43,  330
Remote Admin,  399

Remote Admin Client,  400
Remote connection,  399
Remote Tools Setup,  399
Rendering intent,  329

absolute colorimetric,  330
for CMYK,  44,  335
for RGB,  43
perceptual (photographic),  331
relative colorimetric,  330
saturated (presentation),  330

Reordering columns,  423
Repeated elements,  258
Resource Center,  26
Restoring configuration,  407
Resubmitting,  35
Resume button,  192
Retrieving

a job,  202
VI elements,  387

Re-usable elements,  379
Reverse print order,  40
RGB,  39

workflow,  43,  333
RIP,  4,  8
Rotate 180,  40,  165
RTP,  4,  8

editing RTP jobs,  209
jobs,  354

Rush job,  195

S
Saddle stitch,  229
Saturated (presentation),  43,  330
Screening method,  45,  339,  414
Security,  402
SEF,  170
Separation

calibration,  321
editing,  358
field,  358
viewing,  324

Server icon,  21
Server Name

changing,  393
Server Setup,  392
Settings

Administration,  392
Color,  413

Configuration Backup,  405
Date and Time,  394
General Defaults,  411
Localization,  409
Messages,  416
Network Setup,  395
Preferences,  392
Pre-RIP Preview,  410
Print Queue Manager,  411
Remote Tools Setup,  399
Security,  402
Server Name,  393
Server Setup,  392
System Disks,  404

Settings window,  25,  392
Administration,  392

Show info button,  208
Signature colors,  330
Simplex,  40,  159
Sizes,  229
Slip Sheet,  47,  286
Software components,  6
Source ICC profiles

importing,  347
Spine trim size,  234
Spire over TCP/IP,  108
Spire Web Center,  76,  401

connecting from a client,  77
Downloads,  83
Links,  84
Web Viewer,  78

Split to booklets,  46,  389
SpoolStore,  13,  46,  218,  222
Spot color

create new,  353
deleting,  353

Spot Color Editor,  351
Spot Colors Report,  371
Spot workflow,  337
Stack tray,  47
Staple options,  47
Status

of imported jobs,  155
Status indicators

Queues window,  188
Status information,  190
Status panel,  20
Step & Repeat,  228
Storage tab,  80
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Storage window,  13,  20,  34,  194,  196
status indicators,  198

Submitting,  32
an RTP job,  156
jobs,  200

Suspend button,  192
SWOP,  44
Synapse,  373
System Disks,  404

T
Tabs printing,  268
Target Calibration,  309
TCP/IP Setup,  397
Template,  231
Text and line quality,  41
Text/Line quality,  175
Thumbnail window,  20
Thumbnails

tab,  205
view,  205

Time changing,  394
Tips,  284
Toner tab,  24
Toolbar,  20
Top tray,  47
Total creep in,  237
Transparency,  171
Trapping,  9,  41,  178
Tray,  174
Trim size,  230

conflicting settings,  233
Turning off

Spire Color Server,  36
Turning on

Spire Color Server,  16
Type,  171

U
UNIX,  10

defining a printer,  117
printing from,  118

UNIX connectivity
checking NFS,  131
configuring NFS server settings,  

123

creating file-name translation file,  
121

installing and configuring Brisque, 
 132

installing SFU 3.0 software,  118
mounting Windows NFS volume,  

133
NFS performance,  121
sending samples to Windows NFS 

volume,  135
setting up Windows SFU for 

Brisque,  124
sharing an NFS folder,  129

Use Spire Spot color dictionary,  44
User defined imposition templates

deleting,  247
importing,  245
renaming,  247

User Passwords,  402
Using

overprint information,  182
Utilities folder,  10,  83

V
Variable data Intelligent Postscript 

Printware (VIPP),  10,  377,  379
Variable Information (VI),  9

archiving VI elements,  387
booklets,  378
deleting VI elements,  386
document formats,  377
gallop,  382
imposing VI jobs,  384
inline elements,  379
jobs,  376
managing VI elements,  385
printing VI jobs,  381
retrieting VI elements,  387
sub-job,  378
workflow,  376

Variable Print Specification (VPS),  10, 
 377

VI Job Preview,  410
View

Queues,  21
refresh,  21
Spire classic,  21
Spire classic plus,  21

View Configuration,  418
Viewing

crop marks,  207
the imposed job,  207

VIPP jobs
printing,  380

VIPP. See  Variable data Intelligent 
Postscript Printware (VIPP)

Virtual printer,  218
adding,  218
editing,  221
existing,  221
ProcessPrint,  218
ProcessStore,  218
SpoolStore,  218

Virtual Printers tab,  23
VPS. See Variable Print Specification 

(VPS)

W
Web Connect,  401
Web Connect Setup,  401
Web connections

enabling,  402
Web Viewer,  78,  402

Alerts tab,  81
API,  82
Printer tab,  82
Queues tab,  79
Storage tab,  80

Weight,  41,  172
Windows

copying the PPD file,  64
creating PostScript files,  58
defining a printer on a client 

workstation,  48
printing from,  64
printing using a hot folder,  86
working from client workstations,  

48
Windows 2000

printing using commands,  105
Windows 2000 and Windows ME

defining a printer,  52
Windows 2000 and Windows XP

setting up an LPR printer,  97
Windows 98

defining a printer,  50
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Windows NT 4.0
defining a printer,  48
printing using commands,  105
setting up an LPR printer,  91

Windows XP
defining a printer,  55
defining a printer using the add 

printer wizard,  55
printing using commands,  105

Workflow,  10,  43
basic,  31
importing and printing from the 

client,  32
importing and printing from the 

Spire Color Server,  33
resubmitting a job,  35

Workflow extenders,  9
Workgroup

changing,  394
Workspace

alerts,  20
cutomizing,  20
menu bar,  20
opening,  17,  27
overview,  19
queues,  20
status panel,  20
storage,  20
thumbnail,  20
toolbar,  20

X
X-Rite DTP34 QuickCal Densitometer

calibrating,  306,  308
configuring,  307
connecting,  307
quick calibration,  308

Y
Yellow corners,  233
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